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  1. Installation & Prerequisites 

Introduction 
The 3SPack software package is shipped on a CD-ROM (the DSNP 
Scorpio CD-ROM or the DSNP Aquarius CD-ROM) and a dongle is 
provided.  

You will be interested in creating 3SPack installation diskettes if for 
example you wish to install the package on a PC with no CD-ROM 
drive. To do this, use a PC with a CD-ROM drive and copy each of 
the Disk 1 to Disk N sub-directories from the CD-ROM 3SPack 
directory to a separate diskette (on which you will not forget to write 
down the proper label). 

In case of partial purchase of 3SPack, the applications that are no 
part of your acquisition will remain unavailable to you. 

 
 NOTE: The applications corresponding to your purchase 

order are declared by way of a dongle which you should 
connect to your computer prior to running 3SPack. 

 
 

If later you buy a new application, you will be provided a password to 
unprotect it (see Enabling an application purchased later in page 1-
7). 
 

Computer requirements 
 Processor : DX2-66 minimum, Pentium recommended 
 RAM : 16 Mbytes minimum, 24 Mbytes 

recommended 
 Operating system : Windows 95 
 Display screen : SVGA, 17 inches recommended 
 Other : PCMCIA card drive recommended 
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Installation from CD-ROM 
- Insert the CD-ROM into the CD-ROM drive 

 Setup should be launched automatically. If that is not the 
case, open the Add/Remove Programs icon from the 
Control Panel and click on the Install push-button 

 or, from the Windows 95 task bar, click Start, select Run 
from the pop-up menu. In the text box which then appears, 
type in { drive name} :\Setup.exe and click the OK button. 

- Choose Install 3SPack and then follow the instructions 
provided on the screen to complete setup. The main 
stages in the installation procedure are described below. 

 

• Welcome Dialog box 
 As mentioned in this box, we recommend you to close all 

the active applications before proceeding with the 
installation. 

 

• Registration 
- Specify the following in the two text boxes: 

• your name 
• your company's name 

 

• Destination directory 
- Specify the name of the target directory where you would 

like the software to be installed. You can specify a non-
existing directory: the program will create it for you after 
confirmation. 
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• Program folder 
- Specify the name of the folder where you would like the 

program shortcuts to be created. 

 

• Start copying files 
- Click the Next button to start installing the software (or 

click the Back button to come back to the installation 
parameters if you want to change any of them). 

 

• End of installation 
- The following messages are displayed successively: 

 
Setup is installing DAO 
components... 

Setup is updating registry 
database... 

Setup is installing program 
icon to the start menu... 
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- The end of installation is denoted by the following 
message: 

  
- Select the appropriate option. 

 

Installation from diskettes 

- Insert the first diskette (disk. #1) into the PC drive 

 Open the Add/Remove Programs icon from the Control 
Panel and click on the Install pushbutton 

 or, from the Windows 95 taskbar, click Start, select Run 
from the pop-up menu. In the text box which then appears, 
type in { drive name} :\Setup.exe and click the OK button. 

- Follow the instructions provided on the screen to complete 
setup (same as if installed from the CD-ROM, except that 
the installation diskettes must be inserted one after the 
other, when prompted by the system). 
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Program folders and shortcuts 
- After successful installation and using Windows95 

explorer, the following is now visible on your disk C: 
 

 
 

 Bin : Contains all the program files (mainly 
*.exe, *.dll, *.hlp, *.ocx, etc.) 

 Cmd : Default directory used to save all Win 
Comm command files 

 Data : Reserved directory. Contains the system 
database. Do not edit any of the files 
contained in these directories as this could 
seriously damage the performance of your 
software. 

 

 NOTE: We recommend you to back up the Data directory 
at regular intervals as this directory contains all the data 
used by 3Spack. 

 Running a Restore operation on this directory will put 
3Spack back into the state in which it was when last 
running the Back-up. 
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 Kis : Directory used to store KISS projects 

 Maps : Default directory invoked when importing 
digitized maps (it is easier to move your 
maps to this directory before importing 
them into the database) 

 Pgm : Default directory invoked when saving 
Wincomm record-program files 

 Points : Default directory invoked when importing 
or exporting points (it is easier to move 
your points files to this directory before 
importing them into the database) 

 Raw : Default directory invoked when importing 
raw data files 

 Rtf : Default directory invoked when choosing a 
template for the project document 

 Set : Default directory invoked when saving Win 
Comm configuration file (containing 
communication parameters) 

 Sis : Directory used to store SISS projects  
 

- In addition, a new folder (the "program folder") is present in 
C:\WIN95\Start Menu\Programs\D.S.N.P., containing the 
shortcuts listed below: 
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Getting started 
- Before running 3SPack, do not forget to connect the 

dongle to the parallel port of your PC (the one usually used 
for printers). If a printer is already connected, insert the 
dongle between the printer cable and the PC connector. 

 

 NOTE: The applications corresponding to your purchase 
order are declared by way of a dongle �part of the 
supply� which you should therefore keep permanently 
connected to your computer so long as you use 3SPack. 

 

- Double-click on the 3SPack icon to start the program. 

 

Enabling an application purchased later 
For example you purchase 3SPack without the Kinematic 
application. If later you need to use Kinematic and you buy it, then 
you just have to do the following after DSNP has provided you with a 
password reckoned from your personal key code : 

- Run 3SPack and from the menu bar, select Tool and then 
Unprotect 

 or 

 Run Unprotect from the Windows95 Start Menu 
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- Type the password in the text box which then appears (see 
below): 

 
 

- Click the Unprotect... button 

- The component which has so far been unavailable to you 
can now be run on your computer. ♣  
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  2. Tutorial 

This section introduces the basic techniques required 
to run a survey using 3SPack. 

The average time needed for a beginner to read this 
section while running the tutorial project on the 

computer is about half an hour. 

 
Assumptions 

• Installation: 
Software installation : Default 

 Program folder : D.S.N.P 
 

• Survey: 
 Prediction : Will be run for the current date & time. In normal 

use, predictions should be run for the days of 
surveys. In this tutorial, you should admit there 
won't be no real connection between the 
prediction and the post-processing. 

 Field survey : Not described 

 Receiver-to-PC 
 data transfer : Described just to show how it works. In fact you 

won't need to upload field data since you will be 
asked to "import" field data placed in the Raw 
directory by the installation software, as if it were 
the data recorded during your survey. 

 Post-processing : Will be run for a survey performed during the last 
quarter of 1996. 
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Running 3SPack 
- From the Windows95 task bar, click the Start button and 

then select successively Programs, D.S.N.P and 3SPack. 

- Wait for the 3SPack window to open: 

 
 

Creating the tutorial project 
- From the menu bar in the 3SPack window, select 

successively File and then New Project 

- In the Project dialog box which then appears, enter the 
following in the General tab: 

 
 Project : type Tutorial 
 Supervised by : enter your name 
 ... 
 All coordinates in : choose Lambert 2 
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- Select the Region tab (from top of dialog box) 

- Click the Browse button. A dialog box appears listing the 
registered regions. 

- Choose the only known region (TutoRegion) by directly 
clicking the OK button. As a result the N/S and W/E 
coordinates of this region appear in the corresponding 
fields on the Region tab. 

- Click the OK button. This causes 3SPack to create the 
Tutorial project. A new window appears showing the 
content of this project into which 3SPack then 
automatically inserts the header (from the template, see 
Editing a project document in section 3), followed by the 
project abstract (see Appendix) and a map of the region 
(this may take a while). 

 Note that the insertion of the last two elements will take 
place only if you have maintained the default View options 
in Supervisor (see View menu, Options command in 
Supervisor). 
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 Note also that at the end of the insertion, the Map server is 
in-place activated (in the 3SPack window, the Map Server 
bars are now displayed instead of the Supervisor bars): 
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Focusing on the sites and trajectories 
shown on the map 

- Click    to remove the details of the map. The following 
elements (three sites and a trajectory) remain visible: 

 

 
 

- Double-click  (after moving the pointer onto the site 
name or the cross) 
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 A Site dialog box opens in which you can read the 
definition of this site: 

 Solutions tab : Only a user-estimated location is known 
for this site 

 General tab : Since only a user-solution is known, it is 
also defined as the default solution and 
last solution for this site 

 Observations tab : No observations available yet for this site 

 Curtain tab : No curtain defined for this site 

 

- Click the OK (or Cancel) button to close this dialog box 

- Do the same for the other two sites TutoFrom and 
TutoRef. Note that a curtain is defined for TutoRef. 

- Double-click  (after moving the pointer onto the 
trajectory name or the cross) 

 A Trajectory dialog box opens in which you can read the 
definition of this trajectory: 

 General tab : Only a user-estimated location for the start 
point of this trajectory is known 

 Solutions tab : No solutions available for this trajectory 

 Observations tab : No observations available yet for this 
trajectory 

- Click the OK (or Cancel) button to close this dialog box 
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Defining a prediction at TutoRef 

- Click  

- From the menu bar, select Draw and then Prediction. A 
dialog box appears allowing you to define a satellite 
prediction on this site 

- Do not change any of the parameters displayed in this box. 
Instead, just click the OK button. 

 This causes the Prediction dialog box to disappear and 
 appears beside the TutoRef site on the map. To 

go back to the definition of the prediction, just double-click 
 

- While holding down the Shift key, double-click  to 
display the options of the prediction. Do not make any 
changes to this box. Instead, just read the parameters 
displayed and then click the OK button. 
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Running the prediction 
- Press the Esc key to quit the Map server environment (in 

the 3SPack window, the Supervisor bars are now 
displayed instead of the Map server bars). 

- In the toolbar, click  

- In the dialog box which then appears, click the Run button. 
3SPack starts running the prediction. At the end of the 
computation (this may take a while), a prediction object, 
such as illustrated below, is inserted into the project, at the 
end of the document: 
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Loading a field record to your PC using 
WinComm 
Skip this page and the next one if you do not have your receiver and 
communications cable in hand. You do not need to perform this load 
operation to continue with the tutorial. These two pages only describe the 
typical procedure to be followed for the loading of your field data files 
from the receiver to the computer if you do not use a PCMCIA card. 

 
- Connect the receiver to your PC according to the 

instructions provided in the receiver manual. In what 
follows, you will need to know the port settings used on the 
receiver. 

- From the 3SPack menu bar, select Tool and then 
WinComm. This causes the Communication Settings 
dialog box to appear. 

- Change the following parameters so as to put the 
computer port used in the same configuration as the 
receiver port: 

 

 
 

 If a DSNP receiver is connected and you are not sure 
about the Baud rate, click the Auto Configure button. This 
will automatically set the above parameters to the required 
values. 

- Click the OK button. This enables communications 
between the GPS receiver and the PC. 
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- Now that the WinComm window is active, click Internal 
Memory Reader in the Mode pane (top right). This causes 
the lower-right pane to be changed so that you can prepare 
the data transfer: 

 
 Directory : Specify the directory on your PC where to 

transfer the field record file (default: 
c:/3spack/raw) 

 File name : Specify the name of the file generated on 
the PC. If you do not want the resulting file 
to be split (No Limits is chosen as File 
Max Size option, see below), then you can 
specify the file extension (default: RAW) 

 File Max Size : Specify whether a single file should be 
created on the disk (choose No Limits) or 
the file should be split into 0.7 MB or 1.4 
MB segments (with a view to storing it to 
floppy disks). 

   If you elect to split the file into segments, 
then the system will automatically add 001 
as extension to the name of the first 
segment. This will automatically be 
incremented for each file segment 
generated, if the file exceeds the File Max 
Size selected. 

 
- Click the Transfer Current button. WinComm then starts 

reading the record session selected in the Transfer text 
box from the receiver's memory and saves it to the file 
specified in the File Name and Directory text boxes. 

- When the transfer is complete, click  to close the Win 
Comm window. 
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Importing field data records 

- Scroll up the project document, by holding down , until 
the map object re-appears in the main window 

- Double-click anywhere within the map object to enter the 
Map Server environment 

- Click  to restore the details of the map on the screen 

- From the menu bar, select File and then Import GPS Data 

- In the dialog box which then appears, click the Add button 

- In the Browse dialog box which then appears select all the 
files except ReadMe.txt: 

 

  
 

- Alternately, If your survey was performed with the field data 
files recorded on a PCMCIA card, then insert this PCMCIA 
into the PCMCIA drive of your PC and, from the Look In 
combo box (above), choose this drive and then select the 
files. 
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• Notes about the use of the Shift and Ctrl keys to make a 
Multiple Selection: 
There are two ways of making a multiple selection: 

- Click the first file that you wish to select and, while holding down the Shift key, 
click the last file that you wish to select. The resulting selection consists of 
these two files plus all the files in between. 

- Or click any file that you wish to select and, while holding down the Ctrl key, 
click successively the other files that you wish to select. The selection only 
consists of the files that you clicked. Note that while still holding down the Ctrl 
key, clicking a selected file will deselect it. 

 

- Click the Open button. This causes the list of selected files 
to appear now in the Import GPS Data dialog box 

- Now click successively each of these files and note how 
3SPack can "guess" the destination of each of these files 
and therefore prompt the right associations, the recognition 
being based on the use of appropriate naming rules. 
Examples: 

TutoToRec.raw file

3SPack prompts you to create an observation record
called TutoToRec

(i.e. data file name without the extension)

3SPack searches for a site or trajectory stored in the
database whose name shares the longest character string
with TutoToRec (starting from the first character in both

names).

3SPack prompts you to associate this observation
record with the site called TutoTo.

This is precisely what should be done.  

TutoMobRec.raw file

3SPack prompts you to create an observation record
called TutoMobRec

(i.e. data file name without the extension)

3SPack searches for a site or trajectory stored in the
database whose name shares the longest character string
with TutoMobRec (starting from the first character in both

names).

3SPack prompts you to associate this observation
record with the trajectory called TutoMob.

This is precisely what should be done.  
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- Do not make any changes to these settings and simply 
click the Go button to start importing the data files (you 
don't need to re-select all the files in the Import list box 
before clicking Go). A message box shows the progress of 
the Import function (see example below). 

 

 

- Once all the data files have been imported, click  to 
refresh the map (do not forget to do this whenever you 
make changes to an input parameter or an option 
connected with the map server). 

 Note the presence of diskette icons on the map, meaning 
that observations are now available for these sites and 
trajectory: 
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Defining "Natural" processes to determine 
TutoTo and TutoMob 

- On the map, click  

- While holding down the Shift key, click  

- From the menu bar, select Draw and then Process. A 
dialog box appears in which you can define a process for 
TutoTo (the first element selected on the map). 

 Set this box as follows: 

 

 

 

Select this option 
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- Click the OK button. The same dialog box appears, this 
time to define a process for TutoMob (the second element 
selected on the map). 

 Set this box as follows: 

 

 
- Click the OK button. The Map server now shows two more 

operations: 

 

 

 (click  if these operations do not appear). 

Select this option
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Defining a Rapid Static process to 
determine TutoTo 

 (You can do this only if the Rapid Static processor is 
active) 

 

- On the map, click  

- From the menu bar, select Draw and then Process. A 
dialog box appears in which you can define a process for 
TutoTo. 

 Set this box as follows: 

 
 

- Click the OK button. 



Tutorial 
Defining a Kinematic process to determine TutoMob 

DSNP 2-17 

 

Defining a Kinematic process to determine 
TutoMob 

 (You can do this only if the Kinematic processor is active) 

- On the map, click  

- From the menu bar, select Draw and then Process. A 
dialog box appears in which you can define a process for 
TutoMob. 

 Set this box as follows: 

 
- Click the OK button. The map server then looks like this: 
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- You can check the definition of each of the four processes 
you have just defined by double-clicking the corresponding 
objects on the map (rectangles in green), which causes a 
dialog box summarizing the process definition to display. 

 

Running all the processes 
- Press the Esc key to come back to the project 

environment 
- As a safety measure, from the menu bar, select File and 

then Save Project 

- Click  
- In the Project Run dialog box which then appears, while 

holding down the Ctrl key, click the prediction operation to 
deselect it (this operation has already been run) 

- Click the Run button. This causes the first process to 
execute. Let the program perform all the operations (this 
takes about 3 min with a DX4-100, 16 MHz RAM). 

 Do not try to anticipate the next action, using either the 
mouse or the keyboard, as this could cause the following 
type of message to appear: 
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- After the last process is complete, scroll through the 
project document and compare the results provided by 
"Natural" and "Rapid Static" for the TutoTo site and by 
"Natural" and "Kinematic" for the TutoMob trajectory. 

 Note that plot objects in the document are separated by 
".../...". This character string helps you point to the location 
where you can insert text or graphics between plots. 

Inserting a new map only showing the 
essential results of the survey  

- Point to the end of the project document 

- From the menu bar, select Insert and then Map 

- Click  to remove the scenario from the map 

- From the menu bar, select View and then Options. In the 
dialog box which then appears, select the Show/Hide tab. 
Set this tab as follows and click OK: 
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- Adjust the map so as to give the best possible view of the 
results using the following buttons: 

 to zoom out 

 to zoom in 

 to move the view in any direction 

 

 For example, this may be the kind of view you would like to 
get: 
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Editing the new solutions 

- Click  

- Double-click again. 

- In the Site dialog box which then appears, select the 
Solutions tab. Two more solutions are now available for 
this site. 

- Use the vertical scroll bar to edit successively each of the 
three solutions. 

 
 

 

 
 

Click this button to scroll 
up the list of solutions 

3 solutions for TutoTo 

Click this button to scroll 
down the list of solutions 
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- Double-click  again 

- In the Trajectory dialog box which then appears, select the 
Solutions tab. Two solutions now exist for the trajectory. 
The first one (from Natural) includes 993 points, the 
second (from Kinematic, see below) 248 points. 

- Use the vertical scroll bar to edit successively each of the 
two solutions.  

 
 

 

 

Click this button to scroll 
up the list of solutions 

Trajectory consists of 248 points in the 2nd 
solution. Use the Scroll buttons to display the 

coordinates of each of these points. 

2 solutions for TutoMob 

Click this button to scroll 
down the list of solutions 
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Exporting the solutions 

- On the map, click  

- While holding down the Shift key, click  

- Click . 

- In the dialog box which then appears, just change the 
format to ASCII.DXF, as shown below: 

 
 

- Click Go. The following message appears: 
 

 

- Wait until the message disappears. 
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Previewing the project document 
- Press the Esc key to quit the Map server environment (in 

the 3SPack window, the Supervisor bars are now 
displayed instead of the Map server bars). 

- Click  to verify the page layout of your project document 
before printing it. 

 Use the commands available from within the Preview 
window if necessary. 

- If changes have to be made to the page layout, first click 
the Close button to go back to the project document (in 
any case, click this button to quit the Preview window). 

- Print the project document using the Print command from 
either the Preview window or the Print command from File 
in the Supervisor menu bar. 

 

At this stage in the survey, a printable document is now available 
containing the results (plots) of all the operations performed. A DXF 
file is also available gathering all these results for use by a GIS 
(Geographic Information System) for example. 
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Closing the Project document 
- From the menu bar, select File and then Close Project. 

This causes 3SPack to save and close the Tutorial project. 

- Click . 3SPack now shows the Supervisor database: 

 

 
 

Using the Supervisor Database to edit the 
various "records" involved in the Tutorial 
project 

When you closed the Tutorial project, 3SPack switched to the 
Supervisor Database and automatically selected the Projects object 
thus showing the Tutorial project as a "project record" (in the right-
hand pane of the window). 

3SPack
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The term "record" refers to any element, project, region, map, etc., 
contained and viewed from within the Supervisor database; the term 
"object" refers to a family of records. 

- Double-click the Tutorial record. This causes the Project 
3-tab dialog box to open showing the definition of the 
Tutorial project (as defined earlier when creating the 
Tutorial project) 

- Click OK or Cancel 
- Click the Regions object in the left-hand pane of the 

Database and then double-click the TutoRegion record. A 
dialog box appears showing the definition of this region 

- Click OK or Cancel 
- Click the Sites object in the left-hand pane of the Database 

and then double-click the TutoTo record for example. A 
dialog box appears showing the definition of this site. Note 
the presence of the two solutions determined earlier by 
Natural and Rapid Static 

- Click OK or Cancel 
- Click the Trajectories object in the left-hand pane of the 

Database and then double-click the TutoMob record for 
example. A dialog box appears showing the definition of 
this trajectory. Note the presence of the two solutions 
determined earlier by Natural and Kinematic. 

- Click OK or Cancel 
- Click the Observations object in the left-hand pane of the 

Database and then double-click the TutoMobRec record 
for example. A dialog box appears describing the content 
of this observation. 

- Click OK or Cancel 
 etc. 
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Deleting the various records involved in 
the Tutorial project  

(specifying in which order this must be made) 

From within the Supervisor Database: 

1- Delete Project 
- Click the Projects object and select Tutorial 

- From the menu bar, select Record and then Delete 

- Click OK to confirm your choice. 

2- Delete Observations 
- Click the Observations object and select all the 

Observation records 

- From the menu bar, select Record and then Delete 

- Click OK to confirm your choice. 

3- Delete Ephemerides 
- Click the Ephemerides object and select all the Ephemeris 

records 

- From the menu bar, select Record and then Delete 

- Click OK to confirm your choice. 

4- Delete Iono-UTC data 
- Click the Iono-UTC object and select all the Iono-UTC 

records 

- From the menu bar, select Record and then Delete 

- Click OK to confirm your choice. 
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5- Delete Almanacs 
- Click the Almanacs object and select all the Almanac 

records but one (anyone) 

- From the menu bar, select Record and then Delete 

- Click OK to confirm your choice. 

6- Delete Site solutions 
- Click the Sites object and then double-click the TutoTo 

record 

- Select the Solutions tab 

- Using the Scroll bar, edit the 2/3 solution and click Delete 
twice in the dialog box. Only the user solution now remains 
for this site. 

- Click OK. 

7- Delete trajectory solutions 
- Click the Trajectories object and then double-click the 

TutoMob record 

- Select the Solutions tab 

- Using the Scroll bar, edit the 2/2 solution and click Delete 
twice in the dialog box. Only the estimated position for the 
initial point now remains for this trajectory. 

- Click OK. ♣  
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  3. 3SPack Supervisor 

Introduction 
Basically 3SPack Supervisor consists of a Project Editor and a 
Database Manager. Two different operating environments should 
therefore be distinguished: the Project environment and the 
Database environment. 

- With the Project Editor you can define and run all the 
predictions and computations required for your survey. At 
the end of your work, you get a comprehensive report (the 
"Project document") which you can print, export, archive, 
etc. 

- With the Database Manager, you can easily keep control 
of all the data produced at the different levels of a survey 
by means of the few commands attached to the database 
(Add, Edit, Delete, Import, Export). 

 
Project Editor 
From the Project Editor you can make your satellite predictions and 
run all your site and trajectory computations. In fact, when you do 
that, you work on a document (called the "Project document") in 
which you deposit all these data and results. 

- The start point is to open a new "Project document" for the 
survey. 

- Whenever you execute "operations" such as predictions, 
computations of sites or trajectories, etc., a new "object" is 
inserted into the active Project document. Each of these 
objects may be edited or updated (re-run) separately, 
directly from within the document. They are the results of 
your survey. 
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- An interesting feature of the project editor is the Map 
Server. The Map Server lets you insert a map of the 
region of survey into the Project document. From this map, 
you can graphically control all the operations performed in 
the framework of your survey. The Map Server also gives a 
view of all the operations performed earlier in that region 
(provided the corresponding records are still present in the 
database). 

- As a final step in the creation of a project document, and 
using the integrated edit tools of the Project Editor, you 
can add titles, additional notes and all sorts of comments 
(text and graphics) so as to give the project document the 
aspect of a professional printable document. 
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Database Manager 
- The database gives you a synthetic view of all the records 

held by 3SPack Supervisor. 

- To work in the database, you need to open the Database 
window. This window is divided into a left pane showing 
the architecture of the database (database objects with a 
particular hierarchy) and a right pane showing the content 
(a number of records) of the object selected in the left 
pane. 

 

   
 

Opening the database window 

- In the toolbar, click  

 or 

- From the menu bar, select the View command and then 
the Database Manager command. 
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Database Architecture 
The database consists of the 14 objects shown below. 

 
• Projects object 

Contains Project records. The definition of a Project record 
includes more particularly the time interval when the survey 
is assumed to take place, the type of coordinate system 
used (a Coord system record is mentioned), the region of 
survey and the operations to be performed (predictions, 
processes). 

 
• Regions object 

Contains Region records. Each Region record depicts a 
rectangular area defined by the two points of one of its 
diagonals and a time zone. 

 
• Maps object 

Contains Map records. Each Map record is identified by a 
name. A Map record consists of the map as such (a 
digitized map shown in the Map dialog box) and a user-
settable grid. 
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• Coord. Systems object 
Contains Coord system records. Each Coordinate system 
record is mainly defined by a name, a Datum record, a Unit 
record and a Label record. 

 
• Datums object 

Contains Datum records. Each Datum record is mainly 
defined by a name, an ellipsoid, a scale factor and 
translation and rotation operations performed compared 
with the WGS84 model. 

 
• Ellipsoids object 

Contains Ellipsoid records. Each Ellipsoid record is defined 
by the name of an ellipsoid, its semi-major axis and inverse 
flattening. 

 
• Labels object 

Contains Label records. Each Label record depicts the 
terms used to introduce all coordinates expressed in the 
Coord System record which this record is associated with. 

 
• Units object 

Contains Unit records. Each Unit record specifies the unit 
of all coordinates expressed in the Coord System record 
which this record is associated with. 
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• Sites object 
Contains site records. Each site record depicts the 
characteristics of a particular site (or location). 
The definition of a site record includes more particularly the 
coordinates of the site (several solutions may exist, for 
example that provided by the user as an estimate, or those 
resulting from different processes run precisely to 
determine the position of the site). The coordinates of each 
solution are expressed in the WGS84 system (if viewed 
from the database), or in the coordinate system used in the 
project (if viewed from the project document). 
Among the known solutions, one may be chosen as the 
default solution to be used in other processes in which the 
site is involved. 
The definition of a site also includes the definition of the 
curtain, if any, seen from the site. 

 
• Trajectories object 

Contains trajectory records. Each trajectory record depicts 
the characteristics of a particular trajectory. 
The definition of a trajectory record includes more 
particularly the coordinates of the initial point (the 
beginning of the trajectory) and a number of solutions 
(several solutions may exist if several different processes 
have been run to determine that particular trajectory). 
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A trajectory solution consists of a list of points (all points or 
only marked points) classified in the chronological order of 
recording. The coordinates of each point are expressed in 
the WGS84 system (if viewed from the database), or in the 
coordinate system used in the project (if viewed from the 
project document). 
Among the known solutions, one may be chosen as the 
default solution to be used in other processes in which the 
trajectory is involved. 

 
• Observations object 

Contains observation records. Each observation record 
contains blocks of measurements data recorded in the 
field. Observation records are loaded into the database 
using the Import function. Ephemeris, Iono-UTC and 
almanac records may also be transferred to the database if 
the field data file includes such data. 

 
• Ephemerides object 

Contains ephemeris records. Each ephemeris record 
contains one or more block of ephemeris data, depending 
on the duration of field recording. Ephemeris records are 
loaded into the database using the Import function. 

 
• Iono-UTC object 

Contains iono-UTC records. Each Iono-UTC record 
contains one or more block of Iono-UTC data, depending 
on the duration of field recording. Iono-UTC records are 
loaded into the database using the Import function. 
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• Almanacs object 
Contains almanac records. Each almanac record contains 
one or more block of almanac data, depending on the 
duration of field recording. Almanac records are loaded 
into the database using the Import function. 

 

Adding a record 
 Click the desired database object in the left-hand pane of 

the window. As a result, the list of corresponding records 
appears in the right-hand pane. 

- From the menu bar, select the Record command and then 
the Add command 

 or click  in the tool bar 

 or double-click the desired database object in the left-hand 
pane of the database window 

 

Editing a record 
- Click the desired database object in the left-hand pane of 

the window. 

- Double-click the record you wish to edit 

 or select this record and, from the menu bar, select the 
Record command and then the Edit command 

 or select this record and, in the tool bar, click  

 

Deleting a record 
- Click the desired database object in the left-hand pane of 

the window. 
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- Select the record(s) you wish to delete from the list of 
records now shown in the right-hand pane. To select a list 
of records, first click the first record in the list, then, while 
holding down the Shift key, click the last record in the list. 

- From the menu bar, select the Record command and then 
the Delete command 

 or, in the tool bar, click  

 or press the Del key. 

 You then have to confirm your choice before the 
application really deletes the record(s). 

 

Database Commands 
 

 Project record Region record Map record Coord. syst record 
    · Add      · Add  
 · Edit  · Edit  · Edit  · Edit  
 · Delete  · Delete  · Delete  · Delete  
         · Import  
 
 Datum record Ellipsoid record Label record 
 · Add  · Add  · Add  
 · Edit  · Edit  · Edit  
 · Delete  · Delete  · Delete  
 
 
 Unit record Site record Trajectory record 
 · Add  · Add  · Add  
 · Edit  · Edit  · Edit  
 · Delete  · Delete  · Delete  
   · Import · Import 
    · Export  · Export  
 
 
 Observations Ephemerides Iono-UTC Almanacs 
 · Import  · Import  · Import  · Import  
 · Edit  · Edit  · Edit  · Edit  
 · Delete  · Delete  · Delete  · Delete  
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Shortcut menu 
A shortcut menu is available from any selection you make in the 
database by clicking the right mouse-button. The commands 
available from this shortcut menu are context-sensitive.  
 

Creating a new project document 

- In the tool bar click  or, from the menu bar select the 
File menu and then the New Project command. A 3-tab 
Project dialog box appears. 

-· Enter the parameters of your project, as requested in the 
following three tabs. 

 
• General tab  

 
 

 Project : Enter the name of your project 

 Supervised by : Enter the name of the project supervisor 
(your name) 

 Start on : Enter the start time of the project 

 Should end on : Enter the presumed end time of the project  
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 All coordinates in : Select the Coordinate system used from 
the list box. 

 Notes : Enter comments relative to the project 
(optional) 

 
 
 
• Region tab 

 

 
 

 Time zone : Choose the time zone corresponding to 
the region of survey (expressed in 
reference to UTC). From this combo box, 
you can choose a standard time zone �
such as UTC, UTC+01:00, UTC�01:00, 
etc.� or specify a positive or negative time 
correction, expressed in hours, minutes, 
seconds (see above). 
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 NW & SE coordinates :  Enter the 2D coordinates (expressed in 
the selected coordinate system) of the two 
points defining the region  

 
 Browse button : Use this button to select the name of an 

already known region. As a result, the "NW 
& SE coordinates" fields are automatically 
filled in. 

 Save button : Use this button to name and save a new 
region that you create. 

 World Map button : Use this button to define the region from 
the World Map. 

• Operations tab  
This tab allows you to define the Prediction and Process objects that 
you would like to insert into your project. 
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 Add button : adds a new operations object in the list 
box. The type of object you add is the one 
you specify in the text box shown in the 
right-lower part of the tab. A new dialog 
box then appears, whose type depends on 
the type of object you want to add: 

   New Process (see New Process object in 
page 3-14) 

   New Prediction (see New Prediction 
object in page 3-18) 

 Edit button : displays the definition of the selected 
object you defined earlier 

 Delete button : deletes the selected object. You need to 
confirm your choice before the application 
really deletes the selected object. 

 Insert button : inserts a new object before the selected object 
 Options button : gives access to a new tab on which you 

can set the input parameters of the object: 
   For a process (see Options of a process 

object in page 3-16) 

   For a prediction (see Options of a 
prediction object in page 3-19) 

- When the definition of the project document is complete, 
click the OK button. A new project document opens. 

 Unless a template other than the default one was 
implemented, the new document begins with the logo and 
address of DSNP, followed by the default project title 
(Mission Report) and possibly by the abstract and/or a 
Map server object (see Notes below). 
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 NOTES: 
- Like any Word document, your Project document is 

created from a template that you specify through the 
Options command (from the View menu). 

 The default template ("template.rtf" file stored in 
RTF subdirectory) contains the DSNP logo and 
address, followed by the centered title "Mission 
Report". 

 You may create other templates (RTF files 
necessarily) from Microsoft® Word for example. It is 
recommended to group all the templates in the RTF 
subdirectory. 

- The project abstract and a Map server object are 
inserted into the document if you respectively 
checked the "Insert Project Abstract" and the "Insert 
Map" buttons (see Options in the View menu). 

 
 
 

New Process object 
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 Compute : Define the process object by checking 
either the Site or Trajectory button, 
depending on whether you want to 
determine the position of a site or the 
successive positions along a trajectory. 

     Specify the name of the site or trajectory in 
the text box just under the two check 
buttons. The list of records that appears 
when you click the down-arrow button are 
those for which observation records are 
available. 

     In the Using Observation: text box, select 
the name of the observation record from 
which the site or trajectory can be 
determined. Remember that you create 
links between Site or Trajectory records 
and Observation records when you use the 
Import GPS Data function. 

 Reference : If the database contains a site and a static 
observation record for this site whose 
acquisition time coincides partially or 
completely with that of the observation 
record under process, then the application 
suggests that a differential process be run 
using this site as a reference. In that case, 
check the Site button in the Reference 
pane and choose a site name from the text 
box. In the Using Observation: text box, 
select the name of the observation record 
you want to use. 

     If several position solutions exist for the 
selected site, specify the solution you want 
to use by checking either the Last 
solution button or the Default solution 
button. 
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     If no sites are available, all check buttons 
in this pane (except the None button) are 
dimmed. 

 With 
 Processor : The application indicates the processors 

that can be used to process the 
observation record. Choose one if two or 
more processors are prompted. 

 

 OK button : Click this button if you agree with the 
definition of the process object 

 Cancel button : Click this button if you want to cancel the 
process object. 

 
 

Options of a process object 
The content of this Options dialog box depends on the selected 
process type. 

Dialog box example: 

 
 

 View : Use this text box to choose the type of 
result view you wish to insert into the 
project document. 
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 Elev. Min : Use this text box to specify the minimum 
elevation angle required of any satellite 
present in the observation record to be 
declared as usable in the process. 

 Use {...} Curtain : Check (or clear) this button to insert (or 
remove) the user-defined curtain. 

 Mask button : Click this button to access a chart on 
which you can mask satellites present in 
the observation record on a limited period 
of time (see Using the Mask editor) 

 Filter code with phase : Check (or clear) this button to enable (or 
disable) the code-filtering processing. 

 Initialisation Mode : (For kinematic process only) Use this text 
box to specify the initialisation mode you 
want the process to use when starting 
processing the observation record. 

 
   Deselected Svs 
   This pane allows you to make changes to the 

available GPS constellation, if necessary. 
   The numbers of the SVs present in the observation 

record(s) are shown in black. 

   The numbers of the SVs absent from the 
observation record(s) are shown in white. 

 

 {SV number} button : Depress the button corresponding to 
the satellite you wish to deselect, 
whether the SV is a present or an 
absent one 

 All button : Click this button to deselect all 
satellites. 

 None button : Click this button to re-select all the 
intentionally deselected satellites. 
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 Save As Defaults button : Click this button to save the current 
settings as the default options for the 
process 

 Restore Defaults button : Click this button to restore the default 
options previously defined for the 
process 

 OK button : Click this button to validate all the 
changes made to the parameters 
displayed in this box. 

 Cancel button : Click this button to cancel all the 
changes made to the parameters 
displayed in this box. 

 

New Prediction object 

 
 

 On Site : enter the label of the site of prediction 

 From : enter month, day and time of the beginning 
of prediction (default: current day at 
8hr00am) 

 During : enter the duration of prediction (default: 12 
hr). 

 To : (dimmed) resulting end time of prediction 
(default: current day at 8hr00pm) 

 OK button : Click this button if you agree with the 
definition of the prediction 
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 Cancel button : Click this button if you want to cancel the 
changes you have just made in the dialog 
box. 

 
Options of a prediction object 

 

 
 

 View : Use this text box to choose the type of result 
view you wish to insert into the project 
document. 

 Elev. Min : Use this text box to specify the minimum 
elevation angle required of any satellite seen 
from the prediction site to be declared as 
usable at this site. 

 Use Site Curtain : Check(or clear) this button to insert (or 
remove) the user-defined curtain. 

 GDOP type : Use this text box to specify the type of DOP 
you wish to view on the result plot: 

 GDOP : A measure of the Dilution of Precision in all 
three dimensions plus the time precision 

 PDOP : A measure of the Dilution of both 
Horizontal and Vertical Precisions 

 HDOP : A measure of the Dilution of Horizontal 
Precision only 
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 VDOP : A measure of the Dilution of Vertical 
Precision only 

 TDOP : A measure of the Dilution of Time 
Precision only 

 
 Mode : Use this text box to specify the DOP 

processing mode 

   2D+T should be chosen if the altitude is 
known, otherwise 3D+T. In 2D+T the GDOP 
computation is only concerned with two 
position unknowns instead of three. This 
leads to better (lower) figures of GDOP 

 

   Deselected Svs 
   This pane allows you to make changes to the 

available GPS constellation, if necessary. 
   The numbers of the SVs visible in the prediction are 

shown in black. 

   The numbers of the SVs invisible in the prediction 
are shown in white. 

 
 {SV number} button : Depress the button corresponding to a 

satellite you wish to deselect, whether 
the SV is a visible or an invisible one 

 All button : Click this button to deselect all 
satellites. 

 None button : Click this button to re-select all the 
intentionally deselected satellites. 

 

 Save As Defaults button : Click this button to save the current 
settings as the default options for the 
prediction 
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 Restore Defaults button : Click this button to restore the default 
options previously defined for the 
prediction 

 OK button : Click this button to validate all the 
changes made to the parameters 
displayed on this tab. 

 Cancel button : Click this button to cancel all the 
changes made to the parameters 
displayed on this tab. 

 

Opening an existing project document 
To open an existing project document: 

- In the tool bar click  or, from the menu bar, choose the 
File command and then the Open Project command. 

- In the Open Project dialog box that appears, choose a 
project name from the list and click the OK button. The 
existing document appears in the active window. 

 

Editing a project document 
3SPack Supervisor includes a document editor derived from the 
well-known Microsoft® Word Processor. The most commonly used 
editing commands available in 3SPack Supervisor are described 
below. 

• Typing text 
- Click the mouse pointer where you want to start typing (the 

blinking insertion point then shows up in the document) 
and then type your text. The document editor automatically 
wraps text to the next line as you type. 

- To end a paragraph, press the ENTER key. 
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• Selecting Text  
- Point where you want the selection to begin, and then drag 

over the text. 

- To select a single word, double-click the word 

- To select a paragraph, double-click in the selection bar at 
the left of the window 

 

• Deleting Text  
- Select the text and press BACKSPACE or DELETE. You 

can also delete the text you have just typed by selecting 
Undo from the Edit menu. 

 

• Moving Text 
- Select the text you want to move, point to the selected text, 

drag the dotted insertion point to the new location and then 
release the mouse button 

 or 

- Select the text you want to move, choose Cut from the 
Edit menu, point where you want the text to be moved and 
choose Paste from the Edit menu. 

• Copying Text 
- Select the text you want to copy, point to the selected text, 

drag the dotted insertion point to the new location while 
holding down the Ctrl key and then release the mouse 
button. 

 or 

- Select the text you want to copy, choose Copy from the 
Edit menu, point where you want the text to be copied and 
choose Paste from the Edit menu. 
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• Scrolling through the Project document 
- You can use the vertical and horizontal scroll bars to move 

quickly to a different part of your document. 

• Formatting Text 
 All formatting commands are grouped in the Format bar. 

Shortcut keys can also be used. 
 

 Choose font type and size for selected text : use these two boxes:  
Font Type:   
Font Size:  

 
  

 Add/Remove Bold to selected text : click  or press Ctrl + B 
 

 Add/Remove Italic to selected text : click  or press Ctrl + I 
 

 Add/Remove Underlining to selected text : click  or press Ctrl + U 
 

 Left-align text in selected paragraph(s) : click  or press Ctrl + L 
 

 Center text in selected paragraph(s) : click  or press Ctrl + E 
 

 Right-align text in selected paragraph(s) : click  or press Ctrl + R 
 

 Add/Remove bullet(s) to selected paragraph(s): click  
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• Inserting Objects 
The 3SPack-specific objects that you can insert into a project 
document are: 

- Map object 

- Abstract 

- Prediction object 

- Process object 

With 3SPack, you can also insert many other types of object such 
as: 

- Bitmap image 
- Microsoft Equation 
- Microsoft Graph 
- WordPad document, etc. 
 

To insert any type of object into the project document: 

- From the menu bar, select Insert and then Object 

In the Insert Object dialog box that appears: 

- Check the Create New button if the object does not exist 
yet and, from the Object Type list box, select the type of 
object you would like to create 

 or 
- Check the Create from File button if the object can be 

retrieved from an existing file. In that case, using the 
Browse button, provide the project with the path to this file. 

 Two options are prompted to link this file to the project 
document (this is achieved by checking the Link button) or 
to insert the file as an icon (by checking the Display as 
Icon button). 
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• Re-sizing objects 
- Click anywhere on the object you would like to re-size. 

- Move the pointer to one of its handles. The pointer then 
changes shape (the direction of the arrows depends on the 
handle you choose). 

- Drag the handle to the desired location and release the 
button when you get the desired size for the object. 

 

• Document template 
Like any Word document, your Project document is created from a 
template that you specify through the Options command (from the 
View menu). 

The default template ("template.rtf" file stored in RTF sub-directory) 
contains the DSNP logo and address, followed by the centered title 
"Mission Report". 

You may create other templates (RTF files necessarily) from 
Microsoft® Word for example. It is recommended to group all the 
templates in the RTF sub-directory. 
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Inserting the Map server into the project 
document 
The Map server object provides a graphic representation of your 
region of survey. In addition, if maps of the region are present in the 
database, they will appear in the background. 

Remember that the use of geographical (Lat-Long) coordinates in a 
project document may cause the map(s) available for your region of 
survey to be distorted. In this case, you may choose not to show the 
map(s) in the background by selecting the The project system 
option in the Viewing options of the Map Server (see section 4). The 
coordinate system used in a project document is defined in the 
General tab of the Project record. 

 
How to insert the map server object: 

- In the Project document, place the text insertion point 
where you would like the map server to appear. 

- From the menu bar, select Insert and then Map. This 
causes a new graphic object to be inserted into the 
document (and the Embedded Map environment is 
activated). 

 The object contains all the maps available for the region of 
the project. Initially, the object shows the whole region, 
which means that some maps may not display (because 
they are too reduced or too magnified, compared with the 
region size). 

 The object also shows the results (if any) of operations 
performed earlier in this region. 
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Asking for a prediction 
One of the first steps in preparing a GPS-based land survey is to find 
the best moment when to perform your survey, i.e. a time interval or 
time intervals during which the GPS constellation is favorable seen 
from the region or site of your survey. 

There are three ways of asking for a prediction: 

• From the Map server  
- Unless already done, insert the map of your survey into 

the project document. 

- Unless the Map Server is already active, double-click on 
the map. 

- From the menu bar, select Draw and then Prediction to 
add a prediction on the map. 

 In the dialog box which then appears, define a prediction 
for the selected site, as if you were doing it from the 
project document (see in the next page starting from the 
4th point). 

 The interesting feature of the Map Server is that if you 
invoke the Draw Prediction function after selecting 
several sites on the Map server, the system will let you 
define a prediction for each of these sites, proceeding 
successively in the order of selection. This procedure is 
particularly fast since most of the fields are then correctly 
preset and so you just have to click the OK button 
repeatedly (as many times as the count of selected sites). 

 
• From a Project document  

- From the menu bar, select the Project menu and then the 
Operations command. 

- In the lower-right text box of the Operations tab which 
then appears, select Prediction from the pop-up list 

- Click the Add button 
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- In the Add prediction dialog box enter the following 
parameters: 

 

 
 

 On Site : enter the label of the site of prediction 

 From : enter month, day and time of the beginning 
of prediction (default: current day at 
8hr00am) 

 During : enter the duration of prediction (default: 12 
hr). 

 To : (dimmed) resulting end time of prediction 
(default: current day at 8hr00pm) 

 
- Click the OK button to complete the prediction definition 

- As a result, the Operations tab of the Project dialog box is 
displayed again, in which the prediction you have just 
defined is highlighted. 

- Click the Edit button if you want to go back to the definition 
of the prediction 

- Click the Options button if you want to change the 
options of the prediction. 

- Click the OK button to validate the new prediction and to 
close the Project dialog box. 
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A second method exists from the Project document using the Insert 
menu. This method is faster than the first one since it allows you to 
define and run a prediction in a single operation: 

- Click the mouse in the Project document where you would 
like to insert the prediction object 

- From the menu bar, select Insert and then Prediction 

- In the Add prediction dialog box which then appears, 
define the prediction as you would with the first method 
(see previous page) 

- Click the OK button. This causes the prediction object to 
be directly inserted into the project document (prediction 
created and run in a single operation). 

 

• From the Database Manager  
- Click the Project database object in the left-hand pane of 

the window. 

- In the list of projects now shown in the right-hand pane, 
double-click the project record into which a prediction 
needs to be inserted. As a result the corresponding project 
document opens (3SPack switches from the database to 
the Project environment) 

- Then proceed as you would from the Project document. 
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Running a prediction 
This can be performed only in the Project environment and after 
defining a prediction. 

- From the menu bar, select the Project command and then 
the Run command 

 or 

 Click  

- In the Project Run dialog box which then appears, select 
the prediction you want to run 

- Click the Run button. As a result, a prediction plot appears 
in the project document. 

 

 NOTE: You can create and run a prediction in a single 
operation using the Insert menu (see above). 

 

Importing GPS Data 
Through the Import GPS Data function, you provide 3SPack with 
the field data that are needed to compute your site and trajectory 
solutions. 

In fact when you use this function, you allow 3SPack to enrich its 
database with new records from the field data file(s) that you 
specify. 

GPS Data files are the results of your field surveys. They can be 
loaded into a specific directory of your computer (Raw directory 
created for that purpose) to be imported as observation records, 
which 3Spack can then process. 

Other records can be created from the same files, using the same 
procedure, such as ephemeris, iono-UTC and almanac records. 
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- In the toolbar, click  or, from the menu bar, select the 
File command and then the Import GPS Data command 

- In the Import GPS Data Dialog box that appears, click the 
Add button 

- The Browse dialog box which then appears shows the 
content of the Raw directory where all types of GPS raw 
data are supposed to be located. 

- If your survey was performed with the field data files 
recorded on a PCMCIA card, then insert this PCMCIA into 
the PCMCIA drive of your PC and, from the Look In 
combo box of the Browse dialog box, choose this drive 
and then select the files. 

- Double-click a file icon (corresponding to the data you wish 
to acquire), or click this icon and then the Open button. To 
make a multiple selection, first click the first file in your list 
and then, while holding down the Shift key, click the last 
file in your list. 
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- Now that the name of the file you have just selected 
appears in the Import GPS Data Dialog box and is 
highlighted (as shown in the dialog box example above), 
you can specify the following parameters (for a multiple 
selection, you need to highlight each file individually): 

 
 Format : Specify the format of the selected file 

(DSNP ASCII or DSNP binary) 

 Ephemerides : Keep this button checked if you want to 
acquire the ephemeris data that may be 
contained in the selected file (otherwise 
clear it) 

 Iono-UTC : Keep this button checked if you want to 
acquire the iono-UTC data that may be 
contained in the selected file (otherwise 
clear it) 

 Almanacs : Keep this button checked if you want to 
acquire the almanac data that may be 
contained in the selected file (otherwise 
clear it) 

 1st frequency 
 raw data : Dimmed (and forcibly checked) if the 2nd 

frequency raw data button is checked. 

   If the 2nd frequency raw data button is 
cleared, keep this button checked if you 
want to acquire the single-frequency raw 
data that may be contained in the selected 
file (otherwise, clear it) 

 2nd frequency 
 raw data : Keep this button checked if you want to 

acquire the dual-frequency raw data that 
may be contained in the selected file 
(otherwise clear it). If you clear it, the 1st 
frequency raw data button can be freely 
cleared or checked 
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 Observation : Should contain the name of the observations record 
that will result from each imported file. By default, 
3SPack completes this field with the name of the 
highlighted file without the extension (dimmed text box 
if several files are highlighted) 

 Association : This pane should be used: 

  - to tell 3SPack whether each of the imported files 
corresponds to a survey performed at a site or 
along a trajectory. To do this, click the 
corresponding radio button for each highlighted file 

  - to allow 3SPack to make an association between 
each of the imported files and the corresponding 
site or trajectory present in its database. 3SPack 
will automatically prompt the right site or 
trajectory name if you take care to observe 
naming rules, as illustrated in the example below. 

 - Assuming a site named "pylon" where the operator performed a 
data record held in a file named "pylon270397.raw" 

 - If the file is imported as "pylon270397", then 3SPack will 
automatically associate the imported file with the "pylon" site 

    If in the 3SPack database there is no corresponding 
site or trajectory for the highlighted file, the message 
"New" (instead of "Existing") will appear in the upper 
part of the Association pane prompting you to create 
a new site or trajectory for this file. A name for this site 
or trajectory will be prompted in the lower combo box 
(which for the circumstance will be an edit box instead 
of a simple drop-down list). The default name will 
comply with the naming rule explained above.  

 For this case of importing where in the same time a 
site or trajectory is created, the newly created site or 
trajectory record will feature an approximate "Natural 
GPS" position solution computed with the first 
measurements read from the resulting observations 
record. 
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 You can also create a new site or trajectory before 
importing a file by selecting <New> in the lower 
combo box. In this case you will have to provide a 
position solution for this new record. 

 
 Back up imported  
 source files : You can ask for automatic back-up of any raw data 

file that you import by checking this button. Back-up 
files are saved to the <3SPack>\Raw\Bak directory. 
They are in the same format as the original files. 

 

- Click the Go button to start importing the data. A message 
appears indicating data import in progress. 

- At the end of this step, one or more new records are added to 
the database (observations, ephemerides, almanacs, etc.). 

 

Creating a new site 
You may need to create a new site for example to provide 3SPack 
with the approximate coordinates of the site you want to survey. 

In a further step, and from the data recorded in the field, 3SPack will 
provide a more accurate solution for this site's position. 

There are two ways of creating a new site: 
 

From the Map Server 
- Unless already done, insert the map of your survey into 

the project document 
- Unless the Map Server is already active, double-click on 

the map 
- From the menu bar, select Draw and then Site or in the 

toolbar, click  to add a site on the map. 
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 In the dialog box which then appears, define a site as if you 
were doing it from within the database. 

 
• General Tab  

 

 
 

 Site : Enter/modify the name of the site 
 
 Default Solution  
 & Last Solution : Displays the default solution and the last 

(computed) solution for the new site. If you 
are creating a site, no solution has been 
determined yet for this site. Therefore 
these two solutions are software-set as 
follows: 

 Date & Time : current date & time 
 Lat & Long : zero coordinates 
 Alt : 0.000 m 
 Sigma : 0.00000 m 
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     Later, the application will refresh the 
"default solution" zone when you define 
your "default solution" in the Solutions tab 
and also the "last solution" zone when a 
process provides a position solution for 
this site. 

 Notes : Enter comments relative to the site 
(optional) 

 
• Solutions Tab  

 

 
This tab can contain several position solutions for the site. 

If you are creating a site, this tab contains a single solution (with zero 
coordinates) defined as the "default solution". You then have to re-
define this solution as your "user solution", i.e. an approximate 
position (or a position determined by other means) of this site. 

Later, the application will add new solutions to this tab whenever a 
process determines a new position solution for this site. 
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User solutions are defined as follows: 

 Date & Time : Displays current date & time (software-set) 

 
Position pane: 
 Lat & long : Enter Latitude and Longitude 

 Alt : Enter altitude (optional) 

 
 SdP 
 Correlation Matrix 
 SdUW : Irrelevant to a user solution (leave these 

fields blank). Only a solution resulting from 
a process can provide values for these 
parameters. 

 
Notes pane   : Origin of the site solution 

     If the solution was imported from a file, 
then this box contains the section of file 
from which the solution was created (file in 
SVAR format, see Appendix). 

 New button : Click this button to enter another user 
solution. The tab then shows a new blank 
sheet. The new count of site solutions is 
displayed in the right-hand upper part of 
the tab. Enter a new user solution as 
described above. 

 Vertical Scroll Bar : Click the up and down arrows of the Scroll 
bar to consult the list of solutions 

 Delete button : Click this button to delete the displayed 
solution 
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 Protected solution : Check this button if you wish to protect the 
solution displayed above from accidental 
typing. As a result, all text boxes in the 
Position pane get dimmed 

 Default solution : Among the solutions that you enter in the 
Solutions tab, one (the first by default) 
should be chosen to be the "default 
solution". You need to specify a "default 
solution" to tell the application which of 
these solutions should be used whenever 
the site is involved in a process. Of course 
the default position should present the best 
precision possible. 

   Check this button when you wish to define 
the displayed solution as the "default 
solution". A single solution can be defined 
as the "default solution" 

 
• Observations Tab  

 

 
 

This tab shows the list of observation records associated with the 
site. The list is read from the database. 



3SPack Supervisor 
Creating a new site 

DSNP 3-39 

 

 
• Curtain Tab  

 

 
 

This tab allows you to draw an object representing the shape and 
dimensions of the curtain around the site, if any. 

- Position the mouse pointer anywhere on the graph and 
click with the right mouse button. 

- In the shortcut menu that pops up, select the Draw 
command. The mouse pointer then changes to  

- Position the mouse pointer to the desired location, referring 
to the Az and Ev indications, and click with the mouse to 
begin drawing the curtain. 

- Move the mouse pointer to reach the next point. Note the 
curve that results from the pointer displacement (a straight 
line on the Linear View, an arc on the Polar View). Once 
you have reached the next point, click with the mouse 
again, etc. 
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- To complete the curtain definition, double-click on the last 
point. As a result, the curtain appears in blue as a close 
shape, even if the last point is not superimposed on the 
first one. On the Linear view, the curtain is always a 
polygon, on the Polar view it is a close shape composed of 
several arcs. 

 
- When the definition of the site is complete, click the OK 

button. The new site then appears as a new record in the 
list of existing sites. 

 

 

 

From the Database manager window 
See Database Manager, Adding a record. 
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Creating a new trajectory 
You may need to create a new trajectory for example to provide 
3SPack with the approximate coordinates of a trajectory's initial 
point. 

In a further step, and from the data recorded in the field, 3SPack will 
provide a more accurate solution for each of the points making up 
the trajectory. 

There are two ways of creating a new trajectory: 

 

From the Map Server 
- Unless already done, insert the map of your survey into 

the project document 

- Unless the Map Server is already active, double-click on 
the map 

- From the menu bar, select Draw and then Trajectory or in 
the toolbar, click  to add a trajectory on the map. 

 In the dialog box which then appears, define a trajectory as 
if you were doing it from within the database. 
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• General Tab  
 

 
 

 Trajectory : Enter/modify the name of the trajectory 

 Default solution : "No solutions" is displayed if you are adding a 
new trajectory record 

 Last solution : "No solutions" is displayed if you are adding a 
new trajectory record 

 Initial point : Enter the three coordinates of the start point of 
the trajectory. 

     You can type in these coordinates directly or click 
the Browse button to choose one of the known 
sites as the initial point (in which case the 
corresponding fields are automatically filled in as 
you choose the site). 

 Notes : Enter comments relative to the trajectory 
(optional) 
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• Solutions Tab  
If you are adding a trajectory record ("manually" from within the 
Database Manager or from the Map Server), no solutions are 
available yet and therefore nothing is displayed in this tab 

Later on, when a process is run to determine the trajectory, a 
number of solutions will appear (as shown in the example below). 

 
 

Each solution is composed of the following parameters: 
 

 Date : Displays the date when the solution was 
calculated (software-set) 

 Time : Displays the time when the solution was 
calculated (software-set) 
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 SdP : Standard Deviation of Position 

 View : Check the All points or Marked points 
button, depending on whether you want to 
view all the points of the trajectory solution 
or only those marked earlier 

 Rightmost 
 Vertical Scroll bar : Click the up and down arrows of this Scroll 

bar to display any of the solutions 
available. 

 
 
 
Positions pane 
 Vertical Scroll Bar : Click the up and down arrows of this Scroll 

bar to display any of the points of the 
chosen solution 

 Gps : Date & time of the solution acquisition 

 Lat & long : Latitude and Longitude of the displayed 
point 

 Alt : Altitude of the displayed point 

 SdP : Standard Deviation of Position 

 Correlation Matrix : Position variations along the three axes 

 SdUW : Standard Deviation of Unit Weight 

 Notes : Origin of trajectory solution 

     If the solution was imported from a file, 
then this box contains the section of file 
from which the solution was created (file in 
SVAR format, see Appendix). 
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 Delete button : Click this button if you want to delete all 
the points of the currently displayed 
solution 

 Default solution : Check this button when you wish to define 
the displayed solution as the "default 
solution". If a single solution is available, 
then this button is dimmed and checked. 

 
 

• Observations Tab  
This tab shows the list of observation records associated with the 
trajectory. The list is read from the database. 

 

 
 

- Click the OK button once your trajectory is defined. 

 

 

 

From the Database manager window 
See Database Manager, Adding a record. 
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Importing sites and trajectories 
This function allows you to insert sites and/or trajectories into the 
3SPack database from a file (or from files) that you specify. 
You need to tell 3SPack the name of the coordinate system in which 
the sites and trajectories contained in the file are expressed. 
Sites and trajectories can be imported if they are defined in one of 
the following formats: 

- ASCII SVAR (a DSNP standard format, see Appendix) 
- ASCII DXF (from AutoCad) 

- A format created by the user (see Creating a User 
Format in page 3-64) 

You cannot specify which of the sites or trajectories you would like to 
import from the chosen file(s) but instead you can only import all or 
none of them. 
If a site (or trajectory) contained in the file already exists as a site (or 
trajectory) record in the database, then the Import function will add a 
new solution to that record. 
If a site (or trajectory) is unknown to the database, then the Import 
function will create a new record in the database, named as 
specified in the file. If no name is mentioned in the file for this new 
record, then the imported record will be named "Site #" or "Trajectory 
#", where # is a number from 1 to x. 
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• Import Procedure 
- Select the Sites or Trajectories object in the left-hand 

pane 

- In the toolbar, click    or from the menu bar, select 
Record and then Import 

- In the Import Positions dialog box which then appears, 
click the Add button 

- In the Browse dialog box which then appears, choose the 
file containing the sitesand/or trajectories you want to 
import (default directory: Points) 

- Click the Open button. This causes the path of the 
selected file to appear in the Import Positions dialog box 
(Import text box) and the Browse dialog box to close. 

- In the Import Positions dialog box, do the following: 
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 Format : Specify the format of the file containing the 
sites and/or trajectories 

 User formats button : Click this button if you want to add or 
modify a user format (see also Creating a 
User Format in page 3-64) 

 Default projection : Specify the projection system in which the 
sites and trajectories from the chosen file 
are expressed. You must specify a 
projection system otherwise the import 
function won't execute and a message will 
appear asking you to define this parameter 

   If a projection is mentioned in the imported 
file, then this projection will be 
automatically chosen 

 Default object : If the type (site or trajectory) of an 
imported point is missing in its 
characteristics, 3Spack will allocate one on 
the basis of the radio button that you 
checked in this tab: 

   Default is Site checked means that all 
"unknown"points will be imported as sites 

   Default is Trajectory checked means that 
all "unknown"points will be imported as 
trajectories 

- Click the Go button to start the Import function. A message 
appears providing information on the Import function in 
progress. On import completion, the message box 
disappears. 
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Defining and running a site process 
The procedure is summarized in the diagram below. 

 

Site Record

Observation Record

GPS Data & Measurements

Import function

+ 1 Site Solution

Server Object
inserted into
(or updated in)
Project document

Database

Run function

Server
Object

Project document

Processor

 
 

Use one of the following procedures to define a Site process: 
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From the Map Server 

- Unless already done, insert the map of your survey into 
the project document 

- Unless the Map Server is already active, double-click on 
the map 

- Select the site you want to process 

- From the menu bar, select Draw and then Process. 

- In the dialog box which then appears, define a Site process 
as if you were doing it from the project document (see 
below). 

- The interesting feature of the Map Server is that if you 
invoke the Draw Process function after selecting several 
sites on the Map server, the system will let you define a 
process for each of these sites, proceeding successively in 
the order of selection. This procedure is particularly fast 
since most of the fields are then correctly preset and so 
you just have to click the OK button repeatedly (as many 
times as the count of selected sites). 
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From the Project document 
- From the menu bar, select the Project command and then 

the Operations command. 

- In the lower-right text box of the Operations tab which 
then appears, select Process from the pop-up list 

- Click the Add button. In the Add Gps process dialog box 
enter the following parameters: 

 Compute : Define the process object by checking the 
Site button. 

     Specify the name of the site in the text box 
just under the two check buttons. The list 
of records that appears when you click the 
down-arrow button is the list of sites for 
which observation records are available. 

     In the Using Observation: text box, select 
the name of the observation record from 
which the site can be determined. 
Remember that you create links between 
Site records and Observation records 
when you use the Import GPS Data 
function. 

 Reference : If the database contains a site and a static 
observation record for this site whose 
acquisition time coincides partially or 
completely with that of the observation 
record to be processed, then the 
application suggests that a differential 
process be run using this site as a 
reference. 
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   In that case, check the Site button in the 
Reference pane and choose a site name 
from the text box. In the Using 
Observation: text box, select the name of 
the observation record you want to use. 

     If several position solutions exist for the 
selected site, specify the solution you want 
to use by checking either the Last 
solution button or the Default solution 
button. 

     If no sites are available, all check buttons 
in this pane are dimmed. 

 With 
 Processor : The application indicates the processors 

that can be used to process the 
observation record. Choose one if two or 
more processors are prompted. 

 OK button : Click this button if you agree with the 
definition of the process object 

 Cancel button : Click this button if you want to cancel the 
process object. 

- Click the OK button to complete the process definition 
- As a result, the Operations tab of the Project dialog box is 

displayed again, in which the process you have just defined 
is highlighted. 

 Click the Edit button if you want to go back to the definition 
of the process 

 Click the Options button if you want to change the 
options of the process. 

- Click the OK button to validate the new process and to 
close the Project dialog box. 
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A second method exists from the Project document using the Insert 
menu. This method is faster than the first one since it allows you to 
define and run a process in a single operation: 

- Click the mouse in the Project document where you would 
like to insert the process object 

- From the menu bar, select Insert and then Process 

- In the Add Gps process dialog box which then appears, 
define the process as you would with the first method (see 
previous page) 

- Click the OK button. This causes the process object to be 
directly inserted into the project document (process 
created and run in a single operation). 

 

 
 

From the Database 
- Click the Project database object in the left-hand pane of 

the window. 

- In the list of projects now shown in the right-hand pane, 
double-click the project record into which a site process 
needs to be inserted. 

 
If the project is already open 

- 3SPack Supervisor then switches from the Database to the 
Project environment to show the project document: 
proceed as you would from the Project document. 
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If the project is not open 
 The Project dialog box then appears. 
- Select the Operations tab 
- In the lower-right text box, select Process from the pop-up 

list 
- Click the Add button. In the Add Gps process dialog box 

proceed as you would from the project document 
 

Running a Site process 
This can only be performed in the Project environment and after 
defining a Site process in the project document. 

- From the menu bar, select the Project command and then 
the Run command 

 or 

 Click  

- In the Project Run dialog box which then appears, select 
the process corresponding to the site solution you want to 
obtain. 

- Click the Run button. As a result, a process plot appears in 
the project document and a new site solution is added to 
the corresponding site record as the "last solution" for the 
site. 

 

 NOTE: You can create and run a process in a single 
operation using the Insert menu (see above). 
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Defining and running a Trajectory process 
The procedure is summarized in the diagram below. 

 

Trajectory Record
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Use one of the following procedures to define a trajectory process: 
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From the Map Server 
- Unless already done, insert the map of your survey into 

the project document 

- Unless the Map Server is already active, double-click on 
the map 

- From the menu bar, select Draw and then Process. 

 In the dialog box which then appears, define a Trajectory 
process as if you were doing it from the project 
document (see below). 

- The interesting feature of the Map Server is that if you 
invoke the Draw Process function after selecting several 
trajectories on the Map server, the system will let you 
define a process for each of these trajectories, proceeding 
successively in the order of selection. This procedure is 
particularly fast since most of the fields are then correctly 
preset and so you just have to click the OK button 
repeatedly (as many times as the count of selected 
trajectories). 

 

From the project document 
- From the menu bar, select the Project command and then 

the Operations command. 

- In the lower-right text box of the Operations tab which 
then appears, select Process from the pop-up list 
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- Click the Add button. In the Add Gps process dialog box 
enter the following parameters: 

 Compute : Define the process object by checking the 
Trajectory button. 

     Specify the name of the trajectory in the 
text box just under the two check buttons. 
The list of records that appears when you 
click the down-arrow button is the list of 
trajectories for which observation records 
are available. 

     In the Using Observation: text box, select 
the name of the observation record from 
which the trajectory can be determined. 
Remember that you create links between 
Trajectory records and Observation 
records when you use the Import GPS 
Data function. 

 Reference : If the database contains a site and a static 
observation record for this site whose 
acquisition time coincides partially or 
completely with that of the observation 
record to be processed, then the 
application suggests that a differential 
process be run using this site as a 
reference. In that case, check the Site 
button in the Reference pane and choose 
a site name from the text box. In the Using 
Observation: text box, select the name of 
the observation record you want to use. 
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     If several position solutions exist for the 
selected site, specify the solution you want 
to use by checking either the Last 
solution button or the Default solution 
button. 

     If no sites are available, all check buttons 
in this pane are dimmed. 

 With 
 Processor : The application indicates the processors 

that can be used to process the 
observation record. Choose one if two or 
more processors are prompted. 

 OK button : Click this button if you agree with the 
definition of the process object 

 Cancel button : Click this button if you want to cancel the 
process object. 

 

- Click the OK button to complete the process definition 

- As a result, the Operations tab of the Project dialog box is 
displayed again, in which the process you have just defined 
is highlighted. 

 Click the Edit button if you want to go back to the definition 
of the process 

 Click the Options button if you want to change the 
options of the process. 

- Click the OK button to validate the new process and to 
close the Project dialog box. 
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A second method exists from the Project document using the Insert 
menu. This method is faster than the first one since it allows you to 
define and run a process in a single operation: 

- Click the mouse in the Project document where you would 
like to insert the process object 

- From the menu bar, select Insert and then Process 

- In the Add Gps process dialog box which then appears, 
define the process as you would with the first method (see 
previous page) 

- Click the OK button. This causes the process object to be 
directly inserted into the project document (process 
created and run in a single operation). 

 

From the database 
- Click the Project database object in the left-hand pane of 

the window. 

- In the list of projects now shown in the right-hand pane, 
double-click the project record into which a trajectory 
process needs to be inserted. 

 

If the project is already open 
- 3SPack Supervisor then switches from the Database to the 

Project environment to show the project document: 
proceed as you would from the Project document. 
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If the project is not open 
 The Project dialog box then appears. 

- Select the Operations tab 

- In the lower-right text box, select Process from the pop-up 
list 

- Click the Add button. In the Add Gps process dialog box 
proceed as you would from the project document 

 

Running a trajectory process 
This can only be performed in the Project environment and after 
defining a Trajectory process in the project document. 

- From the menu bar, select the Project command and then 
the Run command 

 or 

 Click  

- In the Project Run dialog box which then appears, select 
the process corresponding to the trajectory solution you 
want to obtain. 

- Click the Run button. As a result, a process plot appears in 
the project document and a new trajectory solution is 
added to the corresponding trajectory record as the "last 
solution" for the trajectory. 

 

 NOTE: You can create and run a process in a single 
operation using the Insert menu (see above). 
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Exporting project results 
The Export function allows you to provide the results of your survey 
in a format different from that used in the project document. 

The Export function is very useful if for example further processings 
have to be made from your results, but with different tools. 

Results can be exported in one of the following formats: 

- ASCII SVAR (a DSNP standard format, see Appendix) 

- ASCII DXF (from AutoCad) 

- A format created by the user (see Creating a User 
Format in page 3-64) 

 
Exporting results can be performed from within the Database 
Manager or from the Map Server. Only Site and Trajectory records 
can be exported. 
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Export Procedure  
To export a site or trajectory record, proceed as follows: 

- Open the Database manager or the Map Server 

- Select the record (or the type of object) you want to export 

- From the menu bar, select the Record and then the 
Export command 

 or 

- Click  

- In the dialog box that appears, prepare your export 
according to the instructions below. 

 
 

 Export list box : Contains the record(s) you have selected 
before invoking the Export function (empty 
if you have selected the Trajectory or Site 
object). The content of this box is then 
controlled by the following three buttons. 

 Add button : Click this button to add a result record in 
the Export list box 
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 Edit button : Click this button to edit the selected record 
 Remove button : Click this button to remove the selected 

record from the Export list box 
 Select : Check the Default Solution or Last Solution 

button, depending on the solution(s) you want 
to export for the selected record 

     If a Trajectory record is selected, check also 
the All points or Marked Points button, 
depending on the solution(s) you want to 
export. 

 In File : Specify the path and name of the export file 

     Click  to scroll through your disk 
 Format : Choose the format in which to export the 

selected records. Two basic formats are 
available plus those created by the user 

 User Formats 
 button : Click this button to create/edit/delete a user 

format. First a dialog box appears showing 
the names of the existing user formats. Make 
the appropriate selection. Then the User 
Format dialog box appears (see on the next 
page) 

 Projection : Choose the name of the projection (from the 
pop-up list) in which to express the 
coordinates of the exported points 

 Go button : Click this button to export the highlighted 
records (as shown in the Export list box) 

 Cancel button : Click this button to cancel the Export function 
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Creating a User Format 
- Open the Manager window  

- Select any trajectory or site record (or the trajectory or site 
object) 

- From the menu bar, select the Record and then the 
Export command 

 or 

 Click  

- In the dialog box that appears, click the User Formats 
button. 

- In the new dialog box that appears, define your user format 
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 Format : Enter a name for your format 

 Export : Choose the first parameter you want to 
insert into your format from this list box. 
Then specify the following for this 
parameter 

 Field Type : Check either Fixed or Variable to define 
the character size of the parameter. 

     If you choose Fixed, then specify the 
number of characters (length) and the 
position (left or right) of the parameter in 
the field. 

     If you choose Variable, then just specify 
the character used as the separator ("," by 
default) 

 Field Format : Depending on the chosen parameter, 
specify additional formatting instructions 
(such as number of decimal places, units 
used, time format, etc.). For some of the 
available parameters, the format is 
dependent on the projection used. 

     Note the simulation of your formatting 
instructions for this parameter in the lower 
part of the dialog box (simulation box) 

 Add  : Click this button to add a new parameter to 
the current user format 

 Insert  : Click this button to insert a new parameter 
into the current user format, before the 
parameter shown in the Export text box. 
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 Remove  : Click this button to remove the parameter 
shown in the Export text box from the 
current user format. 

 Vertical 
 bar : Use this bar to scroll through the list of 

parameters defined in the current user 
format. 

 Simulation 
 box : This box shows a simulation of your 

message, as it would be obtained from 
your formatting instructions. Alternately, 
this box can be used as the Vertical Scroll 
bar to display the definition of each 
parameter in the user format. You can 
scroll up or down the entire list of 
parameters by clicking repeatedly and 
respectively in the left-hand part or right-
hand part of the box. 

 
 

Saving/closing a project document 

 
To save the active project document: 

- In the tool bar click  or, from the menu bar, choose the 
File command and then the Save Project command. 

 
To close the active project document: 

- Choose the File command from the menu bar and then the 
Close Project command. This causes the active project to 
be automatically saved and then closed. 
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Printing the project document 
3SPack Supervisor allows you to print your project document on a 
printer. From the File menu in the Project environment, three print-
oriented commands are available. 

 
Page Setup  

 
Select this command to change margins, paper source, paper size, 
or page orientation of your project document. 

Paper pane 
 Size : Select a paper size available for your 

printer 

 Source : Sets options for printing pages of your 
project document, including the type of 
printer paper tray and manual feed. 
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Orientation pane 
     Select a page orientation (Portrait or 

Landscape). When you change the 
orientation of a page, 3SPack Supervisor 
transfers the Top and Bottom margins to 
the Left and Right margins, and vice versa. 

     The upper part of the dialog box shows the 
selected pattern of page orientation. 

Margins pane 
 Left : Type the distance between the left edge of 

the page and the left end of each line with 
no left indent. 

 Right : Type the distance between the right edge 
of the page and the right end of each line 
with no right indent. 

 Top : Type or select the distance between the 
top of the page and the top of the first line 
on the page. 

 Bottom : Type or select the distance between the 
bottom of the page and the bottom of the 
last line on the page. 

Printer button 
     Gives access to the printer dialog box from 

which you can choose another printer and 
change its characteristics. 
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Print Preview 
Select this command to get a preview of your project document 
before printing it. 

 Print : After visual inspection of your document, 
click this button to access the Print dialog 
box 

 Next Page : Click this button to preview the next page 

 Prev Page : Click this button to preview the previous 
page 

 One Page/Two Page : Click this button to preview a single page 
or two consecutive pages 

 Zoom in : Click this button to zoom in in the project 
document (dimmed when the maximum 
zoom-in ratio is reached) 

 Zoom out : Click this button to zoom out in the project 
document (dimmed when the page is 
shown with normal size) 

     Alternately, you can zoom in/zoom out in a 
document by moving the pointer anywhere 
on the project document and then by 
clicking with the left mouse button. The 
document is then zoomed in (or out) with 
the new view centered around the pointer 
location). 

 Close : Click this button to close the Preview 
window 
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Print  
Select this command to print your project document. First the Print 
Dialog box appears. 

 
 

Choose the following: 
 

 Printer : Select a printer from the "Name" list box. 

     You cannot add a printer using 3SPack 
Supervisor. If you need to define a new printer, 
do it using Windows95 select (from the task 
bar, select "Start", "Settings" and "Printers"). 

 Properties : Provides access to a dialog box in which you 
can set the different properties of the selected 
printer 

 Print to file : Check this button to save the file formatted for 
printing to another file 

 Print Range : Specify the page(s) you want to print out. 

 Copies : Specify the number of copies  
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Using the World Map editor  
The World Map editor allows you to define a region of survey. All 
maps stored into the database are shown 

 

 
 

Displaying the World Map 
- From the menu bar of the active project document, select 

Project and then Region. In the dialog box which then 
appears, click the World Map button. 

- If you are creating a new project document (the Project 
dialog box is then displayed), select the Region tab in this 
dialog box and click the World Map button. 

- From the Database Manager, if a Region record is edited 
or added, click the World Map button in the displayed 
dialog box. 
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Rotating the globe 
If the current view of the globe does not display the region where you 
would like to prepare a survey, a function is available allowing you to 
rotate the globe: 

- Position the mouse pointer anywhere on the pane of the 
World Map window. 

- Click the right mouse button. The World Map shortcut 
menu pops up. 

- Choose the Grabber command from this menu. The menu 
vanishes and the pointer looks like  

- Depress the left mouse button and drag the pointer in 
order that the desired region can be seen on the visible 
side of the globe. Note that the globe will rotate only when 
you release the mouse button. Note also that the rotation 
angle is defined by the distance covered by the pointer 
when you drag it. 

 
Zooming in on a particular region 

- Position the mouse pointer anywhere on the pane of the 
World Map window. 

- Click with the right mouse button. The World Map shortcut 
menu pops up. 

- Choose the Zoom In command from the menu. As a result 
the menu vanishes and the pointer looks like . 

- Position the pointer somewhere on the region on which you 
want to zoom in and click with the left mouse button. As a 
result the window displays a magnified view of the region, 
centered around the clicked point 

 You can zoom in repeatedly (i.e. so long as the mouse 
pointer looks like . Up to 6 successive zoom-in 
operations are possible from the initial view of the World 
Map. 
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Zooming out 
- Position the mouse pointer anywhere on the pane of the 

World Map window. 
- Click with the right mouse button. The World Map shortcut 

menu pops up. 
- Choose the Zoom Out command from this shortcut menu. 

As a result the menu vanishes and the pointer looks like 
. 

 Position the pointer somewhere on the region and click 
with the left mouse button. As a result the window displays 
a larger-scale view centered around the region 

 You can zoom out repeatedly (i.e. so long as the mouse 
pointer looks like ) until you reach the view of the entire 
globe. 

 
Selecting a region on the World Map 
The N/W & S/E coordinates of a region may be typed in directly or 
defined graphically from the World Map. For a "graphic" definition, 
do the following: 

- Click the World Map button in the upper part of the 
Region tab 

- Zoom in on the location you are interested in 
- Choose the Draw command from the World Map shortcut 

menu 
- Drag the mouse button so as to surround the desired 

region. Release the mouse when you agree with the 
selection 

- Click the OK button. 
- In the Region tab which then displays again, note that the 

N/S & S/E coordinates now correspond to the region you 
have just defined on the World Map 
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- Enter a name for the new region in the Region text box 
and specify the Time Zone 

- Click the OK button to complete the definition of the new 
region. This new region is now available from the 
database. 

 
Changing the viewing options on the World Map 

- Position the mouse pointer anywhere on the pane of the 
World Map window. 

- Click with the right mouse button. The World Map shortcut 
menu pops up. 

- Choose the Options command from this shortcut menu. 
As a result the Options dialog box appears. The default 
options are shown below. 

 
Four levels of map resolution are available: 

- Low 

- Medium 

- High 

 Very High 

The higher the resolution, the more accurate the details on the 
map... but the longer the time required to display the map. 
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Using the Curtain editor 
Seen from a site, some directions in space may exist in which GPS 
reception is known to be bad. The concept of "curtain" is introduced 
specifically to describe these particular directions so that they can be 
"curtained" by the user if he or she wishes to do so. 
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What a Curtain is 
The curtain consists of one or more "obstruction zones" seen from 
the site. Each obstruction zone is defined in relation to Azimuth (Az) 
and Elevation (Ev). 

The curtain may be drawn on a polar or linear view. Once the curtain 
is drawn on a view, it is also visible on the other (see example below, 
curtain shown in blue). 

Curtain on linear view Same curtain seen on polar view 

  
 

The curtain may also be defined by specifying each of the points 
making it up. As a result, the curtain also appears on the two views 
as if it had been drawn. 

On the chart, the area located between Elevation Angle 0° and the 
user-set Min Ev angle (see bottom of the tab) is considered as part 
of the curtain (also shown in blue). 

When you enable the curtain in a process or prediction object, you 
allow the application to behave as if there were no GPS signals 
received in the curtain's directions. 
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Accessing the Curtain Graph 
- Open the Database window. 

- In the left-hand pane, click the Sites object. 

- In the right-hand pane, double-click the icon of the site for 
which you want to define a curtain. 

- Select the Site Curtain tab 

- In this tab, draw the curtain or edit the curtain. 

 

Changing the curtain view  
- Position the mouse pointer anywhere on the graph and 

click with the right mouse button. 

- In the shortcut menu that pops up, select the Linear or 
Polar view. The corresponding view then appears on the 
screen. 

 

Drawing a curtain 
After accessing the Curtain Graph : 

- Position the mouse pointer anywhere on the graph and 
click with the right mouse button. 

- In the shortcut menu that pops up, select the Draw 
command. The mouse pointer then changes to    

- Position the mouse pointer to the desired location, referring 
to the Az and Ev indications, and click with the mouse to 
begin drawing the curtain. 

- Move the mouse pointer to reach the next point. Note the 
curve that results from the pointer displacement (a straight 
line on the Linear View, an arc on the Polar View). Once 
you have reached the next point, click with the mouse 
again, etc 
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- If you need to go through the 0/360° or 360/0° limits while 
you draw an obstruction zone, move the pointer outside the 
graph. This causes the horizontal scale to move 
accordingly so long as you keep the pointer outside the 
graph. 

- To complete the curtain definition, double-click on the last 
point. As a result, the curtain appears in blue as a close 
shape, even if the last point is not superimposed on the 
first one. On the Linear view, the curtain is always a 
polygon, on the Polar view it is a close shape composed of 
several arcs. 

- After completing the definition of the obstruction zone and 
if you want to restore a 0/360° normal non-shifted scale (if 
appropriate), choose the Select command from the pop-up 
menu and then simply double-click inside the graph area 
with the left-hand mouse button. 

 

 

Editing the curtain 
After accessing the Curtain Graph : 

- Position the mouse pointer anywhere on the graph and 
click with the right mouse button. 

- In the shortcut menu that pops up, select the Edit Curtain 
command. 
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- In the dialog box that appears, specify the points delimiting 
the obstruction zone(s). 

 

 
 

Curtain pane 

 List box : Shows the number of obstruction zones 
defined to form the curtain for the 
concerned site. Obstruction zones are 
numbered from 1 to n. The definition of the 
selected obstruction is shown in the right-
hand part of the box 

 Add button : Press this button to add a new obstruction 
zone in the above list box. 

 Delete button : Press this button to delete the obstruction 
zone selected in the above list box. 

 

{{{{ Point x/x}}}}  pane 

 Azimuth : Azimuth angle for the displayed point 

 Elevation : Elevation angle for the displayed point 
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 Right from previous point : Check this button if you want the 
position you are defining to be 
somewhere on the right of the 
previous point (this choice will force 
the extension of the obstruction zone 
to the right of the previous point even 
if the azimuth angle of the new point 
is less than that of the previous one; 
this allows you to go through the 
360/0° singular value). 

 Align with previous point : Check this button if you want the 
position you are defining to be aligned 
with the previous point (i.e. same 
azimuth). 

 Left from previous point : Check this button if you want the 
position you are defining to be 
somewhere on the left of the previous 
point (this choice will force the 
extension of the obstruction zone to 
the left of the previous point even if 
the azimuth angle of the new point is 
greater than that of the previous one; 
this allows you to go through the 
0/360° singular value). 

 Add button : Click this button to add a point to the 
definition of the obstruction zone. As a 
result, the total number of points (see 
top of dialog box) is incremented by 
one. 
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 Insert button : Click this button to add a point to the 
definition of the obstruction zone. The new 
point is inserted into the list of points just 
before the displayed point. As a result, the 
total number of points (see top of dialog 
box) is incremented by one. 

 Delete button : Click this button to delete the point 
displayed above. 

 

 OK button : Click this button to validate the entire box 
content 

 Cancel button : Click this button to cancel all the changes 
you have made to the box since you 
opened it. 

 

Moving, re-shaping or deleting the curtain 
- Position the mouse pointer anywhere on the graph and 

click with the right mouse button.  

- In the shortcut menu that pops up, choose the Select 
command. 

- Select the curtain by clicking the mouse pointer inside the 
drawing object (a selected curtain displays handles) then: 

. drag this object to move the curtain 

. or drag each of its handles successively to re-shape 
it 

. or press the Del key to delete it. 
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Enabling/Disabling the curtain in a process or 
prediction object 

- Open the project document containing the prediction or 
process object. 

- From the Project menu, select the Operations command. 
This causes the Operations tab to display. 

- Select the concerned prediction or process from the left-
hand list box 

- Click the Options button. 

- In the dialog box that appears, check the Use Site Curtain 
button to enable the curtain, or clear it to disable the 
curtain. 

- Click the OK button. 
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Using the event editor 
Observation records (resulting from an Import GPS Data operation) 
may include a number of events marked by the field operator during 
the survey. For example, he/she may have marked the moments 
when he/she started or stopped walking, or when the antenna offset 
was changed, etc. 

With the event editor you can review all the events present in an 
observation record. You can also enter these events manually if the 
field equipment could not let the operator do it (they should then 
have been logged through other means, or simply written down). 

From these indications, 3SPack will be capable of reporting these 
events on a trajectory plot for example. 

To use the event editor, proceed as follows: 

- Open the Database window. 

- Click the Observations database object in the left-hand 
pane of the window. In the list of observations now shown 
in the right-hand pane: 

- Double-click the Observation record you wish to view 

 or 

 Select this Observation record and, from the menu bar, 
select the Record command and then the Edit command. 

- In the 3-tab Observation dialog box which then appears, 
select the Events tab. 
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Marking events is achieved by positioning flags along a time chart 
shown in the upper pane of the Events tab, combining the use of the 
Events shortcut menu and of the different buttons available in this 
tab. A coloured letter is placed on top of the flag, according to the 
type of event you specify. 

The value of antenna offset is necessarily defined as the first event 
(1/1) occurring at the beginning of the observation record. 

 
Adding a new event 

- On the Events tab, click the Add button. 

- Check one of the buttons below, depending on the type of 
event you want to add. 

 Start Moving 
 Antenna : (G) marks a moment when the field 

operator started walking. If you check this 
button, specify the date & time of that 
event in the ON: field 



3SPack Supervisor 
Using the event editor 

DSNP 3-85 

 

 Stop Moving  
 Antenna : (S) marks a moment when the field 

operator stopped walking. If you check this 
button, specify the date & time of that 
event in the ON: field 

 Marker : (M) marks a moment when the field 
operator reached a particular site. If you 
check this button, specify the date & time 
in the ON: field and also the site name in 
the At Site: field 

 Antenna offset  
 changed : (A) marks a moment when the value of 

antenna offset was changed. The value of 
antenna offset is necessarily defined as 
the first event (1/1) occurring at the 
beginning of the observation record (enter 
the antenna height, expressed in meters, 
in the Delta H: field). 

 Epoch is significant : (E) marks a moment when a particular 
event occurred. If you check this button, 
specify the type of event in the Notes field. 

- Specify the required parameters, according to the type of 
event. Note the displacement of the corresponding graphic 
symbol as soon as you enter the date & time of event. 

- Click the Add button to define a new event and proceed as 
above. Note that the date & time of the preceding event is 
proposed as the default date & time for the new event. 

- Click the OK button after defining all the events. 
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Zooming in on a particular period in the 
observation record 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom In 
command. As a result the menu vanishes and the pointer 
looks like . 

- Position the pointer on the point around which you want to 
zoom in and click with the left mouse button. As a result 
the time chart is magnified around this point (and the 
clicked point stays immobile in reference to the pane). 

- You can zoom in repeatedly by clicking several times with 
the left mouse button (until a bleep can be heard). 

 

Zooming Out 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom Out 
command. As a result the menu vanishes and the pointer 
then looks like . 

- Position the pointer along the time axis on the point from 
which you want to zoom out and click with the left mouse 
button. As a result the window displays a larger-scale view 
centered around the clicked point 

- You can zoom out repeatedly by clicking several times with 
the left mouse button until you reach the view of the entire 
observation time span (denoted by a bleep). 
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Moving the view along the time axis 
This function is active only on a magnified chart. 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Panoramic 
command. The menu vanishes and the pointer then looks 
like  

- Depress the left mouse button and drag the pointer 
leftward or rightward, depending on where the particular 
period you want to view is. Note that the time scale will 
move as you drag the pointer. Release the mouse button 
once you have reached the desired time. 

 
Scrolling through the list of events 
There are two ways of doing this: 

- Use the up- and down-arrows of the vertical scroll bar on 
the right-hand part of the Events tab. After each click the 
definition of an event is displayed on the tab. On the time 
chart, the displayed event is denoted by a down- arrow 
pointing to the corresponding letter 

 or 
- Click the letter above the corresponding graphic symbol 

with the left mouse button. Proper selection of the event is 
denoted by the display of a down-arrow pointing to the 
letter. In this case the definition of the event is shown in the 
rest of the tab. 

 In both cases, the X/Y expression under the scroll bar 
should be interpreted as follows: 

X : position of displayed event in the list of events 
Y : total number of events 



3SPack Supervisor 
Using the Mask editor 

3-88 DSNP 

3 

Using the Mask editor 
For any reason you may want to discard the data from a satellite (i.e. 
"mask" a satellite) only for a particular moment (or particular 
moments) in an observation record. You can mask a satellite at two 
different levels of the process, depending on the reason why the 
data from this satellite must be rejected. 

 
• Masking attached to an observation record  

Masking applies to the observation record in whatever process this 
observation record is involved. In this case, use the following 
procedure to mask a satellite: 

- Open the Database window. 

- In the left-hand pane, click the Observations object. 

- In the right-hand pane, double-click the icon of the 
observation for which you want to mask a satellite 

- Unless already done, select the General tab and then click 
the Scan button. This provides access to the Mask tab 
showing a chart on which you can define your mask(s) 
(see Mask tab in page 3-90). 

 
• Masking attached to a process object  

Masking applies to the observation record mentioned in the process 
object definition only when this process object is run. In this case, 
use the following procedure to mask a satellite: 

- Open the project document containing the concerned 
process object. 

- From the Project menu, select the Operations command. 
This causes the Operations tab to display. 
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- Select the concerned process from the left-hand list box 

- Click the Options button. 

- In the dialog box that appears, click the Mask button. This 
provides access to the Mask tab showing a chart on which 
you can define your mask(s). (see Mask tab in page 3-90) 
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Mask tab 
This tab shows a chart on which you can define masks. The 
observation time is represented on the horizontal axis, the PRN 
number of each satellite received at that time on the vertical axis. In 
the example below, satellite No. 20 is masked from about 15:43 until 
the end of the observation. Satellite No. 14 is not masked but is 
invisible from about 15:38 until the end of the observation. 

 

 
• Masking a satellite 

Masking a satellite is achieved by drawing a rectangle over each 
period of time during which the satellite must be masked. 

- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Mask command from the menu. 

- Draw a rectangle over the concerned line section by 
dragging the mouse pointer along a virtual line 
representing a diagonal of that rectangle. 
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 You can define the two ends of the rectangle diagonal by 
referring to the information displayed at the foot of the 
dialog box (UTC time or point numbers; point numbers 
shown in blue). This information is continually updated as 
you move the cursor horizontally on the diagram. 

  
 Adjust the horizontal size of the rectangle so that it covers 

the period of time you want to mask and then release the 
mouse button. This causes the covered line section to 
appear in black, meaning that the satellite is now masked 
for that particular period of time. 

- Resume the above step as many times as necessary. 

 

• Unmasking a satellite 
- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Unmask command from the menu. 

- Draw a rectangle around the concerned line section 
(shown in black) and then release the mouse button. This 
causes the covered line section to re-appear in blue, 
meaning that the mask is now removed. 
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• Zooming in on a particular period in the observation record 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom In 
command. As a result the menu vanishes and the pointer 
looks like . 

- Position the pointer on the point around which you want to 
zoom in and click with the left mouse button. As a result 
the time chart is magnified around this point (and the 
clicked point stays immobile in reference to the pane). 

- You can zoom in repeatedly by clicking several times with 
the left mouse button (until a bleep can be heard). 

 

• Zooming Out 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom Out 
command. As a result the menu vanishes and the pointer 
then looks like . 

- Position the pointer along the time axis on the point from 
which you want to zoom out and click with the left mouse 
button. As a result the window displays a larger-scale view 
centered around the clicked point 

- You can zoom out repeatedly by clicking several times with 
the left mouse button until you reach the view of the entire 
observation time span (denoted by a bleep). 
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• Moving the view along the time axis 
This function is active only on a magnified chart. 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Panoramic 
command. The menu vanishes and the pointer then looks 
like  

- Depress the left mouse button and drag the pointer 
leftward or rightward, depending on where the particular 
period you want to view is. Note that the time scale will 
move as you drag the pointer. Release the mouse button 
once you have reached the desired time. 

 
• Masking/Unmasking all SVs  

From the Mask shortcut menu, simply select the Mask All or 
Unmask All command and then release the mouse button. As a 
result all the lines appear in the same color (black or blue 
respectively). 
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Importing Maps 
To import a map to the 3SPack database, you have first to digitize 
the map of your working region using a scanner. The map should be 
saved in the bitmap format (BMP). 

When digitizing a map, the orientation is assumed to be as follows: 

- North/South direction along the vertical axis (North to the 
top) 

- East/West direction along the horizontal axis (East to the 
left) 

 
 

Import Procedure 
- Open the database Manager window 

- Select the Maps object 

- In the menu bar, select Record and then Import. A dialog 
box opens showing the content of the \3SPack\Maps 
directory (the default directory for maps in bmp format). 

- Select the BMP file containing your map and then click the 
Open button. A new dialog box opens showing all or part 
of your map (depending on its size). Use this box to give 
geographical dimensions to the map. Refer to explanations 
below. 
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- Choose a projection from the Projection list box. You 

must choose a projection system otherwise 3SPack won't 
validate the map record. 

 
Defining the grid origin 
On a 3SPack Map record, the origin of the grid is represented by: 

 
Any point on the map whose coordinates are accurately known can 
be chosen to be the origin. Generally, the map from which the 
digitized Map record originates also provides reference points one of 
which can be used as the origin. 

The origin is defined in two steps: 

- Specify the location of the origin on the map. 

 

 
 

 
 

 
 Alternately, use the "tab" key to switch from a setting to the 

next. For each setting, use the "+" and "-" keys for a fine 
adjustment. 

On the Y button, drag the red dot as if you were "turning" the button 
until the horizontal red line (on the map) holding the grid origin 
coincides with the desired point (horizontal lines move in the vertical 
direction, space between lines is left unchanged). Turning the button 
clockwise causes the lines to move downward. 

On the X button, drag the red dot as if you were "turning" the button 
until the vertical red line (on the map) holding the grid origin coincides 
with the desired point (vertical lines move in the horizontal direction, 
space between lines is left unchanged). Turning the button clockwise 
causes the lines to move to the right. 
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- Enter its exact coordinates, expressed in the coordinate 
system used: 

- X coordinate in the text box below the X button 
- Y coordinate in the text box below the Y button 

 The graduations shown on the vertical and horizontal lines 
are then automatically refreshed. 

 
Defining the grid step 
The grid step represents the distance (d) between two adjacent lines 
both in the vertical and horizontal directions (the grid is then a 
network of squares on the map): 

Generally, the map from which the
digitized Map record originates
provides reference points allowing
you to define P1 and P2.P2

d

d

P1Grid Origin

 
- Indicate the locations of points P1 and P2 on the map: 

 
 

 

 
 

On the CX button, drag the red dot as if you were "turning" 
the button until the vertical red line adjacent to that holding 
the origin coincides with the desired point (vertical line 
holding the grid origin remains immobile). Turning the button 
clockwise increases space between adjacent vertical lines. 

On the CY button, drag the red dot as if you were "turning" 
the button until the horizontal red line adjacent to that holding 
the origin coincides with the desired point (horizontal line 
holding the grid origin remains immobile). Turning the button 
clockwise increases space between adjacent horizontal 
lines. 
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- Alternately, use the "tab" key to switch from a setting to the 
next. For each setting, use the "+" and "-" keys for a fine 
adjustment. 

- Enter the distance d in the two text boxes below the CX 
and CY buttons. The graduations shown on the vertical 
and horizontal lines are then automatically refreshed. 

 
 
 

Menus and commands 

File menu commands (in Database environment) 
 New Project : Creates a new project 
 Open Project : Opens an existing project 
 Print : Dimmed 
 Print Preview : Dimmed 
 Print Setup : Defines the Printing properties 
 Import GPS data : From GPS data files, creates observation 

records in the database 
 Exit Application : Exits 3SPack 
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File menu commands (in Project environment) 
 New Project : Creates a new project 
 Open Project:  Opens an existing project 
 Close Project : Closes the active project 
 Save Project : Saves the active project 
 Print : Prints the active project 
 Print Preview : Displays the active project as it would 

appear printed 
 Page Setup : Defines the orientation and size of the 

printed document 
 Import GPS data : From GPS data files, creates observation 

records in the database  
 Exit Application : Exits 3SPack 
 
 
 

Edit menu commands (in Project environment) 
 Undo:  Undoes the most recent action you have 

made in the project document 

 Cut : Moves the current selection (text and/or 
graphics) to the clipboard 

 Copy : Copies the current selection (text and/or 
graphics) to the clipboard 

 Paste : Pastes the clipboard contents into the 
active document, where the insertion point 
is positioned 
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 Paste Special : Pastes the clipboard contents into the 
active document, where the insertion point 
is positioned. Before using this command, 
a picture (Metafile), a word6 document, 
RTF formatted text or unformatted text 
was placed on the clipboard. You are 
requested to specify the format of the data 
stored in the clipboard before pasting. 

 Select All : Selects the entire project document 
(selects all the elements, text and 
graphics, present in the document) 

 Object Properties : Displays the properties of the selected 
object 

 {Type of} Object : Allows you to open or edit the selected 
object, if any 

 

Insert menu commands 
 Map : Inserts a map of the region as a graphic 

object into the active project 

 Prediction : Inserts a Prediction object into the project 

 Process : Inserts a Process object into the project 

 Abstract : Inserts the abstract as text into the project 
document 

 Object : Inserts an object into the active project 
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View menu commands (in Project environment) 
 Toolbar : Shows/hides the Toolbar 

 Format Bar : Shows/hides the Format Bar 

 Status Bar : Shows/hides the Status Bar 

 Ruler : Shows/hides the Ruler 

 Database Manager : Provides access to the database. The 
3SPack Supervisor window then enters the 
Database environment. 

 Options : From the Report tab, you can choose a 
document template for your project and 
specify the length unit used in the ruler 
(Measurement Units). 

    From this tab, you can also specify 
whether Map server objects and project 
abstracts must systematically be inserted 
into your project documents on creating 
them. To do so, check respectively the 
"Insert Map" button and the "Insert Project 
Abstract" button. 

    From the Operations tab, you can specify 
the default size of the objects inserted into 
the document (initial width and height). 

    If you clear the "Use operations default 
options" button, then 3SPack Supervisor 
will systematically open the Options 
dialog box of a prediction or the 
Options dialog box of a process 
whenever you create (add) either of these 
objects, thus prompting you to define these 
options  
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   From the GPS tab, you can tell 3SPack 
whether the receivers you use in your 
surveys are single-or dual-frequency. If 
they are dual-frequency, check the button 
on this tab. This will preset the Import 
GPS data dialog box in order to "keep 2nd 
frequency raw data" (see Importing GPS 
Data, page3-30). 

 

View menu commands (in Database environment) 
 List : Simply lists the names of the records in the 

selected database object 

 Details : Lists more complete information on the 
records in the selected database object 

 Toolbar : Shows/hides the Toolbar 

 Format Bar : Shows/hides the Format Bar 

 Status Bar : hows/hides the Status Bar 

 Options : From the Report tab, you can choose a 
document template for your project and 
specify the length unit used in the ruler 
(Measurement Units). 

    From this tab, you can also specify 
whether Map server objects and project 
abstracts must systematically be inserted 
into your project documents on creating 
them. To do so, check respectively the 
"Insert Map" button and the "Insert Project 
Abstract" button. 

    From the Operations tab, you can specify 
the default size of the objects inserted into 
the document (initial width and height). 
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    If you clear the "Use operations default 
options" button, then 3SPack Supervisor 
will systematically open the Options 
dialog box of a prediction or the 
Options dialog box of a process 
whenever you create (add) either of these 
objects, thus prompting you to define these 
options  

   From the GPS tab, you can tell 3SPack 
whether the receivers you use in your 
surveys are single-or dual-frequency. If 
they are dual-frequency, check the button 
on this tab. This will preset the Import 
GPS data dialog box in order to "keep 2nd 
frequency raw data" (see Importing GPS 
Data, page3-30). 

 

Record menu commands 
 Add : Creates a new record in the selected 

database object (other than project) 

 Edit : Edits the dialog box corresponding to the 
selected record 

 Delete : Deletes the selected record(s) from the 
database object 

 Import : Edits Import dialog box 

 Export : Edits Export dialog box 
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Project menu commands 
 Run : Runs an operation defined in the 

Operations tab of the Project dialog box 
(and creates or updates the corresponding 
object in the document) 

 Run All : Runs all the operations defined in the 
Operations tab of the Project dialog box 
(and creates or updates the corresponding 
objects in the document) 

 Description : Edits the General tab of the Project dialog 
box 

 Region : Edits the Region tab of the Project dialog 
box 

 Operations : Edits the Operations tab of the Project 
dialog box 
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Tool Menu commands (default) 
 Unprotect : Allows you to activate an application you 

buy later (password provided by DSNP) 

 Transfo : Starts the Transfo software module 

 Win Comm : Starts the Win Comm software module 

 Tracer : Starts the Tracer software module. This 
tool allows real-time monitoring of the 
position of a DSNP mobile receiver on a 
map of the working area 

 KISS : Starts the KISS module 

 SISS : Starts the SISS module 

 DSNP to RINEX : Opens a dialog box from which you can 
convert raw data from DSNP to RINEX 
format 

 Customize... : Allows you to customize this menu. Any 
application can be added to or removed 
from this menu  

 

Window menu commands (in Project environment) 
 Cascade : Arranges all the open windows in cascade 

configuration 

 Tile : Arranges all the open windows in tile 
configuration 

 Arrange icons : Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the 3SPack Supervisor window. 

{List of active windows} : Allows you to change the active window in 
3SPack Supervisor 
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Window menu commands (in Database 
environment) 

 New Window : Causes the Database window to become 
the active window in 3SPack Supervisor 

 Cascade : Arranges all the open windows in cascade 
configuration 

 Tile : Arranges all the open windows in tile 
configuration 

 Arrange icons : Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the 3SPack Supervisor window. 

{List of active windows} : Allows you to change the active window in 
3SPack Supervisor 

 

Help menu commands 
 Index : Displays the opening screen of Help 

 Using Help : Displays instructions for using Help 

 About 3SPack Supervisor : Displays the version number of this 
application. ♣  
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  4. Map Server 

Introduction 
- Using the Map server, you can get a graphic view of your 

region of survey before you start your own survey: 

- If a map of the region is available from the 3SPack 
Supervisor database, it may be shown in the 
background. The map may be added/removed at your 
convenience. 

 For a map to be effectively shown in the background, 
first it must coincide partially or entirely with the 
considered region. Second, it must be defined in the 
same coordinate system as the one specified for the 
project document. This second requirement will be 
met if The project system option is chosen in the 
View options dialog box (see Select pane in page 4-
8),. 

- The region view may be enriched with a grid. The 
horizontal and vertical lines of the grid may be 
represented by their coordinates expressed in the 
geodetic system used, or by visible lines, or by both. 

- Using the �grab� function, you can move the Map 
Server on the surface of the map so that other details 
of the map can be viewed. The map can be �grabbed� 
in all directions. 

- All sites and trajectories located within the region, 
resulting from previous operations and still present in 
the 3SPack Supervisor Database, are also shown on 
the map. 
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- Using the Map server, you can create a site or create a 
trajectory by a simple click on the mouse. 

- Using the Map server, you can prepare the scenario of 
your survey 

- For any site, you can easily associate a prediction 
that you will run later from the project document 

- For any site or trajectory, you can associate a 
process, provided field data are available for this site 
or trajectory. You will run the process later from the 
project document 

- The results of all the operations you perform during a 
survey are shown on the map right after they are made 
available to the Map server, which significantly enhances 
interaction with the software. 

- Using the Map server, you can directly export your 
trajectory or site solutions in the desired format. 

 

NOTES: 
- The Map Server is said to be "embedded" (or "in-place 

activated") if it is run in the main window of 3SPack 
Supervisor. This is the case when you double-click a map 
object in an open project, or if you select this object and 
choose successively Edit (in the menu bar of Supervisor) 
then MapSrv object then Edit. 

- The Map Server is said to be "separate" or "open" if it is 
run in a separate main window. This is the case if you 
select this object and you choose successively Edit (in the 
menu bar of Supervisor) then MapSrv object then Open. 
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How the Map Server shows your region of 
survey 

- The Map server shows the region of your survey inside a 
rectangular object. Since the region of survey graphically is 
a rectangular area of any proportion, the entire region 
cannot generally fit in the original rectangular object. 

 For this reason, the rectangular object is then defined so 
that its smaller side be equal to the smaller side of the 
region. 

 Consequently, a portion of the region may not appear 
when you insert the Map Server into the project document. 

 

 

Server Object

Section of Region
visible in the project
document

N/W coordinates

Region of Survey

N/W coordinates

S/E coordinates

S/E coordinates  
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- If a map record is available from the database which 
coincides completely or partially with the region of survey, it 
is then shown in the Map Server object. Its placement and 
size are deduced respectively from its grid origin and grid 
step: 

Grid Step

Grid Origin

Map

N/W coordinates

S/E coordinates  
 

 

 

Graphic conventions 
- When you use the grabber or the zoom, a limit of the 

validity area may be reached. This limit will then appear as 
a red continuous line on the Map. 
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- In the Separate Map environment, where the window can 
be of any size, a dotted area is represented on the map to 
remind you of the section of map that will be visible from 
the project document (as the Map Server object). 

 
 

 

 
- When observations are available for a site or a trajectory, a 

�diskette� icon is shown nearby. 

 

 
- When you define a process in which a reference site is 

involved, a line is represented on the map connecting that 
reference site to the surveyed site or trajectory. An arrow is 
placed on the line at mid-distance from the two places, 
pointing toward the surveyed site or trajectory. 
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About the region displayed by the Map 
Server 
Following the insertion of the Map Server into your project document, 
the region shown in the Map Server is necessarily the one you 
defined for your survey. 

Later, after performing a number of zoom and �grab� operations on 
the map, the displayed region will probably be different from the 
initial one. You may at any time read the coordinates (N/W & S/E) of 
the two points defining the currently viewed region. To do this: 

- In the tool bar, click  . 

 or 

 from the menu bar, select View and then Region. 

 The Viewed Region dialog box which then appears 
contains the coordinates of the two points defining the 
region. 
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Map Server options 
- From the menu bar, select View and then Customize. The 

dialog box which then appears looks like this: 
 

 
 

 The Map Server options are described in the next pages. 
After making all the necessary changes, do not forget to 
click the OK button to validate the new options. 

Default Viewing options (check pane) 
- The Map Server is configured according to the following 

settings when you run this server: 
 

 Display processing 
 scenario : Check this button to display the operations 

to be run, or already run, in the displayed 
region 
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 Display available maps : Check this button to display the map, if 
any, of the region of survey 

 Display ruler : Check this button to display the 
coordinates of the grid lines 

 Display grid : Check this button to display the map 
grid. 

- You may need to change these options while you use the 
Map Server. An easy way to do this is to use some of the 
buttons in the tool bar or some of the commands from the 
View menu. 

 

Other (Select pane) 
Display sites and trajectories: 

 

 Last solutions : Select this button if you want the Map 
Server to place each site or trajectory on 
the map according to the latest solution 
known for this site or trajectory 

 Default solutions : Select this button if you want the Map 
Server to place each site or trajectory on 
the map according to the default solution 
defined for this site or trajectory 
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Display maps projected in: 

 

 The project system : Only maps in the same coordinate system 
as the project document can be displayed 

 Any system : All maps can be displayed whatever the 
coordinate system used in the project 
document 

   Note that if you do not use a projection for 
the project document (all coordinates 
expressed in lat &long), then maps can 
only provide an erroneous view of the 
region with respect to the grid used. 

 

Zoom options (zoom pane) 
 Zoom factor : Defines the elementary skip of map scale 

when zooming in or out by one click of the 
mouse. 

   To decrease the zoom factor, drag the 
slide to the left (and vice versa) (default: 
slide in central position) 

 Map Zoom-In Limit : Defines a scale limit for the map for which 
you want the map to disappear from the 
window (because it's too magnified). 

   To reach this limit, zoom in repeatedly until 
the map disappears. To reduce the zoom-
in limit, drag the slide to the left (and vice 
versa) (default: slide in central position). 
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 Map Zoom-Out Limit : Defines a scale limit for the map for which 
you want the map to disappear from the 
window (because it's too small). 

   To reach this limit, zoom out repeatedly 
until the map disappears. To reduce the 
zoom-out limit, drag the slide to the left 
(and vice versa) (default: slide in central 
position). 

 
Color options 

- Click the Colors tab. 

  This tab shows the current colors of all the configurable 
items (icons, text, text background). Each of these items is 
shown in the deselected state (top diagram) and in the 
selected state (bottom diagram). 

- Select the item whose color has to be changed by clicking 
this item in the corresponding diagram or by choosing this 
item from the item list box. 

- In the lower part of the tab, set the following parameters: 
 

 Size : relevant to site and trajectory elements 
only. Choose between �thin� or �thick� 

 Color : choose a new color for the selected item 
from this pop-up menu 

 
- Make as many changes as necessary. Note that all the 

changes you make appear immediately on the items 
shown above. 
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Show/Hide Options 
- Click the Show/Hide tab. 

 This tab allows you to specify sites and trajectories that 
you do not want to view on the map. 

 You may need to use this option if for example the map 
shows too many of these objects �making the map 
uneasy to read� and you do not want to remove the 
corresponding records from the 3SPack Supervisor 
database. 

 Remember that the Hide options that you set in this dialog 
box only applies to the map object you are working on 
(another map object in the same project document can use 
different Hide options). 

 

Hidden Sites pane 
 

 {Sites list box} : Lists all the sites from the 3SPack 
Supervisor database whose solutions 
(default or last, depending on your choice) 
are within the limits of the map currently 
viewed. 

   Check the button(s) corresponding to the 
site(s) you want to hide 

 Hide All button : Click this button to hide all the sites listed 
in this pane 

 Show All button : Click this button to show all the sites listed 
in this pane 
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Hidden Trajectories pane 
 

 {Trajectories list box} : Lists all the trajectories from the 3SPack 
Supervisor database whose solutions 
(default or last, depending on your choice) 
are partially or entirely within the limits of 
the map currently viewed. 

   Check the button(s) corresponding to the 
trajectory(ies) you want to hide 

 Hide All button : Click this button to hide all the trajectories 
listed in this pane 

 Show All button : Click this button to show all the trajectories 
listed in this pane 

 

Placing a new site on the map 
 

- Click   in the toolbar 

 or 

 From the menu bar, select Draw and then Site 
- Move the mouse pointer onto the map. This causes the 

pointer to change to a  

- Click the mouse button on the map where you would like to 
create a new site. This causes the Site dialog box to open, 
as if you were creating a Site record from within the 
database 
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- Just type the Site name. The Site coordinates are 
automatically deduced from the point where you have 
clicked on the map. Since a single solution is known for 
this site (the one resulting from the mouse click), these 
coordinates are defined as both the default and last 
solutions. The current date & time also appear as the date 
& time of these solutions. 

- Click the OK button. As a result, an icon appears on the 
map representing the new site. The name of the site is 
shown beside the icon. 

- To create several sites in succession, hold down the Shift 
key while clicking on . 

 When you are finished, click on    for example to stop 
creating new sites. 

 

Placing a new trajectory on the map 
 

- Click    in the toolbar 

 or 

 From the menu bar, select Draw and then Trajectories 
- Move the mouse pointer onto the map. This causes the 

pointer to change to a  

- Click the mouse button on the map where you would like to 
create a new trajectory. This causes the Trajectory dialog 
box to open, as if you were creating a Trajectory record 
from within the database 
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- Just type the Trajectory name. The coordinates of the 
initial point are automatically deduced from the point where 
you have clicked on the map. 

- Click the OK button. As a result, an icon appears on the 
map representing the new trajectory (icon located on initial 
point). The name of the trajectory is shown beside the icon. 

- To create several trajectories in succession, hold down the 
Shift key while clicking on . 

 When you are finished, click on    for example to stop 
creating new trajectories. 

 

Placing a new prediction on the map 
- Select the sites on the map for which you would like 

predictions to be run. To make a multiple selection, hold 
down the Shift key while clicking the 2nd site, the 3rd site, 
etc. 

- From the menu bar, select Draw and then Prediction 

- In the Add Prediction dialog box which then appears, 
enter the definition of the first prediction, as you would from 
a project document or from within the database. 

 
 On Site : enter the label of the site of prediction 

 From : enter month, day and time of the beginning 
of prediction (default: current day at 
8hr00am) 
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 During : enter the duration of prediction (default: 12 
hr). 

 To : (dimmed) indicates the resulting end time 
of prediction (default: current day at 
8hr00pm) 

 

- When the definition is complete, click the OK button. As a 
result a text frame containing the term "prediction", 
preceded by an order number, appears on the map, beside 
the site for which the prediction must be performed. The 
order number indicates the position of the prediction in the 
list of operations to be performed in the project document 

 The reason why the text frame does not appear may be 
one of the following: 

- The   button is depressed 

- The displayed part of the map does not 
contain the site for which the prediction 
must be performed. 

- The map is too reduced or too magnified to 
show the site and the associated predictions 
and/or processes 

- If you made a multiple selection, the Add Prediction 
dialog box displays again from which you can define a 
prediction for the 2nd site. This dialog box will appear as 
many times as the number of selected sites. 
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Placing a new process on the map 
- Select the sites and trajectories on the map for which you 

would like processes to be run. To make a multiple 
selection, hold down the Shift key while clicking the 2nd 
element, the 3rd element, etc. 

- From the menu bar, select Draw and then Process 

- In the Add Gps Process dialog box which then appears, 
enter the definition of the first process, as you would from a 
project document or from within the database. 

 

 Compute : Define the process object by checking the 
Site or Trajectory button. 

     Specify the name of the site or trajectory in 
the text box just under the two check 
buttons. The list of records that appears 
when you click the down-arrow button are 
those for which observation records are 
available. 

     In the Using Observation: text box, select 
the name of the observation record from 
which the site or trajectory can be 
determined. Remember that you create 
links between Site/Trajectory records and 
Observation records when you use the 
Import GPS Data function. 
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 Reference : If the database contains a site and a static 
observation record for this site whose 
acquisition time coincides partially or 
completely with that of the observation 
record under process, then the application 
suggests that a differential process be run 
using this site as a reference. In that case, 
check the Site button in the Reference 
pane and choose a site name from the text 
box. In the Using Observation: text box, 
select the name of the observation record 
you want to use. 

     If several position solutions exist for the 
selected site, specify the solution you want 
to use by checking either the Last solution 
button or the Default solution button. 

     If no sites are available, all check buttons 
in this pane are dimmed. 

 With module : The application indicates the processing 
modules that can be used to process the 
observation record. Choose one if two or 
more modules are prompted. 

 
- When the definition is complete, click the OK button 

 If the "Use Operations default options" check button was 
cleared in the options dialog box, a dialog box then 
appears in which you have to define the processing options 
for that particular process (otherwise, this dialog box is 
bypassed). 
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 Then a text frame containing the term "process", preceded 
by an order number, appears on the map, beside the icon 
for which the process must be performed. The order 
number indicates the position of the process in the list of 
predictions and processes to be performed in the project 
document 

 

 The reason why the text frame does not appear may be 
one of the following: 

- The    button is depressed 

- The displayed part of the map does not 
contain the site or trajectory for which the 
process must be performed. 

- The map is too reduced or too magnified to 
show the site or trajectory and the 
associated predictions and/or processes 

- If you made a multiple selection, the Add Gps Process 
dialog box displays again from which you can define a 
process for the 2nd element. This dialog box will appear as 
many times as the number of selected elements. 
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Using the zoom 

Zooming in 
- Click   in the toolbar or from the menu bar, select View 

and then Zoom in 

- Move the pointer to the point around which you would like 
to zoom in (the pointer then changes to a  ) and then 
click with the left mouse button. As a result the window 
displays a view of the region centered around the clicked 
point, and magnified according to the value of zoom factor. 

 

Zooming out 
- Click    in the toolbar or from the menu bar, select View 

and then Zoom out 
- Move the pointer to the point from which you would like to 

zoom out (the pointer then changes to a   ) and then 
click with the left mouse button. As a result the window 
displays a view of the region centered around the clicked 
point, and reduced according to the zoom factor. 

 

 

Measuring a segment on the map 

- Move the pointer to the toolbar and click . This causes 
the pointer to change to  

 Move the pointer to an end of the segment and start 
dragging the pointer toward the other end. 
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 From that moment, the Map Server will provide the value 
of distance (with red background) between the initial point 
and the one currently pointed by the mouse until you 
release the mouse button: 

 
- Once the pointer accurately coincides with the second 

point, read the distance measured and then release the 
mouse. 

 After releasing the mouse button, the pointer shape is still 
 meaning that the Map Server is ready to measure a 

new segment. 
 

Displaying the properties (& options) of 
objects or operations 

- Click  

- Double-click the desired object or operation or, select this 
object or operation and, from the menu bar, select Edit 
and then Properties. A dialog box appears whose content 
is dependent on the selected element: 

- For a site or trajectory, this action is equivalent to 
editing the corresponding record from the database. 

- For a prediction or process, this action is equivalent to 
clicking the Edit button from the Operations tab of your 
project document after selecting the corresponding 
prediction or process from that tab. 
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- To display the options of a prediction or of a process, 
double-click the icon while holding down the Shift key or 
select the icon and, from the menu bar, select Edit and 
then Options. 

 This action is equivalent to clicking the Options button 
from the Operations tab of your project document after 
selecting the corresponding prediction or process from that 
tab. 

 

 

Deleting objects or operations 

- In the toolbar, click   

- Move the mouse pointer onto the map and click the 
element you would like to delete (a site, a trajectory, a 
prediction or a process) 

- For a multiple selection, hold down the shift key while 
clicking other elements. All kinds of elements may be part 
of a multiple selection 

- From the menu bar select Edit and then Delete 
 or 

 press the Del key. 

- You then have to confirm your choice before the 
application really deletes the object(s) and operation(s). If 
an object is involved in a process or a prediction, a 
message will appear 
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Exporting sites and trajectories 

 Procedure 

- Click   

- Click the corresponding element(s) on the map. To make a 
multiple selection, hold down the Shift key while clicking 
the 2nd element, the 3rd element, etc. 

- Click    in the tool bar or, from the menu bar select Edit 
and then Export. 

 A dialog box appears, whose content depends on the 
selection you have just made on the map. Set the dialog 
box as you would from 3SPack Supervisor: 

 

 Export list box : Contains the element(s) you have selected 
before invoking the Export function. The 
content of this box is then controlled by the 
following three buttons. 

 Add button : Click this button to add a site or trajectory 
to the Export list box 

 Edit button : Click this button to edit the selected 
element 

 Remove button : Click this button to remove the selected 
element(s) from the Export list box 

 Select : Check the Default Solution or Last Solution 
button, depending on the solution(s) you 
want to export for the selected element 
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     If a Trajectory is selected, check also the 
All points or Marked Points button, 
depending on the point(s) you want to 
export. 

 In File : Specify the path and name of the export 
file 

     Click    to scroll through your disk 

 Format : Choose the format in which to export the 
selected elements. Two basic formats are 
available plus those created by the user 

 User Formats 
 button : Click this button to create/edit/delete a 

user format. First a dialog box appears 
showing the names of the existing user 
formats. Make the appropriate selection. 
Then the User Format dialog box appears 
(see below). 

 Projection : Choose the name of the projection (from 
the pop-up list) in which to express the 
projected coordinates of the exported 
points 

 Go button : Click this button to export the selected 
elements (as shown in the Export list box) 

 Cancel button : Click this button to cancel the Export 
function. 
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 Defining a user format 
In the User Format Dialog box: 

 Format : Enter a name for your format 

 Export : Choose the first parameter you want to 
insert into your format from this list box. 
Then specify the following for this 
parameter: 

 Field Type : Check either Fixed or Variable to 
define the character size of the 
parameter. 

     If you choose Fixed, then specify the 
number of characters (length) and the 
position (left or right) of the parameter 
in the field. 

     If you choose Variable, then just 
specify the character used as the 
separator ("," by default) 

 Field Format : Depending on the chosen parameter, 
specify additional formatting 
instructions (such as number of 
decimal places, units used, time 
format, etc.). 

     Note the simulation of your formatting 
instructions for this parameter in the 
lower part of the dialog box 
(simulation box) 

 Add  : Click this button to add a new 
parameter to the current user format 
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 Insert  : Click this button to insert a new 
parameter into the current user 
format, before the parameter shown 
in the Export text box. 

 Remove  : Click this button to remove the 
parameter shown in the Export text 
box from the current user format. 

 Vertical 
 bar : Use this bar to scroll through the list 

of fields defined in the current user 
format. 

 Simulation 
 box : This box shows a simulation of your 

message, as it would be obtained 
from your formatting instructions. 
Alternately, this box can be used as 
the Vertical Scroll bar to display the 
definition of each parameter in the 
user format. You can scroll up or 
down the entire list of parameters by 
clicking repeatedly and respectively in 
the left-hand part or right-hand part of 
the box. 
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Changing the Viewing options 
 

- To show/hide the horizontal and vertical lines of the map 
grid, from the menu bar select View and then Grid  

 or click   

 

- To show/hide the map, from the menu bar select View and 
then Map 

 or click   

 
- To show/hide the operations to be run or already run in the 

displayed region, from the menu bar select View and then 
Scenario 

 or click   

 
- To show/hide the coordinates of the map grid, from the 

menu bar select View and then Ruler 

 or click   

 
- To hide a site or trajectory, select the corresponding icon 

on the map (for a multiple selection, use the Shift key) and, 
from the menu bar, select Edit and then Hide. 

 To show it back on the map, from the menu bar, select 
View and then Options. In the Show/Hide tab, make the 
appropriate settings. 
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Using the Grab tool 

- Click    in the toolbar 

 or 

 From the menu bar, select View and then Grabber 
- Move the mouse pointer onto the map. This causes the 

pointer to change to a  

- Depress the left mouse button and drag the pointer in the 
desired direction. Note that the map will move only when 
you release the mouse button. Note also that the 
displacement is defined by the distance covered by the 
pointer when you drag it. 

 

Menus and commands 

File menu (embedded) 
 New Project : Creates a new project 
 Open Project : Opens an existing project 
 Close Project : Closes the active project 
 Save Project : Saves the active project 
 Print : Prints the active project 
 Print Preview : Displays the active project as it would 

appear printed 
 Page Setup : Defines the orientation and size of the 

printed document 
 Import GPS data : From GPS data files, creates observation 

records in the database  
 Exit : Exits 3SPack 
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 File menu (separate) 
 
 Update : Updates the Map server in the open 

project 

 Print : Prints the active project 

 Print Preview : Displays the active project as it would 
appear printed 

 Print Setup : Defines the orientation and size of the 
printed document 

 Exit & Return to : Exits MapSrv and returns to the open 
project 

 

 Edit menu 
 Copy : Copies the current view to the clipboard 

 Delete : Deletes the current view 

 Select All : Selects all records shown on the map 

 Hide : Hides the selected sites and trajectories 
(and associated icons) 

 Import : Dimmed 

 Export : Exports the selected site or trajectory in a 
user-chosen format 

 Properties : Edits the properties of the selected 
element 

 Options : Displays the Options dialog box of the 
prediction selected on the map 
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 View menu (separate) 
 Zoom In : Selects the zoom-in function 

 Zoom Out : Selects the zoom-out function 

 Grabber : Selects the Grabber function 

 Refresh : Updates the content of the Map Server 
Window 

 Region : Provides access to the Region dialog box 

 Scenario : Shows/hides the scenario 

 Map : Shows/hides the map 

 Ruler : Shows/hides the ruler 

 Grid : Shows/hides the grid 

 Names : Shows/hides the names of the objects 
visible on the map 

 Observations : Shows/hides the diskette icons by those 
objects for which data records are 
available 

 Toolbar : Shows/hides the Tool Bar 

 Status Bar : Shows/hides the Status Bar 

 Customize : Provides access to the Map Server 
Options dialog box 
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View menu (embedded) 
 Zoom in : Selects the zoom-in function 
 Zoom out : Selects the zoom-out function 
 Grabber : Selects the Grabber function 
 Region : Provides access to Region dialog box 
 Scenario : Shows/hides the scenario 
 Map : Shows/hides the map 
 Ruler : Shows/hides the ruler 
 Grid : Shows/hides the grid 
 Names : Shows/hides the names of the objects 

visible on the map 
 Observations : Shows/hides the diskette icons by those 

objects for which data records are 
available 

 Toolbar : Shows/hides the Status Bar 
 Customize : Provides access to the Map Server 

Options dialog box 
 

 Draw menu 
 Prediction : Allows you to associate a prediction with 

the selected site or trajectory 
 Process : Allows you to associate a process to the 

selected site or trajectory (only if field data 
available for this site or trajectory) 

 Select : Allows you to select an object on the map 
 Sites : Allows you to place a new site on the map 
 Trajectories : Allows you to place a new trajectory on the 

map 
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 Tool menu 
(Exists in Embedded Map Server only) 
Same as 3SPack Supervisor'sTools menu, which can be 
customized. 

 
Window menu 

 New Window : Causes a new window showing the open 
project document to appear 

 Cascade : Arranges all the open windows in cascade 
configuration 

 Tile : ranges all the open windows in tile 
configuration 

 Arrange icons : Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the 3SPack Supervisor window. 

{List of active windows} : Allows you to change the active window in 
3SPack Supervisor 

 
 Help menu 

 Index : Displays the opening screen of Help 

 Using Help : Displays instructions for using Help 

 About MapSrv : Displays the version number of this 
application. ♣  
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  5. Prediction processor 

Introduction 
- The Prediction Processor (PRED) allows you to work on a 

prediction you've inserted into your project document. A 
prediction is a set of information in the form of text and/or 
graphics depicting the GPS constellation visible from a 
specified site for a specified period of time (prediction time 
span). 

- PRED allows you to change the view of your prediction. 
Five different views are possible: Schedule, Elevation, 
Azimuth, Polar and GDOP. 

- PRED also allows you to change the input parameters 
and options of the prediction to customize your project. 

- Once you get the right information for your prediction, you 
can update your project with the corresponding view. This 
view then becomes the new prediction object in your 
project document. 

 

NOTES: 
PRED is said to be "embedded" (or "in-place activated") if 
it is run in the main window of 3SPack Supervisor. This is 
the case when you double-click a prediction object in an 
open project, or if you select this object and choose 
successively Edit (in the menu bar of 3SPack Supervisor) 
then Pred Object then Edit. 
PRED is said to be "separate" or "open" if it is run in a 
separate main window. This is the case when you select a 
prediction object and you choose successively Edit (in the 
menu bar of 3SPack Supervisor) then Pred Object then 
Open. 
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How to choose a view for your prediction 
- In the menu bar, select View and then the desired view 
 or 
 Position the mouse pointer anywhere on the active view 

and click the right mouse button. In the shortcut menu that 
appears, choose the desired view. 

 Five different views are possible: 
Schedule 
Elevation 
Azimuth 
Polar 
GDOP 
 

How to change the input parameters of a 
prediction 

- In the menu bar, select Edit and then Operations. A 
dialog box appears allowing you to change the input 
parameters of the open prediction. The input parameters of 
a prediction are: 

 On Site : enter label of prediction site 
 From : enter month, day and time of the beginning of 

prediction (default: current day at 8hr00am) 
 During : enter duration of prediction (default: 12 hr). 
 To : (dimmed) resulting end time of prediction 

(default: current day at 8hr00pm) 
 OK button : Click this button if you agree with the definition of 

the prediction 
 Cancel button : Click this button if you want to cancel the 

changes you've just made in the dialog box. 
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The options of a prediction 
The options of a prediction may be modified in two different ways: 

- Globally from the Options dialog box. There are three 
ways of accessing this dialog box: 

- In the menu bar, select Process and then 
Options 

 or 

- In the toolbar, click  

 or 

- Move the pointer over the displayed view 
(any type), click with the right mouse button. 
In the shortcut menu that appears, select 
Options 

- Separately for three of them. From the toolbar: 

- Click  to access the Svs dialog box (see 
description in the next pages) 

- Click  to access the Elev Min dialog box 

- Click  to superimpose or remove the Use 
Curtain option. 
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The following six parameters can be defined in the Options dialog 
box: 

 View : Choose a view for your prediction among 
the five possible: Schedule , Elevation , 
Azimuth , Polar , GDOP  

 Elev Min : Enter the value of minimum elevation  

 Use Site Curtain : Check this button if you want to enable the 
curtain  

 GDOP Type : Enter the DOP type : GDOP , PDOP , 
HDOP or TDOP  

 GDOP Mode : Enter the DOP Processing mode (3D+T or 
2D+T) 

 Selected Svs : Define the list of Svs actually used from 
the available constellation (see description 
of the SVs dialog box in the next pages) 

 
These options are detailed below. 

 

Elev Min 
This option allows you to change the minimum elevation 
angle required of any satellite seen from the prediction site 
to be declared as usable at this site. 
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Use Site Curtain 
This option lets you superimpose/remove the curtain at 
your convenience. The curtain, which is part of the 
definition of the prediction site, depicts an angular zone 
(seen from the prediction site) in which GPS signals are 
known to be bad. 
Due to the superimposition of the curtain, whose shape 
and size can be seen in the Polar view, some of the plots 
in the Azimuth and Elevation views may be disrupted and 
the Schedule and GDOP views may also be affected. 

 
GDOP Type 

GDOP is a measure of the Dilution of Precision in all three 
dimensions plus the time precision 
PDOP is a measure of the Dilution of both Horizontal and 
Vertical Precisions 
HDOP is a measure of the Dilution of Horizontal Precision 
only 
TDOP is a measure of the Dilution of Time Precision only 

 
GDOP Mode 

This option is used to change the DOP processing mode. 
2D+T should be chosen if the altitude is known, otherwise 
3D+T. In 2D+T the GDOP computation is only concerned 
with two position unknowns instead of three. This leads to 
better (lower) figures of GDOP. 



Prediction processor 
The options of a prediction 

5-6 DSNP 

5 

Svs dialog box 
This dialog box allows you to modify the set of SVs used effectively 
in the prediction. 

The first time you display this box for a prediction, it is preset so that 
the whole set of satellites can be involved in the prediction 
processing. Black PRN numbers denote visible satellites, white PRN 
numbers denote invisible satellites. All buttons are OFF (released). 

- To deselect a satellite, depress the corresponding button 

- To deselect the whole set of satellites, click the All button 

- To re-select a satellite (if previously deselected), release 
the corresponding button 

- To re-select the whole set of satellites, click the None 
button 

 
In this example: 

- Satellites Nos 8, 11, 12, 13 and 32 not visible 

- Satellite No. 26 visible but deselected 

- Satellite No. 12 not visible and deselected 

- All other satellites visible and used 
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Schedule View 
This view shows the visible satellites for the considered prediction, 
taking into account the minimum elevation angle, the presence or 
absence of the curtain and the fact that you may have intentionally 
rejected some of the visible satellites. 

- Y axis (linear scale): SV PRN No. (1 to 32) and count of 
visible SVs (in red) 

- X axis (linear scale): time (unit:1/12th of the whole 
prediction). 

  
The period of time for which a satellite is visible is represented by a 
thick horizontal line. The red curve indicates the count of visible 
satellites at any moment in the prediction. Gray lines, if any, identify 
unhealthy satellites. 
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The View sub-title includes: 

- the label and XYZ coordinates of the prediction site (1st 
line)  

- the beginning and end times of the prediction (2nd line)  

- the validity date of the almanac data used in the prediction, 
the minimum elevation angle and the presence or absence 
of curtain (3rd line)  
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Elevation View 
This view shows the elevation plot of each visible satellite for the 
considered prediction, taking into account the minimum elevation 
angle, the presence or absence of the curtain and the fact that you 
may have intentionally rejected some of the visible satellites. 

- Y axis (linear scale): Elevation angle (0 to 90°) 

- X axis (linear scale): time (unit:1/12th of the whole 
prediction). 

  
The View sub-title includes: 

- the label and XYZ coordinates of the prediction site (1st 
line)  

- the beginning and end times of the prediction (2nd line)  

- the validity date of the almanac data used in the prediction, 
the minimum elevation angle and the presence or absence 
of curtain (3rd line)  



Prediction processor 
Azimuth View 

5-10 DSNP 

5 

Azimuth View 
This view shows the azimuth plot of each visible satellite for the 
considered prediction, taking into account the minimum elevation 
angle, the presence or absence of the curtain and the fact that you 
may have intentionally rejected some of the visible satellites. 

- Y axis (linear scale): Azimuth angle (0 to 360°) 

- X axis (linear scale): time (unit:1/12th of the whole 
prediction). 

  
The View sub-title includes: 

- the label and XYZ coordinates of the prediction site (1st 
line)  

- the beginning and end times of the prediction (2nd line)  

- the validity date of the almanac data used in the prediction, 
the minimum elevation angle and the presence or absence 
of curtain (3rd line). 
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Polar View 
This view shows the orbit of each visible satellite for the considered 
prediction, taking into account the minimum elevation angle, the 
presence or absence of the curtain and the fact that you may have 
intentionally rejected some of the visible satellites. The view uses 
polar coordinates: 

- Center of concentric circles: location of prediction site 
- From center to larger circle: elevation angle, from 90° to 0° 

respectively (each new circle represents 10° in elevation) 
- The angular space between any two adjacent lines 

represents 30° in azimuth; graduated clockwise from 0 to 
360°. 
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The View sub-title includes: 

- the label and XYZ coordinates of the prediction site (1st 
line)  

- the beginning and end times of the prediction (2nd line)  

- the validity date of the almanac data used in the prediction, 
the minimum elevation angle and the presence or absence 
of curtain (3rd line). 
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GDOP View 
The GDOP view can take different forms depending on the type of 
DOP you wish to plot (GDOP , PDOP , HDOP or TDOP ). You can 
choose the DOP type directly from the Process menu or via the 
Options dialog box. 

- Y axis (logarithmic scale): DOP (0.1 to 100) 

- X axis (linear scale): time (unit:1/12th of the whole 
prediction). 

  
The View sub-title includes: 

- the label and XYZ coordinates of the prediction site (1st 
line)  

- the beginning and end times of the prediction (2nd line)  

- the validity date of the almanac data used in the prediction, 
the minimum elevation angle and the presence or absence 
of curtain (3rd line). 
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Using the movable time tag on the Polar 
view 
The time tag is defined as a particular time in the observation period. 
It is used to focus the Polar view on that particular time, for example 
to know the exact number and positions of the visible satellites at 
that time. The time tag is invisible on the graph but its position is 
indicated in the sub-title of the Polar view. 

You can move the time tag forward or backward within the limits of 
the prediction, by a time step depending on the value of the 
prediction time span. For example, the time step is 6 minutes if you 
define a 24-hour prediction. The default position of the time tag is the 
start time of the prediction. 

The time tag may be moved in two different ways: 
 

1. Using the toolbar 
 

- Click  to take the time tag one step forward. 

 or 

- Click  to take the time tag one step backward.  
 

2. Using the keyboard 
 

- Depressing the "+" key (numeric keypad) causes the time 
tag to move one step forward. 

- Depressing the "-" key (numeric keypad) causes the time 
tag to move one step backward. 

- Holding down the "+" key (numeric keypad) causes the 
time tag to move one step forward repeatedly, at a fast 
rate, until you release the key. 

- Holding down the "-" key (numeric keypad) causes the time 
tag to move one step backward repeatedly, at a fast rate, 
until you release the key. 
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Copying a plot to the clipboard  
The clipboard is a temporary storage area for text and graphics that 
you are copying or moving from one location to another. The 
Clipboard is a common holding area among Windows applications. 

 

After choosing the desired view in the active window: 

- Click  

 or 

- From the menu bar, select Edit and then Copy 

 or 

- Position the mouse pointer anywhere on the plot, click the 
right mouse button. In the shortcut menu that appears, 
select Copy. 

 

 

How to update your project document with 
the displayed view of your prediction 

 
If you are in Separate PRED environment 

- In the menu bar, select File and then the Update 
command. 

 
If you are in Embedded PRED environment 

- Updating is inherent since in this case you work directly on 
the prediction object of the project document. 
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How to quit PRED 
If you are in Embedded PRED environment 

- Simply click in the active window, outside the prediction 
object or press the Esc key. The project document is 
systematically updated with the last displayed view of the 
prediction. 

 
If you are in Separate PRED environment 

- In the menu bar, select File and then the Exit & Return to 
command. The project document is systematically updated 
with the last displayed view of the prediction. 

 

Menus and commands 

File menu (embedded) 
 New Project  Creates a new project 

 Open Project  Opens an existing project 

 Close Project  Closes the open project 

 Save Project  Saves the open project 

 Print  Prints the open project 

 Print Preview  Displays the project as it would appear 
printed 

 Page Setup  Defines the orientation and size of the 
printed document 

 Import GPS data  From GPS data stored in the Raw 
directory, creates observation records in 
the database 

 Exit  Exits 3SPack 
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File menu (separate) 
 Update  Updates the prediction object in the open 

project 

 Print  Prints the active prediction 

 Print Preview  Displays the prediction as it would appear 
printed 

 Print Setup  Selects a printer and printer connection 

 Exit & Return to  Exits PRED and returns to the open 
project 

 

 

Edit menu 
 Copy  Copies the prediction object to the 

clipboard  

 Dec time  Moves the time tag one step backward 
(active on Polar view only) 

 Inc time  Moves the time tag one step forward 
(active on Polar view only) 

 Operations  Edits the input parameters of the 
prediction 
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View menu (separate) 
 Schedule   Displays the "Schedule" view of the 

prediction 

 Elevation   Displays the "Elevation" view of the 
prediction 

 Azimuth   Displays the "Azimuth" view of the 
prediction 

 Polar   Displays the "Polar" view of the prediction 

 GDOP   Displays the "GDOP" view of the prediction 

 Toolbar  Shows or hides the toolbar 

 

 

View menu (embedded) 
 Schedule   Displays the "Schedule" view of the 

prediction 

 Elevation   Displays the "Elevation" view of the 
prediction 

 Azimuth   Displays the "Azimuth" view of the 
prediction 

 Polar   Displays the "Polar" view of the prediction 

 GDOP   Displays the "GDOP" view of the prediction 

 Toolbar  Shows or hides the toolbar 

 Status Bar  Shows or hides the status bar  

 Split  Dimmed 
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Process menu 
 Svs  Shows the set of visible satellites in the 

Svs dialog box  

 Elev Min   Displays the Elev Min dialog box 

 Use Curtain   Superimposes/removes the curtain, if any, 
on the Polar view  

 GDOP  Plots the GDOP on the GDOP view  

 PDOP  Plots the PDOP on the GDOP view  

 HDOP  Plots the HDOP on the GDOP view  

 VDOP  (not operational) 

 TDOP  Plots the TDOP on the GDOP view  

 3D+T  Selects the 3D+T mode (affects the GDOP 
view only) 

 2D+T  Selects the 2D+T mode (affects the GDOP 
view only) 

 Options   Displays the Prediction Options dialog box 

 

 

Tools menu 
 

(Exists in Embedded Pred only) 
Same as 3SPack Supervisor'sTools menu, which can be 
customized. 
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Window menu 
 New Window  Creates a new window 

 Cascade  Arranges all the open windows in cascade 
configuration 

 Tile  Arranges all the open windows in tile 
configuration 

 Arrange Icons  Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the PRED window. 

 {Project name}  Causes this project's window to become 
active 

 

 

Help menu 
 Index  Displays the opening screen of Help 

 Using Help  Displays instructions for using Help 

 About Pred  Displays the version number of this 
application. ♣  
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  6. Natural processor 

Introduction 
- The Natural Processor allows you to determine a 

Trajectory or a Site solution. 

- Since Natural does not involve the use of observations 
made by a stationary receiver on a reference site, it is not 
so accurate as Rapid Static or Kinematic. For example, the 
effect of the SA is noticeable on the Target view of a site 
determined with Natural. 

- At the end of a Natural processing, the site or trajectory 
solution is routed to the database to be stored into the 
corresponding record, thus enriching this record with a new 
solution. 

- Natural can produce two different views for a process: 

- The Gps view, which shows the GPS 
constellation for a particular moment during 
the observation which the user specifies 
using the time tag. The view takes into 
account the intentionally deselected 
satellites, if any, and/or the user-set 
maskings, if any. 

- The Target view, which shows a map of the 
site or trajectory solution. 

 The chosen view will then be visible from the project 
document when you go back to this environment. 



Natural processor 
How to choose a view for your natural object 

6-2 DSNP 

6 

NOTE: 
- Natural is said to be "embedded" (or "in-place activated") if 

it is run in the main window of 3SPack Supervisor. This is 
the case when you double-click a process object in an 
open project, or if you select this object and choose 
successively Edit (in the menu bar of Supervisor) then 
Natural Object then Edit. 

- Natural is said to be "separate" or "open" if it is run in a 
separate main window. This is the case when you select a 
natural object and you choose successively Edit then 
Natural Object and Open. 

 

How to choose a view for your natural 
object 

- In the menu bar, select View and then the desired view: 

Target 
Gps 

 or 

 Position the mouse pointer anywhere on the active view 
and click with the right mouse button. In the shortcut menu 
that appears, choose the desired view: 

Target 
Gps 
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Changing the options of a Natural process 
 

WARNING! 
Changing any of these options requires 
that you re-run the process to get the 
updated view of the natural object. 

 

- From the menu bar, select Process and then Options 

 or 

 In the toolbar, click   

 or 

 Move the mouse pointer anywhere on the Natural view, 
click with the right mouse button and, in the shortcut menu 
which then appears, select Options. 

 A dialog box appears in which you can set the options of 
the process: 

 View : Choose a view for your Natural process 
(Target or Gps) 

 Elev. min. : Choose the minimum elevation angle 
required of any satellite present in the 
observation record to be involved in the 
process 

 Use Site curtain : Check this button if the curtain defined for 
the site must be involved in the processing 
(option not displayed if a trajectory is being 
processed)  
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 Mask button : Provides access to the Mask editor 
through which you can add masking 
moments on the set of usable satellites 
(prior masking can have been made on the 
observation record from the 3SPack 
Supervisor environment). 

 
 Filter Code With Phase : Check this button to enable code/phase 

filtering (otherwise clear it). 

 
Deselected Svs pane     If required, depress the button(s) 

corresponding to the satellite(s) present in 
the observation record that you want to 
deselect 

 
 All button : Click this button to deselect all the 

satellites present in the observation record 

 None button : Click this button to re-select all the 
deselected satellites 

 
 Save As Defaults button : Click this button to save the current 

settings as the default options for the 
process 

 Restore Defaults button : Click this button to restore the default 
options previously defined for the process 

 OK button : Click this button if you agree with all the 
options shown in the dialog box 

 Cancel button : Click this button if you want to cancel the 
changes you have made in this dialog box 
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Target view 
This view shows the result of your process. The solution is shown on 
two distinct plots for a trajectory, on a single plot for a site: 

- The top diagram shows a map of the site or trajectory (the 
axis system is graduated North vs. East). 

 For a site, the axis system is centered at the averaged 
solution (coordinates displayed with yellow background, 
site location indicated by a flag) and the 95% probability 
ellipse is shown in green. The SdE, SdN and SdH standard 
deviations are also displayed with yellow background. 

 For a trajectory, the axis system is graduated so as to 
show all the points issued from the process. The bottom 
diagram shows an �altitude vs. time� view of the trajectory 
solution. 

-  The horizontal axis shows the entire non-masked 
observation time (From... : start date & time; To... : end 
date & time) 

Note the presence of a green spot (time tag) on each of the two 
diagrams allowing you to establish a time relationship between the 
two diagrams. 

When a trajectory is processed with Natural, flags may appear 
resulting from "markers" placed by the operator during the survey. 
When the Natural processor detects a marker in an observation 
record, an accurate determination of the position is performed for 
that particular time when the marker was inserted. 
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Depending on whether the operator was walking (dynamic) or 
immobile (static) at that time, the position solution will result from 
one of the following two processings: 

- position interpolation (dynamic) 

- position averaging (static) 

The position solution is then saved as the solution of the site 
associated with the marker. 

 

• Note: 
 A marker is assumed to be static if it is placed between a 

"Stop Moving Antenna" event and a "Start Moving 
Antenna" event (see 3SPack Supervisor section, using 
the event editor). 

 The plot below is an example of a site processed with 
Natural: 
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3SPack automatically chooses the appropriate scale for the map, 
depending on the size of the dispersion ellipse. When the 1:1000 
scale is used, it is indicated in the right-lower part of the map, with 
green background. 

The 1:1000 scale is the largest scale possible for a Natural 
processing. 

The Target view subtitle provides the following information: 

 1st line : Name of the site under process, 
observation record involved in the natural 
process, antenna height offset. 

 2nd line : Non-masked observation time (From... : 
start date & time; To... : end date & time). 

 3rd line : Process Options, i.e. minimum elevation 
angle requested, curtain involved/not 
involved in the process. 
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Gps view 
This view shows the orbit of each visible satellite for the considered 
observation, taking into account the minimum elevation angle, the 
presence or absence of the curtain and the fact that you may have 
intentionally rejected some of the visible satellites. The view uses 
polar coordinates: 

- Center of concentric circles: site location 

- From center to larger circle: elevation angle, from 90° to 0° 
respectively (each new circle represents 10° in elevation) 

- The angular space between any two adjacent lines 
represents 30° in azimuth; graduated clockwise from 0 to 
360° 
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The Gps view subtitle provides the following information: 

 1st line : Non-masked observation time (From... : 
start date & time; To... : end date & time). 

 2nd line : Process Options, i.e. minimum elevation 
angle required, curtain involved/not 
involved in the process. 

In its left-hand part, the GPS view provides the instantaneous values 
of azimuth and elevation for the satellites present in the observation 
record for the current position of the time tag (indicated just above). 

On the polar diagram, orbits are shown for the satellites visible 
during all or part of the observation (SV No. indicated for each orbit 
plot). The presence of a satellite icon on an orbit plot means that the 
satellite is present for the current position of the time tag. 

 
 

Running the Natural process 
from within the Natural object 

- From the menu bar and whatever the displayed view, 
select Process and then Run 

 or 

 Click    in the toolbar. 
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- A message box appears providing information about the 
time required to complete the computation in progress. 
The following two steps are reported successively: 

 - Computing... 

 - Events processing... 

 On completion of the Natural process, the result is 
available on the target view (select this view, unless 
already done) 

 The Natural process needs to be re-run after you change a 
process option. 
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Mask editor 
The mask editor is also made available from within the Natural 
Processor as additional masking may be needed if for example 
satellite data are found suspect in view of the results provided by the 
process. 

Remember that satellites can be masked at two different levels: 

- in the observation record 
- or in process object. 

 

Using the Mask editor 
- From the menu bar, select Process and then Options 
 or 
 Position the mouse pointer anywhere on the active view 

and click with the right mouse button. In the shortcut menu 
that appears, choose Options. 

- In the dialog box which then appears, click the Mask 
button. This causes the Mask editor box to appear. Note 
that the content of this box is exactly the same as the one 
you would get from 3SPack Supervisor for the considered 
process object. 

   
 In blue : Satellites in view during the observation 

record (masking, if any, shown as one or 
more black segment). 
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Masking a satellite 
Masking a satellite is achieved by drawing a rectangle over each 
period of time during which the satellite must be masked. 

- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Mask command from the menu. 

- Draw a rectangle over the concerned line section by 
dragging the mouse pointer along a virtual line 
representing a diagonal of that rectangle. 

 You can define the two ends of the rectangle diagonal by 
referring to the information displayed at the foot of the 
dialog box (UTC time or point numbers; point numbers 
shown in blue). This information is continually updated as 
you move the cursor horizontally on the diagram. 

  
 Adjust the horizontal size of the rectangle so that it covers 

the period of time you want to mask and then release the 
mouse button. This causes the covered line section to 
appear in black, meaning that the satellite is now masked 
for that particular period of time. 

- Resume the above step as many times as necessary. 
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Unmasking a satellite 
- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Unmask command from the menu. 

- Draw a rectangle around the concerned line section 
(shown in black) and then release the mouse button. This 
causes the covered line section to re-appear in blue and 
green, meaning that the mask is now removed. 

 

Zooming in 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom In 
command. As a result the menu vanishes and the pointer 
looks like  

- Position the pointer on the point around which you want to 
zoom in and click with the left mouse button. As a result 
the time chart is magnified around this point (and the 
clicked point stays immobile in reference to the pane). 

- You can zoom in repeatedly by clicking several times with 
the left mouse button (until a bleep is heard). 
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Zooming out 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom Out 
command. As a result the menu vanishes and the pointer 
then looks like . 

- Position the pointer along the time axis on the point from 
which you want to zoom out and click with the left mouse 
button. As a result the window displays a larger-scale view 
centered around the clicked point 

- You can zoom out repeatedly by clicking several times with 
the left mouse button until you reach the view of the entire 
observation time span (denoted by a bleep). 

 
Moving the view along the time axis 
This function is active only on a magnified chart. 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Panoramic 
command. The menu vanishes and the pointer then looks 
like  

- Depress the left mouse button and drag the pointer 
leftward or rightward, depending on where the particular 
period you want to view is. Note that the time scale will 
move as you drag the pointer. Release the mouse button 
once you have reached the desired time. 
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Using the movable time tag on the Target 
or Gps view 
The time tag is defined as a particular time in the observation period. 
It is used to focus the Target or Gps view on that particular time, for 
example to know the exact number and positions of the visible 
satellites at that time. The time tag is shown as a green spot on the 
Target view. 

You can move the time tag forward or backward within the limits of 
the observation, by a time step depending on the sampling interval of 
the observation. The default position of the time tag is the beginning 
of the observation. 

The time tag may be moved in three different ways: 
 

1. Using the toolbar 

- Click    to take the time tag one step forward. 
 or 
- Click    to take the time tag one step backward.  

 
2. Using the keyboard 

- Depressing the "+" key (numeric keypad) causes the time 
tag to move one step forward. 

- Depressing the "-" key (numeric keypad) causes the time 
tag to move one step backward. 

- Holding down the "+" key (numeric keypad) causes the 
time tag to move one step forward repeatedly, at a fast 
rate, until you release the key. 

- Holding down the "-" key (numeric keypad) causes the time 
tag to move one step backward repeatedly, at a fast rate, 
until you release the key. 
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3. Using the mouse 

- Position the mouse pointer in the lower diagram (altitude 
vs. time) where you would like the time tag to be moved 
and click with the left-mouse button. This causes the time 
tag to be moved to the pointed location and the upper view 
to be updated accordingly. 

 
Copying a plot to the clipboard  
The clipboard is a temporary storage area for text and graphics that 
you are copying or moving from one location to another. The 
Clipboard is a common holding area among Windows applications. 

After choosing the desired view in the active window: 

- Click  

 or 

- From the menu bar, select Edit and then Copy 

 or 

- Position the mouse pointer anywhere on the plot, click the 
right mouse button. In the shortcut menu that appears, 
select Copy. 
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How to update your project document with 
the displayed view of your Natural object 
If you are in Separate Natural environment 

- In the menu bar, select the File menu and then the Update 
command. 

If you are in Embedded Natural environment 

- Updating is inherent since in this case you work directly on 
the process object of the project document. 

 
How to quit Natural 
If you are in Embedded Natural environment 

 
- Simply click in the active window, outside the process 

object or press the Esc key. The project document is 
systematically updated with the last displayed view of the 
Natural process. 

 
If you are in Separate Natural environment 

- In the menu bar, select File and then the Exit & Return to 
command. The project document is systematically updated 
with the last displayed view of the Natural process. 
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Menus and commands 
 

File menu commands (in separate Natural) 
 Update...  Updates the process object in the open 

project 

 Print  Prints the active process 

 Print Preview  Displays the process as it would appear 
printed 

 Print Setup  Selects a printer and printer connection 

 Exit & Return to...  Exits Natural and returns to the open 
project 

 
File menu (in embedded Natural) 

 
 New Project  Creates a new project 

 Open Project  Opens an existing project 

 Close Project  Closes the open project 

 Save Project  Saves the open project 

 Print  Prints the open project 

 Print Preview  Displays the project as it would appear 
printed 

 Page Setup  Defines the orientation and size of the 
printed document 

 Import GPS data  From GPS data stored in the Raw 
directory, creates observation records in 
the database 

 Exit  Exits 3SPack 
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Edit menu 
 

 Copy  Copies the process object to the clipboard 
 Dec time  Moves the time tag one step backward 
 Inc time  Moves the time tag one step forward 
 Operations  Edits the definition of the Natural process 
 

View menu (in separate Natural) 
 

 Target  Displays the active Natural process in the 
Target view 

 Gps  Displays the active Natural process in the 
Gps view 

 Toolbar  Shows/hides the toolbar 
 Status bar  Shows/hides the status bar 
 

View menu (in embedded Natural) 
 

 Target  Displays the active Natural object in the 
Target view 

 Gps  Displays the active Natural object in the 
Gps view 

 Toolbar  Shows/hides the toolbar 
 

Process menu 
 

 Run  Runs the active Natural process 

 Options  Displays the options of the active Natural 
process 
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Tools menu 
(Exists in Embedded Natural only) 
Same as 3SPack Supervisor'sTools menu, which can be 
customized. 

 
 

Window menu 
 New Window  Creates a new window 

 Cascade  Arranges all the open windows in cascade 
configuration 

 Tile  Arranges all the open windows in tile 
configuration 

 Arrange Icons  Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the Natural window. 

 {...}  Causes this open window, if any, to 
become active 

Help menu 
 
 Index  Displays the opening screen of Help 

 Using Help  Displays instructions for using Help 

 About Natural  Displays the version number of this 
application. 

 ♣♣♣♣  
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  7. DGNSS Processor 

Introduction 
- The DGNSS Processor allows you to determine a 

Trajectory or a Site solution. 

- At the end of a DGNSS processing, the site or trajectory 
solution is routed to the database to be stored into the 
corresponding record, thus enriching this record with a new 
solution. 

- The DGNSS processor makes use of a reference site to 
determine the surveyed site or trajectory. The condition 
required to perform a DGNSS process is that observations 
should have been performed concurrently at both the 
reference site and the surveyed site. The coordinates of 
the reference site should be known with the best possible 
accuracy 

- DGNSS can produce two different views for a process: 

- The Gps view, which shows the GPS 
constellation for a particular moment during 
the observation which the user specifies 
using the time tag. The view takes into 
account the intentionally deselected 
satellites, if any, and/or the user-set 
maskings, if any. 

- The Target view, which shows a map of the 
site or trajectory solution. 

 The chosen view will then be visible from the project 
document when you go back to this environment. 
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NOTE: 
- DGNSS is said to be "embedded" (or "in-place activated") 

if it is run in the main window of 3SPack Supervisor. This is 
the case when you double-click a process object in an 
open project, or if you select this object and choose 
successively Edit (in the menu bar of Supervisor) then 
DGNSS Object then Edit. 

- DGNSS is said to be "separate" or "open" if it is run in a 
separate main window. This is the case when you select a 
DGNSS object and you choose successively Edit then 
DGNSS Object and Open. 

 

How to choose a view for your DGNSS 
object 

- In the menu bar, select View and then the desired view: 

Target 
Gps 

 or 

 Position the mouse pointer anywhere on the active view 
and click with the right mouse button. In the shortcut menu 
that appears, choose the desired view: 

Target 
Gps 



DGNSS Processor 
Changing the options of a DGNSS process 

DSNP 7-3 

 

Changing the options of a DGNSS process 
 

WARNING! 
Changing any of these options requires 
that you re-run the process to get the 
updated view of the DGNSS object. 

 

- From the menu bar, select Process and then Options 

 or 

 In the toolbar, click   

 or 

 Move the mouse pointer anywhere on the DGNSS view, 
click with the right mouse button and, in the shortcut menu 
which then appears, select Options. 

 A dialog box appears in which you can set the options of 
the process: 

 View : Choose a view for your DGNSS process 
(Target or Gps) 

 Elev. min. : Choose the minimum elevation angle 
required of any satellite present in the 
observation record to be involved in the 
process 

 Use Ref curtain : Check this button if the curtain defined for 
the reference site must be involved in the 
processing  
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 Mask button : Provides access to the Mask editor 
through which you can add masking 
moments on the set of usable satellites 
(prior masking can have been made on the 
observation record from the 3SPack 
Supervisor environment). 

 
 Filter Code With Phase : Check this button to enable code/phase 

filtering (otherwise clear it). 

 
Deselected Svs pane     If required, depress the button(s) 

corresponding to the satellite(s) present in 
the observation record that you want to 
deselect 

 
 All button : Click this button to deselect all the 

satellites present in the observation record 

 None button : Click this button to re-select all the 
deselected satellites 

 
 Save As Defaults button : Click this button to save the current 

settings as the default options for the 
process 

 Restore Defaults button : Click this button to restore the default 
options previously defined for the process 

 OK button : Click this button if you agree with all the 
options shown in the dialog box 

 Cancel button : Click this button if you want to cancel the 
changes you have made in this dialog box. 



DGNSS Processor 
Target view 

DSNP 7-5 

 

Target view 
This view shows the result of your process. The solution is shown on 
two distinct plots for a trajectory, on a single plot for a site: 

- The diagram (top diagram for a trajectory) shows a map of 
the site or trajectory. The axis system is graduated North 
vs. East. 

 For a site, the axis system is centered at the averaged 
solution (coordinates displayed with yellow background, 
site location indicated by a flag) and the 95% probability 
ellipse is shown in green. The SdE, SdN and SdH standard 
deviations are also displayed with yellow background. The 
plot also includes the numeric results of the baseline 
solution (top left, in yellow background). 

 For a trajectory, the axis system is graduated so as to 
show all the points issued from the process. 

- For a trajectory, the bottom diagram shows an �altitude vs. 
time� view of the trajectory solution. The horizontal axis of 
this type of diagram shows the entire non-masked 
observation time (From... : start date & time; To... : end 
date & time). 

 When a trajectory is processed with DGNSS, flags may 
appear resulting from "markers" placed by the operator 
during the survey. When the DGNSS processor detects a 
marker in an observation record, an accurate 
determination of the position is performed for that 
particular time when the marker was inserted. Depending 
on whether the operator was walking (dynamic) or 
immobile (static) at that time, the position solution will 
result from one of the following two processings: 

 - position interpolation (dynamic) 

 - position averaging (static) 
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 The position solution is then saved as the solution of the 
site associated with the marker. 

Note the presence of a green spot (time tag) on each of the two 
diagrams allowing you to establish a time relationship between the 
two diagrams. 

 

• Note: 
 A marker is assumed to be static if it is placed between a 

"Stop Moving Antenna" event and a "Start Moving 
Antenna" event (see 3SPack Supervisor section, using 
the event editor). 

 The plot below is an example of a site processed with 
DGNSS: 

 



DGNSS Processor 
Target view 

DSNP 7-7 

 

3SPack automatically chooses the appropriate scale for the map, 
depending on the size of the dispersion ellipse. When the 1:100 
scale is used, it is indicated in the right-lower part of the map, with 
green background. 

The 1:100 scale is the largest scale possible for a DGNSS 
processing. 

The Target view subtitle provides the following information: 

 1st line : Name of the site or trajectory under 
process, observation record involved in the 
DGNSS process, antenna height offset. 

 2nd line : Name and coordinates of the reference 
site involved in the DGNSS process, 
observation record from which the 
coordinates of this site were determined. 

 3rd line : Non-masked observation time (From... : 
start date & time; To... : end date & time). 

 4th line : Process Options, i.e. minimum elevation 
angle requested, curtain involved/not 
involved in the process. 
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Gps view 
This view shows the orbit of each visible satellite for the considered 
observation, taking into account the minimum elevation angle, the 
presence or absence of the curtain and the fact that you may have 
intentionally rejected some of the visible satellites. The view uses 
polar coordinates: 

- Center of concentric circles: site location 

- From center to larger circle: elevation angle, from 90° to 0° 
respectively (each new circle represents 10° in elevation) 

- The angular space between any two adjacent lines 
represents 30° in azimuth; graduated clockwise from 0 to 
360° 
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The Gps view subtitle provides the following information: 

 1st line : Name and coordinates of the reference 
site from which the constellation was 
observed. 

 2nd line : Non-masked observation time (From... : 
start date & time; To... : end date & time). 

 3rd line : Process Options, i.e. minimum elevation 
angle required, curtain involved/not 
involved in the process. 

In its left-hand part, the GPS view provides the instantaneous values 
of azimuth and elevation for the satellites present in both observation 
records for the current position of the time tag (indicated just above). 

On the polar diagram, orbits are shown for the satellites visible 
during all or part of the observations (SV No. indicated for each orbit 
plot). The presence of a satellite icon on an orbit plot means that the 
satellite is present for the current position of the time tag. 

 
 

Running the DGNSS process 
from within the DGNSS object 

- From the menu bar and whatever the displayed view, 
select Process and then Run 

 or 

 Click    in the toolbar. 
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- A message box appears providing information about the 
time required to complete the computation in progress. 
The following two steps are reported successively: 

 - Computing... 

 - Events processing... 

 On completion of the DGNSS process, the result is 
available on the target view (select this view, unless 
already done) 

 The DGNSS process needs to be re-run after you change 
a process option. 
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Mask editor 
The mask editor is also made available from within the DGNSS 
Processor as additional masking may be needed if for example 
satellite data are found suspect in view of the results provided by the 
process. 
Remember that satellites can be masked at two different levels: 

- in the observation record 
- or in process object. 

 
Using the Mask editor 

- From the menu bar, select Process and then Options 
 or 
 Position the mouse pointer anywhere on the active view 

and click with the right mouse button. In the shortcut menu 
that appears, choose Options. 

- In the dialog box which then appears, click the Mask 
button. This causes the Mask editor box to appear. 

- The Mask editor of a DGNSS process presents the 
following difference compared to the one available from 
within 3SPack Supervisor: masking is shown concurrently 
for both the observation record made at the surveyed 
trajectory's initial point or site and that made at the 
reference site: 

   
 In blue : Satellites in view during the observation 

record (masking, if any, shown as one or 
more black segment). 

 In green : Satellites in view at reference site during 
observation record (masking, if any, shown 
as a black segment). 
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Masking a satellite 
Masking a satellite is achieved by drawing a rectangle over each 
period of time during which the satellite must be masked. 

- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Mask command from the menu. 

- Draw a rectangle over the concerned blue and green line 
sections by dragging the mouse pointer along a virtual line 
representing a diagonal of that rectangle. 

 You can define the two ends of the rectangle diagonal by 
referring to the information displayed at the foot of the 
dialog box (UTC time or point numbers; point numbers 
shown in blue). This information is continually updated as 
you move the cursor horizontally on the diagram. 

  
 Adjust the horizontal size of the rectangle so that it covers 

the period of time you want to mask and then release the 
mouse button. This causes the covered part to appear in 
black, meaning that the satellite is now masked for that 
particular period of time. 

- Resume the above step as many times as necessary. 
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Unmasking a satellite 
- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Unmask command from the menu. 

- Draw a rectangle around the concerned line section 
(shown in black) and then release the mouse button. This 
causes the covered line section to re-appear in blue and 
green, meaning that the mask is now removed. 

 

Zooming in 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom In 
command. As a result the menu vanishes and the pointer 
looks like  

- Position the pointer on the point around which you want to 
zoom in and click with the left mouse button. As a result 
the time chart is magnified around this point (and the 
clicked point stays immobile in reference to the pane). 

- You can zoom in repeatedly by clicking several times with 
the left mouse button (until a bleep is heard). 
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Zooming out 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom Out 
command. As a result the menu vanishes and the pointer 
then looks like . 

- Position the pointer along the time axis on the point from 
which you want to zoom out and click with the left mouse 
button. As a result the window displays a larger-scale view 
centered around the clicked point 

- You can zoom out repeatedly by clicking several times with 
the left mouse button until you reach the view of the entire 
observation time span (denoted by a bleep). 

 
Moving the view along the time axis 
This function is active only on a magnified chart. 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Panoramic 
command. The menu vanishes and the pointer then looks 
like  

- Depress the left mouse button and drag the pointer 
leftward or rightward, depending on where the particular 
period you want to view is. Note that the time scale will 
move as you drag the pointer. Release the mouse button 
once you have reached the desired time. 
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Using the movable time tag on the Target 
or Gps view 
The time tag is defined as a particular time in the observation period. 
It is used to focus the Target or Gps view on that particular time, for 
example to know the exact number and positions of the visible 
satellites at that time. The time tag is shown as a green spot on the 
Target view. 

You can move the time tag forward or backward within the limits of 
the observation, by a time step depending on the sampling interval of 
the observation. The default position of the time tag is the beginning 
of the observation. 

The time tag may be moved in three different ways: 
 

1. Using the toolbar 

- Click    to take the time tag one step forward. 
 or 
- Click    to take the time tag one step backward.  

 
2. Using the keyboard 

- Depressing the "+" key (numeric keypad) causes the time 
tag to move one step forward. 

- Depressing the "-" key (numeric keypad) causes the time 
tag to move one step backward. 

- Holding down the "+" key (numeric keypad) causes the 
time tag to move one step forward repeatedly, at a fast 
rate, until you release the key. 

- Holding down the "-" key (numeric keypad) causes the time 
tag to move one step backward repeatedly, at a fast rate, 
until you release the key. 
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3. Using the mouse 

- Position the mouse pointer in the lower diagram (altitude 
vs. time) where you would like the time tag to be moved 
and click with the left-mouse button. This causes the time 
tag to be moved to the pointed location and the upper view 
to be updated accordingly. 

 
Copying a plot to the clipboard  
The clipboard is a temporary storage area for text and graphics that 
you are copying or moving from one location to another. The 
Clipboard is a common holding area among Windows applications. 

After choosing the desired view in the active window: 

- Click  

 or 

- From the menu bar, select Edit and then Copy 

 or 

- Position the mouse pointer anywhere on the plot, click the 
right mouse button. In the shortcut menu that appears, 
select Copy. 
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How to update your project document with 
the displayed view of your DGNSS object 
If you are in Separate DGNSS environment 

- In the menu bar, select the File menu and then the Update 
command. 

If you are in Embedded DGNSS environment 

- Updating is inherent since in this case you work directly on 
the process object of the project document. 

 
How to quit DGNSS 
If you are in Embedded DGNSS environment 

 
- Simply click in the active window, outside the process 

object or press the Esc key. The project document is 
systematically updated with the last displayed view of the 
DGNSS process. 

 
If you are in Separate DGNSS environment 

- In the menu bar, select File and then the Exit & Return to 
command. The project document is systematically updated 
with the last displayed view of the DGNSS process. 
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Menus and commands 
 

File menu commands (in separate DGNSS) 
 Update...  Updates the process object in the open 

project 

 Print  Prints the active process 

 Print Preview  Displays the process as it would appear 
printed 

 Print Setup  Selects a printer and printer connection 

 Exit & Return to...  Exits DGNSS and returns to the open 
project 

 
File menu (in embedded DGNSS) 

 
 New Project  Creates a new project 

 Open Project  Opens an existing project 

 Close Project  Closes the open project 

 Save Project  Saves the open project 

 Print  Prints the open project 

 Print Preview  Displays the project as it would appear 
printed 

 Page Setup  Defines the orientation and size of the 
printed document 

 Import GPS data  From GPS data stored in the Raw 
directory, creates observation records in 
the database 

 Exit  Exits 3SPack 
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Edit menu 
 

 Copy  Copies the process object to the clipboard 
 Dec time  Moves the time tag one step backward 
 Inc time  Moves the time tag one step forward 
 Operations  Edits the definition of the DGNSS process 
 

View menu (in separate DGNSS) 
 

 Target  Displays the active DGNSS process in the 
Target view 

 Gps  Displays the active DGNSS process in the 
Gps view 

 Toolbar  Shows/hides the toolbar 
 Status bar  Shows/hides the status bar 
 

View menu (in embedded DGNSS) 
 

 Target  Displays the active DGNSS object in the 
Target view 

 Gps  Displays the active DGNSS object in the 
Gps view 

 Toolbar  Shows/hides the toolbar 
 

Process menu 
 

 Run  Runs the active DGNSS process 

 Options  Displays the options of the active DGNSS 
process 
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Tools menu 
(Exists in Embedded DGNSS only) 
Same as 3SPack Supervisor'sTools menu, which can be 
customized. 

 
 

Window menu 
 New Window  Creates a new window 

 Cascade  Arranges all the open windows in cascade 
configuration 

 Tile  Arranges all the open windows in tile 
configuration 

 Arrange Icons  Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the DGNSS window. 

 {...}  Causes this open window, if any, to 
become active 

Help menu 
 
 Index  Displays the opening screen of Help 

 Using Help  Displays instructions for using Help 

 About DGNSS  Displays the version number of this 
application. 

 ♣♣♣♣
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  8. Kinematic & LR Kinematic Processors 

Introduction 
- The Kinematic & LR Kinematic Processors allow you to 

determine a trajectory solution (i.e. all the points making up 
a trajectory). At the end of the processing, the trajectory 
solution is routed to the 3SPack Supervisor database to be 
stored into the corresponding trajectory record, thus 
enriching this trajectory record with a new solution. 

- The Kinematic & LR Kinematic Processors make use of a 
reference site to determine a trajectory. The condition 
required to perform a Kinematic or LR Kinematic process 
is that observations should have been performed 
concurrently at both the reference site and the roving unit. 
In addition, observations have to be dual-frequency for a 
LR Kinematic process. The coordinates of the reference 
site should be known with the best possible accuracy. 

- A Kinematic or LR Kinematic process can be started in one 
of the following four initialization modes: 

 

 Known point : The kinematic processing is initialized with 
the coordinates of the initial point as 
defined by the user in the corresponding 
trajectory record. 

 Rapid Static : The kinematic processing is started 
assuming the observation record involved 
starts with a significant time interval of 
static observation. 



Kinematic & LR Kinematic Processors 
Introduction 

8-2 DSNP 

8 

 Stamove : The kinematic processing is started 
assuming the height coordinate of the 
trajectory remains a constant. 

 OTF : The kinematic processing is started 
without any reference to an initial point 
(OTF means �On The Fly�). OTF is the 
default initialization mode. 

   During the process and in the event of a 
phase loss, OTF will be selected 
systematically for re-initialization purpose 
whatever the mode you chose before 
running the processing. 

 

- The Kinematic and LR Kinematic Processors can produce 
two different views of a trajectory process: 

- The Gps view shows the GPS constellation for a 
particular moment during the observation which 
the user specifies using the time tag. The view 
takes into account the intentionally deselected 
satellites, if any, and/or the user-set maskings, if 
any. 

- The Target view shows a map of the trajectory. 

 If markers are present in the observation, they are 
shown on the two views in the form of flag icons 
placed along the trajectory. 

 The chosen view will then be visible from the project 
document when you go back to this environment. 
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NOTES: 
- Kinemat is said to be "embedded" (or "in-place activated") 

if it is run in the main window of 3SPack Supervisor. This is 
the case when you double-click a process object in an 
open project, or if you select this object and choose 
successively Edit (in the menu bar of Supervisor) then 
Kinemat Object then Edit. 

- Kinemat is said to be "separate" or "open" if it is run in a 
separate main window. This is the case when you select a 
kinematic object and you choose successively Edit then 
Kinemat Object and Open. 

 

How to choose a view for your (LR) 
kinematic object 

- In the menu bar, select View and then the desired view: 

Target 
Gps 

 or 

 Position the mouse pointer anywhere on the active view 
and click with the right mouse button. In the shortcut menu 
that appears, choose the desired view: 

Target 
Gps 
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Changing the options of a (LR) kinematic 
process 

 
WARNING! 

Changing any of these options requires 
that you re-run the process to get the 

updated view of the object. 
 

- From the menu bar, select Process and then Options 

 or 

 In the toolbar, click   

 or 

 Move the mouse pointer anywhere on the kinematic view, 
click with the right mouse button and, in the shortcut menu 
which then appears, select Options. 

 A dialog box appears in which you can set the options of 
the process: 

 View : Choose a view for your kinematic process 
(Target or Gps) 

 Elev. min. : Choose the minimum elevation angle 
required of any satellite present in the 
observation record to be involved in the 
process 

 Use Ref curtain : Check this button if the curtain defined at 
the reference site must be involved in the 
processing 
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 Mode : Choose one of the following initialization 
modes: 

Known point 
Rapid Static 
Stamove 
OTF 

   See definitions in the introduction to this 
section. 

 
 Mask button : Provides access to the Mask editor 

through which you can add masking 
moments on the set of usable satellites 
(prior masking can have been made on the 
observation record from the Supervisor 
environment). 

Deselected Svs pane     If required, depress the button(s) 
corresponding to the satellite(s) present in 
the observation records that you want to 
deselect 

 
 All button : Click this button to deselect all the 

satellites present in the observation record 

 None button : Click this button to re-select all the 
deselected satellites 

 
 L1/L2 Iono Processing : Deals with the dual-frequency model used 

to correct iono errors (in LR Kinematic 
only). Choose one of the following three 
options: 

   On: model always used 
   Off: model never used 
   Automatic: model used only for those 

points distant by more than 10 km from 
the reference station 
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 Save As Defaults 
 button : Click this button to save the current 

settings as the default options for the 
process 

 Restore Defaults 
 button : Click this button to restore the default 

options previously defined for the process 

 OK button : Click this button if you agree with all the 
options shown in the dialog box 

 Cancel button : Click this button if you want to cancel the 
changes you have made in this dialog box 

 

Target view 
This view shows the result of your process. The trajectory is shown 
on two different diagrams (see in the next page): 

- The top diagram shows a map of the trajectory (the axis 
system is graduated North vs. East) 

- The bottom diagram shows an �altitude vs. time� view of 
the trajectory. The horizontal axis shows the non-masked 
observation time common to the roving unit and the 
reference station. 

Note the presence of a green spot (time tag) on each of the two 
diagrams allowing you to establish a time relationship between the 
two diagrams. 

Note also the possible presence of flags resulting from "markers" 
placed by the operator during the survey. When the Kinematic 
processor detects a marker in an observation record, an accurate 
determination of the position is performed for that particular time 
when the marker was inserted. 
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Depending on whether the operator was walking (dynamic) or 
immobile (static) at that time, the position solution will result from 
one of the following two processings: 

- position interpolation (dynamic) 

- position averaging (static) 

The position solution is then saved as the solution of the site 
associated with the marker. 

 

 Note: A marker is assumed to be static if it is placed 
between a "Stop Moving Antenna" event and a "Start 
Moving Antenna" event (see 3SPack Supervisor section, 
using the event editor). 
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The Target view subtitle provides the following information: 

 1st line : Name of the trajectory under process, 
observation record involved in the 
kinematic process 

 2nd line : Name and coordinates of the reference 
site involved in the kinematic process, 
observation record from which the 
coordinates of this site were determined 

 3rd line : Non-masked observation time common to 
roving unit and reference station (From... : 
start date & time; To... : end date & time) 

 4th line : Process Options, i.e. initialization mode 
used, minimum elevation angle required, 
curtain involved/not involved in the 
process. 
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Gps view 
This view shows the orbit of each visible satellite for the considered 
observation, taking into account the minimum elevation angle, the 
presence or absence of the curtain and the fact that you may have 
intentionally rejected some of the visible satellites. The view uses 
polar coordinates: 

- Center of concentric circles: location of reference site 

- From center to larger circle: elevation angle, from 90° to 0° 
respectively (each new circle represents 10° in elevation) 

- The angular space between any two adjacent lines 
represents 30° in azimuth; graduated clockwise from 0 to 
360° 

 

 



Kinematic & LR Kinematic Processors 
Gps view 

8-10 DSNP 

8 

The Gps view subtitle provides the following information: 

 1st line : Name and coordinates of the reference 
site from which the constellation was 
observed. 

 2nd line : Non-masked observation time common to 
roving unit and reference station (From... : 
start date & time; To... : end date & time). 

 3rd line : Process Options, i.e. minimum elevation 
angle required, curtain involved/not 
involved in the process. 

 

In its left-hand part, the GPS view provides the instantaneous values 
of azimuth and elevation for the satellites present in the observation 
record for the current position of the time tag (indicated just above). 

On the polar diagram, orbits are shown for the satellites visible 
during all or part of the observation (SV No. indicated for each orbit 
plot). The presence of a satellite icon on an orbit plot means that the 
satellite is present for the current position of the time tag. 
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Running the (LR) kinemat process 
from within the (LR) kinematic object 

- From the menu bar and whatever the displayed view, 
select Process and then Run 

 or 

 Click    in the toolbar. 

- A message box appears providing information about the 
time required to complete the computation in progress. 
The following four steps are reported successively: 

 - Locking... 
 - Backward processing... 
 - Forward processing... 
 - Event processing... 

 On completion of the kinematic process, the result of the 
trajectory is available on the target view (select this view, 
unless already done) 

 The kinematic process needs to be re-run after you 
change a process option. 

 
 

Mask editor 
The mask editor is also made available from within the (LR) 
Kinematic Processor as additional masking may be needed if for 
example satellite data are found suspect in view of the results 
provided by the process. 

Remember that satellites can be masked at two different levels: 

- in the observation record 
- or in process object. 
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Using the Mask editor 
- From the menu bar, select Process and then Options 
 or 

 Position the mouse pointer anywhere on the active view 
and click with the right mouse button. In the shortcut menu 
that appears, choose Options. 

- In the dialog box which then appears, click the Mask 
button. This causes the Mask editor box to appear. Note 
that the content of this box is exactly the same as the one 
you would get from 3SPack Supervisor for the considered 
process object. 

 Compared to those of other processors, the Mask editor of 
a (LR) kinematic process presents the following difference: 
masking is shown concurrently for both the observation 
record made at the trajectory's initial point and that made 
at the reference site: 

 

  
 

 In blue : Satellites in view from the start point of the 
trajectory during observation record 
(masking, if any, shown as a black 
segment). 

 In green : Satellites in view at reference site during 
observation record (masking, if any, shown 
as a black segment). 



Kinematic & LR Kinematic Processors 
Mask editor 

DSNP 8-13 

 

Masking a satellite 
Masking a satellite is achieved by drawing a rectangle over each 
period of time during which the satellite must be masked. 

- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Mask command from the menu. 

- Draw a rectangle over the concerned line section by 
dragging the mouse pointer along a virtual line 
representing a diagonal of that rectangle. 

- You can define the two ends of the diagonal by referring to 
the information displayed at the foot of the dialog box (UTC 
time or point numbers; point numbers shown in blue for the 
roving unit, in green for the reference station) This 
information is continually updated as you move the cursor 
horizontally on the diagram. 

  
- Adjust the horizontal size of the rectangle so that it covers 

the period of time, or the range of point numbers, you 
would like to mask and then release the mouse button. 
This causes the covered line section to appear in black, 
meaning that the satellite is now masked for that particular 
period of time. Note that the mask is equally applied to 
both the roving unit and the reference site. 

- Resume the above step as many times as necessary. 
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Unmasking a satellite 
- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Unmask command from the menu. 

- Draw a rectangle around the concerned line section 
(shown in black) and then release the mouse button. This 
causes the covered line section to re-appear in blue and 
green, meaning that the mask is now removed. 

 

Zooming in 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom In 
command. As a result the menu vanishes and the pointer 
looks like  

- Position the pointer on the point around which you want to 
zoom in and click with the left mouse button. As a result 
the time chart is magnified around this point (and the 
clicked point stays immobile in reference to the pane). 

- You can zoom in repeatedly by clicking several times with 
the left mouse button (until a bleep is heard). 
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Zooming out 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom Out 
command. As a result the menu vanishes and the pointer 
then looks like . 

- Position the pointer along the time axis on the point from 
which you want to zoom out and click with the left mouse 
button. As a result the window displays a larger-scale view 
centered around the clicked point 

- You can zoom out repeatedly by clicking several times with 
the left mouse button until you reach the view of the entire 
observation time span (denoted by a bleep). 

 
Moving the view along the time axis 
This function is active only on a magnified chart. 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Panoramic 
command. The menu vanishes and the pointer then looks 
like  

- Depress the left mouse button and drag the pointer 
leftward or rightward, depending on where the particular 
period you want to view is. Note that the time scale will 
move as you drag the pointer. Release the mouse button 
once you have reached the desired time. 
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Using the movable time tag on the Target 
or Gps view 
The time tag is defined as a particular time in the observation period. 
It is used to focus the Target or Gps view on that particular time, for 
example to know the exact number and positions of the visible 
satellites at that time. The time tag is shown as a green spot on the 
Target view. 

You can move the time tag forward or backward within the limits of 
the observation, by a time step depending on the sampling interval of 
the observation. The default position of the time tag is the beginning 
of the observation. 

The time tag may be moved in three different ways: 
 

1. Using the toolbar 
 

- Click    to take the time tag one step forward. 
 or 

- Click    to take the time tag one step backward. 
 

2. Using the keyboard 
 

- Depressing the "+" key (numeric keypad) causes the 
time tag to move one step forward. 

- Depressing the "-" key (numeric keypad) causes the 
time tag to move one step backward. 

- Holding down the "+" key (numeric keypad) causes the 
time tag to move one step forward repeatedly, at a fast 
rate, until you release the key. 

- Holding down the "-" key (numeric keypad) causes the 
time tag to move one step backward repeatedly, at a 
fast rate, until you release the key. 
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3. Using the mouse 

- Position the mouse pointer in the lower diagram 
(altitude vs. time) where you would like the time tag to 
be moved and click with the left-mouse button. This 
causes the time tag to be moved to the pointed location 
and the upper view to be updated accordingly. 

 

Copying a plot to the clipboard  
The clipboard is a temporary storage area for text and graphics that 
you are copying or moving from one location to another. The 
Clipboard is a common holding area among Windows applications. 

 

After choosing the desired view in the active window: 

- Click  

 or 

- From the menu bar, select Edit and then Copy 

 or 

- Position the mouse pointer anywhere on the plot, click the 
right mouse button. In the shortcut menu that appears, 
select Copy. 
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How to update your project document with 
the displayed view of your kinematic object 
If you are in Separate Kinemat environment 

- In the menu bar, select the File menu and then the Update 
command. 

 
If you are in Embedded Kinemat environment 

- Updating is inherent since in this case you work directly on 
the process object of the project document. 

 

How to quit Kinemat 
If you are in Embedded Kinemat environment 

 
- Simply click in the active window, outside the process 

object or press the Esc key. The project document is 
systematically updated with the last displayed view of the 
(LR) kinematic process. 

 
If you are in Separate Kinemat environment 

- In the menu bar, select File and then the Exit & Return to 
command. The project document is systematically updated 
with the last displayed view of the (LR) kinematic process. 
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Menus and commands 

File menu commands (in separate Kinemat) 
 Update...  Updates the process object in the open 

project 

 Print  Prints the active process 

 Print Preview  Displays the process as it would appear 
printed 

 Print Setup  Selects a printer and printer connection 

 Exit & Return to...  Exits Kinemat and returns to the open 
project 

 
File menu (in embedded Kinemat) 

 
 New Project  Creates a new project 

 Open Project  Opens an existing project 

 Close Project  Closes the open project 

 Save Project  Saves the open project 

 Print  Prints the open project 

 Print Preview  Displays the project as it would appear 
printed 

 Page Setup  Defines the orientation and size of the 
printed document 

 Import GPS data  From GPS data stored in the Raw 
directory, creates observation records in 
the 3SPack Supervisor database 

 Exit  Exits 3SPack 
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Edit menu 
 Copy  Copies the process object to the clipboard 

 Dec time  Moves the time tag one step backward 

 Inc time  Moves the time tag one step forward 

 Operations  Edits the definition of the (LR) kinematic 
process 

 
View menu (in separate Kinemat) 

 
 Target  Displays the active process in the Target 

view 

 Gps  Displays the active process in the Gps 
view 

 Toolbar  Shows/hides the toolbar 

 Status bar  Shows/hides the status bar 

 
View menu (in embedded Kinemat) 

 Target  Displays the active object in the Target 
view 

 Gps  Displays the active object in the Gps view 

 Toolbar  Shows/hides the toolbar 
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Process menu 
 Run  Runs the active (LR) kinematic process 
 Options  Displays the options of the active process 
 
 

Tools menu 
(Exists in Embedded Kinemat only) 
Same as 3SPack Supervisor'sTools menu, which can be 
customized. 
 

 
Window menu 

 New Window  Creates a new window 
 Cascade  Arranges all the open windows in cascade 

configuration 
 Tile  Arranges all the open windows in tile 

configuration 
 Arrange Icons  Places all the minimized windows side by 

side, from left to right, and from the lower 
part of the Kinemat window. 

 {...}  Causes this open window, if any, to 
become active 

 
Help menu 

 Index  Displays the opening screen of Help 
 Using Help  Displays instructions for using Help 
 About Kinemat  Displays the version number of this 

application. ♣  
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  9. Rapid Static & LR Rapid Static processors 

Introduction 
- The Rapid Static & LR Rapid Static processors allow you 

to determine a Site solution. At the end of the processing, 
the Site solution is routed to the database to be stored into 
the corresponding record, thus enriching this record with a 
new solution. 

- The Rapid Static & LR Rapid Static processors make use 
of a reference site to determine the surveyed site. The 
condition required to perform a (LR) Rapid Static process 
is that observations should have been performed 
concurrently at both the reference site and the surveyed 
site. For an LR Rapid Static process, observations have to 
be dual-frequency. The coordinates of the reference site 
should be known with the best possible accuracy. 

- Rapid Static can produce two different views for the 
process: 

- The Gps view shows the GPS constellation 
for a particular moment during the 
observation which the user specifies using 
the time tag. The view takes into account 
the intentionally deselected satellites, if 
any, and/or the user-set maskings, if any. 

- The Target view shows a map of the site. 

 The chosen view will then be visible from the project 
document when you go back to this environment. 
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NOTES: 
- Rapid Static is said to be "embedded" (or "in-place 

activated") if it is run in the main window of 3SPack 
Supervisor. This is the case when you double-click a 
process object in an open project, or if you select this 
object and choose successively Edit (in the menu bar of 
3SPack Supervisor) then Static Object then Edit. 

- Rapid Static is said to be "separate" or "open" if it is run in 
a separate main window. This is the case when you select 
a static object and you choose successively Edit then 
Static Object and Open. 

 

How to choose a view for your (LR) Rapid 
Static object 

- In the menu bar, select View and then the desired view: 

Target 
Gps 

 or 

 Position the mouse pointer anywhere on the active view 
and click with the right mouse button. In the shortcut menu 
that appears, choose the desired view: 

Target 
Gps 
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Changing the options of a (LR) Rapid Static 
process 

 

WARNING! 
Changing any of these options 

requires that you re-run the 
process to get the updated view of 

the object. 
 

- From the menu bar, select Process and then Options 

 or 

 In the toolbar, click   

 or 

 Move the mouse pointer anywhere on the static view, click 
with the right mouse button and, in the shortcut menu 
which then appears, select Options. 

 A dialog box appears in which you can set the options of 
the process: 

 View : Choose a view for your static process 
(Target or Gps) 

 Elev. min. : Choose the minimum elevation angle 
required of any satellite present in the 
observation record to be involved in the 
process 

 Use "Site from" curtain : Check this button if the curtain defined at 
the reference site must be involved in the 
processing 
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 Use "Site to" curtain : Check this button if the curtain defined 
at the surveyed site must be involved in 
the processing 

 Mask button : Provides access to the Mask editor 
through which you can add masking 
moments on the set of usable satellites 
(prior masking can have been made on 
the observation record from the 3SPack 
Supervisor environment). 

 
Deselected Svs pane     If required, depress the button(s) 

corresponding to the satellite(s) present 
in the observation records that you 
want to deselect 

 
 All button : Click this button to deselect all the 

satellites present in the observation 
record 

 None button : Click this button to re-select all the 
deselected satellites 

 L1/L2 Iono Processing : Deals with the dual-frequency model 
used to correct iono errors (in LR Rapid 
Static only). Choose one of the 
following three options: 

   On: model always used 
   Off: model never used 
   Automatic: model used only for 

baselines exceeding 10 km in length 
 Save As Defaults button : Click this button to save the current 

settings as the default options for the 
process 
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 Restore Defaults button : Click this button to restore the default 
options previously defined for the 
process 

 OK button : Click this button if you agree with all the 
options shown in the dialog box 

 Cancel button : Click this button if you want to cancel 
the changes you have made in this 
dialog box. 

 
 

Target view 
This view shows a map of the site (the axis system is graduated 
North vs. East), centered around the average solution of the site, as 
deduced from all the points issued from the process. 

The 95% dispersion ellipse is shown in green, centered around the 
site solution (location denoted by a flag). The X-Y-Z coordinates of 
the solution, the baseline and the E sd, N sd and H sd standard 
deviations, are indicated with yellow background.  

3SPack automatically chooses the appropriate scale for the map, 
depending on the size of the dispersion ellipse. When the 1:1 scale 
is used, it is indicated in the right-lower part of the map, with green 
background. 
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The 1:1 scale is the largest scale possible. 
 

 
The Target view subtitle provides the following information: 

 1st line : Name of the site under process, 
observation record involved in the Rapid 
Static process. 

 2nd line : Name and coordinates of the reference 
site involved in the Rapid Static process, 
observation record from which the 
coordinates of this site were determined. 

 3rd line : Non-masked observation time common to 
roving unit and reference station (From... : 
start date & time; To... : end date & time). 

 4th line : Process Options, i.e. minimum elevation 
angle required, curtains involved/not 
involved in the process. 
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Gps view 
This view shows the orbit of each visible satellite for the considered 
observation, taking into account the minimum elevation angle, the 
presence or absence of the curtain(s) and the fact that you may 
have intentionally rejected some of the visible satellites. The view 
uses polar coordinates: 

- Center of concentric circles: location of reference site 

- From center to larger circle: elevation angle, from 90° to 0° 
respectively (each new circle represents 10° in elevation) 

- The angular space between any two adjacent lines 
represents 30° in azimuth; graduated clockwise from 0 to 
360° 
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The Gps view subtitle provides the following information: 

 1st line : Name and coordinates of the surveyed site 
from which the constellation was observed. 

 2nd line : Non-masked observation time common to 
roving unit and reference station (From... : 
start date & time; To... : end date & time). 

 3rd line : Process Options, i.e. minimum elevation 
angle required, curtain involved/not 
involved in the process. 

 
In its left-hand part, the GPS view provides the instantaneous values 
of azimuth and elevation for the satellites present in the observation 
record for the current position of the time tag (indicated just above). 

On the polar diagram, orbits are shown for the satellites visible 
during all or part of the observation (SV No. indicated for each orbit 
plot). The presence of a satellite icon on an orbit plot means that the 
satellite is present for the current position of the time tag. 
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Running the (LR) Rapid Static process 
from within the Static object 

- From the menu bar and whatever the displayed view, 
select Process and then Run 

 or 

 Click    in the toolbar. 

- A message box appears providing information about the 
time required to complete the computation in progress. 
The following three steps are reported successively: 

 - Locking... 

 - Quality Control... (possibly) 

 - Computing... 

 - Event processing... 

 
 

 NOTE: The Quality Control message will appear only if the 
processor has determined several probable integer sets. 

 
 On completion of the Rapid Static process, the result of the 

site is available on the target view (select this view, unless 
already done) 

 The Rapid Static process needs to be re-run whenever you 
change a process option. 
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As you probably know, the present solar activity, which has 
increased during the last months, will reach a maximum in the early 
year 2000. As solar activity has a direct influence on the ionospheric 
layer, which introduces propagation delays for L1 and L2, ambiguity 
resolution will become more difficult both for single- and dual-
frequency systems. 

The operational consequences of this phenomenon is a longer 
initialisation phase in real-time systems and, in post-processing 
systems, the need for accurately choosing the duration of recording 
as a function of the baseline length. 

To be on the safe side, we give you hereunder some field guidelines 
which should avoid potential future problems when post-processing 
data with the (LR) Rapid Static processor: 

Recording Rate 

Single-frequency Dual-frequency 

6 seconds max. (3 seconds recommended) 
 

Recording Duration 

Single-frequency Dual-frequency 

10 minutes + 1.5 minutes per km 5 minutes + 0.5 minutes per km 
 

Please notice that all suppliers of GPS equipment will suffer from 
this situation while DSNP will still keep its technical advantage in 
terms of high initialisation speed and reliability, even if these features 
will be slightly degraded compared to what we experience now. 

 

Mask editor 
The mask editor is also made available from within the Static 
Processor as additional masking may be needed if for example 
satellite data are found suspect in view of the results provided by the 
process. 
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Remember that satellites can be masked at two different levels: 

- in the observation record 
- or in process object. 

 

Using the Mask editor 
- From the menu bar, select Process and then Options 
 or 

 Position the mouse pointer anywhere on the active view 
and click with the right mouse button. In the shortcut menu 
that appears, choose Options. 

- In the dialog box which then appears, click the Mask 
button. This causes the Mask editor box to appear. 

 Compared to that of Supervisor, the Mask editor of a Rapid 
Static process presents the following difference: masking 
is shown concurrently for both the observation record 
made at the surveyed site and that made at the reference 
site: 

  
 

 In blue : Satellites in view at the surveyed site 
during observation record (masking, if any, 
shown as black segment). 

 In green : Satellites in view at reference site during 
observation record (masking, if any, shown 
as black segment). 
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Masking a satellite 
Masking a satellite is achieved by drawing a rectangle over each 
period of time during which the satellite must be masked. 

- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Mask command from the menu. 

- Draw a rectangle over the concerned line section by 
dragging the mouse pointer along a virtual line 
representing a diagonal of that rectangle. 

- You can define the two ends of the diagonal by referring to 
the information displayed at the foot of the dialog box (UTC 
time or point numbers; point numbers shown in blue for the 
roving unit, in green for the reference station) This 
information is continually updated as you move the cursor 
horizontally on the diagram. 

  
 Adjust the horizontal size of the rectangle so that it covers 

the period of time you want to mask and then release the 
mouse button. This causes the covered line section to 
appear in black, meaning that the satellite is now masked 
for that particular period of time. Note that the mask is 
equally applied to both the surveyed site and the reference 
site. 

- Resume the above step as many times as necessary. 
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Unmasking a satellite 
- Position the mouse pointer anywhere on the chart. The 

mouse pointer then looks like  

- Click with the right mouse button. The Mask shortcut menu 
pops up. 

- Choose the Unmask command from the menu. 

- Draw a rectangle around the concerned line section 
(shown in black) and then release the mouse button. This 
causes the covered line section to re-appear in blue and 
green, meaning that the mask is now removed. 

 

Zooming in 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 

- In the shortcut menu that appears, choose the Zoom In 
command. As a result the menu vanishes and the pointer 
looks like  

- Position the pointer on the point around which you want to 
zoom in and click with the left mouse button. As a result 
the time chart is magnified around this point (and the 
clicked point stays immobile in reference to the pane). 

- You can zoom in repeatedly by clicking several times with 
the left mouse button (until a bleep is heard). 

 

Zooming out 
- Position the mouse pointer anywhere on the chart and click 

with the right mouse button. 
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- In the shortcut menu that appears, choose the Zoom Out 
command. As a result the menu vanishes and the pointer 
then looks like . 

- Position the pointer along the time axis on the point from 
which you want to zoom out and click with the left mouse 
button. As a result the window displays a larger-scale view 
centered around the clicked point 

- You can zoom out repeatedly by clicking several times with 
the left mouse button until you reach the view of the entire 
observation time span (denoted by a bleep). 

 

Moving the view along the time axis 
This function is active only on a magnified chart. 

- Position the mouse pointer anywhere on the chart and click 
with the right mouse button. 

- In the shortcut menu that appears, choose the Panoramic 
command. The menu vanishes and the pointer then looks 
like  

- Depress the left mouse button and drag the pointer 
leftward or rightward, depending on where the particular 
period you want to view is. Note that the time scale will 
move as you drag the pointer. Release the mouse button 
once you have reached the desired time. 

 

Using the movable time tag on the Gps view 
The time tag is defined as a particular time in the observation period. 
It is used to focus the Gps view on that particular time, for example 
to know the exact number and positions of the visible satellites at 
that time. The exact time-position of the tag is indicated in the left-
upper part of the view. 
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You can move the time tag forward or backward within the limits of 
the observation, by a time step depending on the sampling interval of 
the observation. The default position of the time tag is the beginning 
of the observation. 

The time tag may be moved in two different ways: 
 

1. Using the toolbar 
 

- Click    to take the time tag one step forward. 

 or 

- Click    to take the time tag one step backward.  
 

2. Using the keyboard 
 

- Depressing the "+" key (numeric keypad) causes the time 
tag to move one step forward. 

- Depressing the "-" key (numeric keypad) causes the time 
tag to move one step backward. 

- Holding down the "+" key (numeric keypad) causes the 
time tag to move one step forward repeatedly, at a fast 
rate, until you release the key. 

- Holding down the "-" key (numeric keypad) causes the time 
tag to move one step backward repeatedly, at a fast rate, 
until you release the key. 

 

Copying a plot to the clipboard  
The clipboard is a temporary storage area for text and graphics that 
you are copying or moving from one location to another. The 
Clipboard is a common holding area among Windows applications. 
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After choosing the desired view in the active window: 

- Click  

 or 

- From the menu bar, select Edit and then Copy 

 or 

- Position the mouse pointer anywhere on the plot, click the 
right mouse button. In the shortcut menu that appears, 
select Copy. 

 

How to update your project document with 
the displayed view of your Static object 
If you are in Separate Rapid Static environment 

- In the menu bar, select the File menu and then the Update 
command. 

 
If you are in Embedded Rapid Static environment 

- Updating is inherent since in this case you work directly on 
the process object of the project document. 

 

How to quit Rapid Static 
If you are in Embedded Rapid Static environment 

 
- Simply click in the active window, outside the process 

object or press the Esc key. The project document is 
systematically updated with the last displayed view of the 
static process. 
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If you are in Separate Rapid Static environment 

- In the menu bar, select File and then the Exit & Return to 
command. The project document is systematically updated 
with the last displayed view of the Rapid Static process. 

 

Menus and commands 
 

File menu commands (in separate Rapid Static) 
 Update...  Updates the process object in the open 

project 

 Print  Prints the active process 

 Print Preview  Displays the process as it would appear 
printed 

 Print Setup  Selects a printer and printer connection 

 Exit & Return to...  Exits Static and returns to the open project 

 

 
File menu (in embedded Rapid Static) 

 New Project  Creates a new project 

 Open Project  Opens an existing project 

 Close Project  Closes the open project 

 Save Project  Saves the open project 

 Print  Prints the open project 

 Print Preview  Displays the project as it would appear 
printed 
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 Page Setup  Defines the orientation and size of the 
printed document 

 Import GPS data  From GPS data stored in the Raw 
directory, creates observation records in 
the database 

 Unprotect component  Allows you to activate an application you 
buy later (password provided by DSNP) 

 Exit  Exits 3SPack 

 

 
Edit menu 

 
 Copy  Copies the process object to the clipboard 

 Dec time  Moves the time tag one step backward 

 Inc time  Moves the time tag one step forward 

 Operations  Edits the definition of the static process 

 

 
View menu (in separate Rapid Static) 

 
 Target  Displays the active static process in the 

Target view 

 Gps  Displays the active static process in the 
Gps view 

 Toolbar  Shows/hides the toolbar 

 Status bar  Shows/hides the status bar 
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View menu (in embedded Rapid Static) 

 
 Target  Displays the active static object in the 

Target view 

 Gps  Displays the active static object in the Gps 
view 

 Toolbar  Shows/hides the toolbar 

 

Process menu 
 
 Run  Runs the active Rapid Static process 

 Options  Displays the options of the active static 
process 

 
Tools menu 

 
(Exists in Embedded Rapid Static only) 
Same as 3SPack Supervisor'sTools menu, which can be 
customized. 
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Window menu 
 New Window  Creates a new window 

 Cascade  Arranges all the open windows in cascade 
configuration 

 Tile  Arranges all the open windows in tile 
configuration 

 Arrange Icons  Places all the minimized windows side by 
side, from left to right, and from the lower 
part of the Static window. 

 {...}  Causes this window, if any, to become 
active 

 
Help menu 

 
 Index  Displays the opening screen of Help 

 Using Help  Displays instructions for using Help 

 About Rapid Static  Displays the version number of this 
application. ♣  
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  10. Transfo 

Introduction 
The TRANSFO module is used to convert coordinates from a format 
and Datum to another format and Datum. The formats handled by 
TRANSFO are: 

- Latitude - Longitude - Height, 
- X - Y - Z : Earth-Centered, Earth-Fixed, 
- NEH : Projected Northing, Easting and Height. 

The TRANSFO window displays two presentations of the same 
position: on the left is the position to be transformed ('From' 
coordinates) and on the right is the result of the transformation by 
TRANSFO ('To' coordinates). You only need to select the 'From' 
system and the 'To' system from the combo boxes and enter the 
original position into the left-hand text boxes. 
The position to be transformed can be entered manually (by typing it 
into the text boxes) or pasted from another WINDOWS application. 
The position (whether original or transformed) can be copied to 
another WINDOWS application. The list of positions in the 
TRANSFO window can be saved to a disk so that it can be loaded 
from it at a later date. 
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Entering one or more positions to be 
transformed 
After you open the TRANSFO application, the TRANSFO main 
window displays with a transformation list window open in it. You can 
use each window's title bar and/or control menu to move and/or 
resize the windows. 

Prior to entering the position to be transformed, you must select the 
initial coordinate system from the System From combo box. 

There are three ways of entering a position to be transformed: 

- Typing 
- Pasting 
- Drag and Drop 

You can generate a list of positions using the following buttons: 

 Add  Enters a blank position at the end of the list. 

 Insert  Enters a blank position between the 
displayed position and the preceding one.  

 Delete  Removes the displayed position from the list. 

If you entered two or more positions into the System From boxes, 
use the scroll bar to browse through the list and view the desired 
position. 

 

Blank position 
Blank entry fields on Lat-Lon WGS 84 system: 

 Lat 0°  0'  0.0000" N 

 Lon 0°  0'  0.0000" E 

 Alt 0.000 m 
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Typing a position 
To type a position into the From entry boxes,  

- click in the desired entry field 

- type the desired value. 

The coordinates are automatically converted (in the System To 
boxes) as you type new values. 

 

Pasting a position 
You can import a copy of a position from the clipboard to the active 
transformation list. (The position must be placed beforehand in the 
clipboard, e.g. by selecting the Copy Pos From or Copy Pos To 
command from the Edit menu or from the pop-up menu accessible 
with the mouse right button). 

Pasting a position into TRANSFO will replace the position previously 
displayed in the active transformation list. Use the scrollbar to select 
a position you do not mind erasing, or use the Add or Insert button to 
select a blank position in the list. 

The initial system selected in the System From combo box must be 
in the same format as the position in the clipboard. 

Once you are ready to paste a position, do one of the following : 

- From the Edit menu, select Past Pos 

 or 

- Click the shortcut button    

 or 

- With the mouse right button, click in the Transformation list 
window. In the menu that pops up, select Past Pos. 
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Drag and Drop 
You can copy a position from a list window to the entry boxes of 
another list window using the Drag and Drop function as follows : 

- Arrange the two list windows so both are visible 
simultaneously. 

- Be sure the system selected for the entry boxes is in the 
same format as the position to be copied into them. 

- In the list window containing the position to be copied, click 
the anchor to the right of the System combo box specifying 
the system on which the position is expressed. 

- Hold down the mouse button. The mouse pointer should 
change to a "No Parking" traffic sign. 

- Move the mouse pointer to the entry boxes into which you 
wish to copy the position, until the mouse pointer changes 
to a + sighting pointer. 

- Release the mouse button. As a result the position is 
copied into the entry boxes. 

You open transformation list windows using the New or Open 
command in the File menu, or the New Window command in the 
Window menu. Note that copying a position into a transformation list 
will replace the position previously displayed in it. Use the scrollbar 
to select a position you do not mind erasing, or use the Add or Insert 
button to select a blank position in the list. 
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Performing coordinate transformations 
After you open the TRANSFO application, the TRANSFO main 
window displays with a transformation list window open in it. You can 
use each window's title bar and/or control menu to move and/or 
resize the windows. 

To convert a position from a coordinate system to another, do the 
following: 

- Select the initial coordinate system from the System From 
combo box. 

- Type or paste or drop the initial coordinates into the three 
'From' coordinates entry boxes. 

- Select the target coordinate system from the System To 
combo box. TRANSFO automatically computes the 
transformation and displays the transformed coordinates in 
the System To coordinate boxes. 

If you entered two or more positions into the System From boxes, 
use the scroll bar to browse through the list and view the desired 
position. 

 

Saving or copying positions 
You can copy the original or transformed position to another 
WINDOWS application, using the Copy Pos_From or Copy 
Pos_To command in the Edit menu. 

You can save a position list opened in the TRANSFO main window, 
using the Save or Save As command in the File menu. 
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Save (File menu) 
Use this command to save the active transformation list to its current 
name and directory. When you save a transformation list for the first 
time, TRANSFO displays the Save As dialog box so you can name 
your transformation list. If you want to change the name and 
directory of an existing transformation list before you save it, choose 
the Save As command. 

• Shortcuts 

 Toolbar:  

 Keys: CTRL+S 

 

Save As (File menu) 
Use this command to save and name the active transformation list. 
TRANSFO displays the Save As dialog box so you can name your 
transformation list.  

To save a transformation list with its existing name and directory, 
use the Save command. 

 

File Save As dialog box 
The following options allow you to specify the name and location of 
the file you're about to save: 

 Save in : Select the drive and directory in which you 
want to store the transformation list. Use 
the buttons to the right to move up in the 
directory tree (Up One Level button) and/or 
to create a new folder (Create New Folder 
button) if required. To select a directory, 
double-click the desired directory name in 
the Save In box. 
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 File Name : Type a new file name to save a 
transformation list with a different name. A 
filename can contain up to eight characters 
and an extension of up to three characters. 
TRANSFO adds the extension you specify 
in the Save As Type box. 

 

 Save as type : Select the type of file to which you want to 
store the transformation list: 

   Point list file (*.pts) 

   All file types 

 

Copy Pos_From (Edit menu) 
Use this command to copy the coordinates displayed in the "From" 
boxes onto the clipboard. This command is unavailable if there is no 
transformation list currently open. 

Copying data to the clipboard replaces the contents previously 
stored there. 

• Shortcuts 
 Mouse  Click in the list window with the right-hand 

button and select Copy Pos From in the 
menu that pops up.  

 Toolbar :  
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Copy Pos_To (Edit menu) 
Use this command to copy the coordinates displayed in the "To" 
boxes onto the clipboard. This command is unavailable if there is no 
transformation list currently open. 

Copying data to the clipboard replaces the contents previously 
stored there. 

• Shortcuts 
 Mouse  Click in the list window with the right-hand 

button and select Copy Pos To in the 
menu that pops up. 

 Toolbar :  

 

Opening a position list 
To open a position transformation list, use the New or Open or 1, 
2... (Recent File) command in the File menu or New command in 
the Window menu 

 

New (File menu) 
Use this command to create a new transformation list in TRANSFO. 

You can open an existing transformation list with the Open 
command. 

Use the Window menu to switch among the multiple open 
transformation lists.  Window 1, 2, ... command. 

 

• Shortcuts 

 Toolbar:  

 Keys: CTRL+N 
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Open (File menu) 
Use this command to open an existing transformation list in a new 
window. The following options allow you to specify which file to open: 

 Look in : Select the drive and directory in which 
TRANSFO stores the file that you want to 
open. Use the button to the right (Up One 
Level button) to move up in the directory 
tree if required. To select a directory, 
double-click the desired directory name in 
the Look In box. 

 File Name : Type or select the filename you want to 
open. This box lists files with the extension 
you select in the Files of Type box.  

 Files of Type : Select the type of file you want to open: 

   Point list file (*.pts) 

   All file types 

You can open multiple transformation lists at once. Use the Window 
menu to switch among the multiple open transformation lists. See 
Window 1, 2, ... command. 

You can create new transformation lists with the New command. 

 

• Shortcuts 

 Toolbar :  

 Keys : CTRL+O 
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1, 2, 3, 4 (File menu) 
Use the numbers and filenames listed at the bottom of the File menu 
to open one of the last four transformation lists you saved. Choose 
the number that corresponds with the transformation list you want to 
open. 

 

New (Window menu) 
Use this command to open a new window with the same contents as 
the active window. You can open multiple transformation list 
windows to display different parts or views of a transformation list at 
the same time. If you change the contents in one window, all other 
windows containing the same transformation list reflect those 
changes. When you open a new window, it becomes the active 
window and is displayed on top of all other open windows. 
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Importing/exporting positions 

Importing a points file 
• Import conditions 

- The format of the imported file must be compatible with the 
selection you make in the System From combo box. 
Transfo will only check the type of coordinates (geocentric, 
projected or geographic) provided in the file. If this 
requirement is not met, no point will be imported and an 
"Empty List" message will appear in the Transfo window. 

 As Transfo only checks the type of coordinates provided in 
the file, it is the user's responsibility to insure that the 
coordinates of the imported points are effectively 
expressed in the same system as the one specified in the 
System From field. 

- If the coordinates of the imported positions are expressed 
in two different ways (geographic + projected for example), 
then Transfo will import only the ones compatible with the 
selected input system (System From) 

- All parameters accompanying the coordinates of a point 
and not processed by Transfo will be kept unchanged as 
being part of the expression of the point.  

- If a position list is open when you import a file, Transfo will 
close the open list before showing the imported list. 

 

• Import procedure 
- From the Edit menu, select the Import Pos From 

command. A dialog box opens showing the content of the 
Points directory (typically points files in user format) 

- Select a file from this directory (or from another one) and 
click the Open button. A new dialog opens asking you to 
specify the type of user format under which this file was 
saved 
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- Select the format type and then click the Go button to start 
importing all the points contained in the file. Unless you 
have specified a wrong format, the Transfo window will 
then show the coordinates of the first of these points 
(expressed both in the selected input and output systems). 
The number of imported points appears on top of the 
vertical scroll bar. 

 

Exporting positions to a file 
• Export conditions 

- The format of the file resulting from an export operation 
must be compatible with the selection you made in the 
System To combo box (same type of coordinates: 
geocentric, projected or geographic). If this requirement is 
not met, no point will be exported. 

- All parameters accompanying the coordinates of a 
previously imported point and not processed by Transfo 
will be exported unchanged.  

 

• Export procedure 
- From the Edit menu, select the Export Pos To command. 

A dialog box opens showing the content of the Points 
directory 

- In the File Name text box, specify a name for the file to be 
exported (extension is "usr" by default) and then click the 
Save button. A new dialog opens asking you to specify the 
type of user format under which the file should be saved. 

- Select a format type compatible with the System To 
selection and then click the Go button to run the export 
operation. 
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Accessing the Transformation Parameters 
If you wish to view and/or modify the parameters TRANSFO uses 
when it takes coordinates from a system to another, click in the 
transformation list window with the right button of the mouse, and 
select the desired command in the menu that pops up. 

The list of commands available in the pop-up menu varies 
depending on the window which you click in with the mouse right 
button: 

 

 

(After 
clicking in 
the list 
window) 

 

(After clicking 
in the 
coordinate 
system 
parameter 
window) 

 
(After 
clicking in 
the Datum 
parameter 
window) 

  

 

Terminology: 

Datum You generate a Datum when you take an ellipsoid and 
move its center so the ellipsoid matches the geoid very closely 
in your area of interest. For example in Europe the ED50 
(European Datum 1950) results from taking the International 
ellipsoid and shifting it so it fits the geoid in Europe. 

Ellipsoid: An ellipse which has been rotated about an axis, 
providing a mathematical surface approximating the surface of 
the geoid. The shape of the ellipsoid is chosen to match the 
geoidal surface as closely as possible. 
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Geoid: An equipotential surface (meaning that the pull of 
gravity is equal everywhere on the surface) which influences 
measurements and satellite orbits. It approximately 
corresponds to the mean sea level. A plumb bob always 
points perpendicular to the geoid, not to the center of the 
earth. 

Geocenter: Center of an Ellipsoid. 

Projection: A projection is a representation of a 3-
dimensional surface (a portion of an ellipsoid) on a 2-
dimensional plane. In order to make a section of an ellipsoid 
into a flat surface, you have to stretch some parts of the 
surface and compress other parts. The amount of 
stretching/compressing is described by a point scale factor. 

For example, UTM (Universal Transverse Mercator) is a 
cylindrical projection which divides the world into 6° zones of 
longitude. The central meridian runs through the centre of 
each zone. UTM is good from 80°N to 80°S but has huge 
distortion about the poles. 

 

 

• Edit System From 
 

Use this command to display the parameters of the coordinate 
system selected in the System From combo box. 

 

• Edit System To 
 

Use this command to display the parameters of the coordinate 
system selected in the System To combo box. 
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The parameters TRANSFO uses when it takes a position from a 
coordinate system to another are contained in the database. In the 
database a coordinate system is defined by: 

 a system name 
 a Projection kind 
 a Datum 
 a Unit 
 Labels 
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• New datum 
Use this command to create a new Datum and save it to the 
database. In the database a Datum is defined by : 

- a Name 

- an Ellipsoid 

- plus seven parameters : 

 DX Distance between ellipsoid geocenters 

 DY Distance between ellipsoid geocenters 

 DZ Distance between ellipsoid geocenters 

 k Change in scale between geodetic systems 

 Rx Rotational change about the X axis 

 Ry Rotational change about the Y axis 

 Rz Rotational change about the Z axis 
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• New ellipsoid 
Use this command to create a new 
Ellipsoid and save it to the 
database. 
In the database, ellipsoids are 
defined by : 
- a Name 
- the semi-major axis 
- the inverse flattening 

 
• New unit 
Use this command to create a new 
Unit and save it to the database. The 
parameters of each coordinate system 
are expressed in one of the units 
selectable from the database, for 
example : 
- Borneo Chain 
- Imperial Foot 
- Meter 
- US foot  
• New label 
Use this command to create a new Label 
and save it to the database.  
You can customize the labels you wish to 
appear ahead of the coordinate boxes in 
your transformation list windows and 
printouts, for each type of coordinates 
selectable from the database. 
Examples : 
- X, Y, Z for a Geocentric coordinate system
- Lat, Lon, Alt for a Lat-Long coordinate 
system 

 

- North, East, Height for a Projection 
coordinate system 
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Menus and Commands 

File menu  
The File menu offers the following commands: 

 New : Creates a new transformation list. 

 Open : Opens an existing transformation list. 

 Close : Closes an opened transformation list. 

 Save : Saves an opened transformation list using 
the same file name. 

 Save As : Saves an opened transformation list to a 
specified file name. 

 Print : Prints a transformation list. 

 Print Preview : Displays the transformation list on the 
screen as it would appear printed. 

 Print Setup : Selects a printer and printer connection. 

 1, 2, 3...(Recent File) : Opens one of the last four lists you saved. 

 Exit : Exits TRANSFO. 

 

Edit menu  
The Edit menu offers the following commands: 

 Copy Pos_From : Copies coordinates from the "From" boxes 
to the clipboard. 

 Copy Pos_To : Copies coordinates from the "To" boxes to 
the clipboard. 

 Paste Pos : Pastes coordinates from the clipboard into 
the transformation list. 
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 Import Pos From : Imports a list of positions from a points file 
in User format 

 Export Pos To : Exports a list of positions to a points file in 
User format. 

 Delete All : Deletes all points contained in the active 
transformation list. 

The Edit menu is unavailable if there is no transformation list open. 

 

 

View menu  
The View menu offers the following commands: 

 Toolbar : Shows or hides the toolbar 

 Status Bar : Shows or hides the status bar. 

 

Window menu  
The Window menu offers the following commands, which enable you 
to arrange multiple views of multiple transformation lists in the 
application window: 

 New Window : Creates a new window that views the 
same transformation list. 

 Cascade : Arranges windows in an overlapped 
fashion. 

 Tile : Arranges windows in non-overlapped tiles. 

 Arrange Icons : Arranges icons of closed windows. 

 List 1, 2, . : Goes to specified window. 
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Help menu  
The Help menu offers the following commands, which provide you 
assistance with this application:  

 Index : Displays the opening screen of Help. 

 Using Help : Displays instructions for using Help 

 About TRANSFO : Displays the version number of this 
application. ♣  
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  11. WinComm Module 

Introduction 
WinComm is a communication software package for DSNP GPS 
receivers. It features the following main functions : 

- Automatic search for the communication Baud rate (on 
operator's request, only with DSNP receivers).  

- Identification of the DSNP GPS receiver connected (on 
operator's request, only with DSNP receivers). 

- Viewing the data stream on the serial port. 
- Sending commands to a GPS receiver. 
- Manual request for recording data from a GPS receiver. 
- Programmable requests for recording data from a GPS 

receiver. 
- Reading from a GPS receiver's data memory. 
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Enabling communications with a GPS 
receiver 
After you start WinComm or click the Settings push-button in the 
WinComm main window, a dialog box (titled Communication 
Settings) shows up that allows you to view and change the serial port 
parameters of your computer and enable communications with the 
GPS receiver connected to it. 

 

  
You can save your customary communications settings to a 
configuration file (using the Save Settings button) and specify the 
configuration file name in the command line of any shortcut created 
to start WinComm. As a result the configuration file will automatically 
be loaded and enabled when you double-click the WinComm icon to 
start WinComm (in that case the Communication Settings dialog box 
will not be prompted). 

Use the combo boxes to set the communication parameters. The 
parameters are preset to default values. Select the desired port 
("Comm" parameter, that is the computer port connected to the 
desired GPS receiver) and the appropriate serial communication 
parameters (Baud Rate, etc.) to match those of the receiver. 
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With DSNP receivers, the Baud rate will be adjusted automatically 
if you use the Auto Configure push-button. 

 
OK 
 Clicking the OK button activates the current serial port parameter 
settings and closes the Communication Settings dialog box. This 
enables communications between the computer and the GPS 
receiver, unless the serial port parameter settings do not match 
those of the receiver connected. 

 

Cancel 
Clicking the Cancel button closes the Communication Settings 
dialog box. Any changes you made in the Communication 
Settings dialog box are ignored. 

 

Auto Configure 
Auto Configure initiates an automatic search for the Baud rate 
and receiver type. Use this push-button if you are not sure about 
the Baud rate or if you wish to view the type of the receiver 
connected. 

An automatic search for the Baud rate and receiver type is only 
allowed with DSNP receivers as this requires that the receiver be 
capable of returning a consistent reply to a "TEST 1" or "IDENT" 
command. 
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After choosing "Auto Configure" you are allowed to : 

- disable the communication by clicking "Cancel" , 
- or, if the identification is successful, close the 

Communication Setting dialog box, by clicking "OK". This 
enables communications between the computer and the 
GPS receiver and allows you to use any of the functions of 
WinComm. 

 

Receiver Type 
After a communication is successfully established (e. g. using the 
Auto Configure push-button), the identification of the connected 
receiver appears in this box. 

The example below results from a communication established with a 
DSNP receiver. 

 
After the Communication Settings dialog box is closed, you can ask 
for the receiver type by sending the TEST 1 or IDENT command to 
the connected receiver, using the Command pane. 
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Load settings 
 Load settings  opens a dialog box that allows you to select any 
serial port configuration file saved earlier using the Save Settings 
push-button. 

Click the desired file name in the list box, to select it (typically in 
the 'set' directory), and click Open. As a result the serial port 
parameters in the Communication Settings dialog box are 
automatically set as specified in the file you selected. 

(Clicking Cancel takes you back to the Communication Settings 
dialog box without loading any settings). 

 
Save settings 
Save settings  opens a dialog box that allows you to save the 
serial port configuration currently enabled so that you can quickly 
retrieve it at a later date using the Load Settings push-button. It 
can be loaded automatically if you specify its name in the 
command line of any shortcut icon created to start Wincomm. 

In the File Name text box, enter a name (e.g. the type of the 
receiver connected) for the file to which the serial port 
configuration should be saved (typically with '.set' as extension). 
Typically, serial port configuration parameters are saved to the 
'set' directory. 
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Clicking the Save push-button saves the following communication 
parameters  

- serial port No. 
- Baud rate 
- number of bits per character 
- parity check option 
- number of stop bits 

(Clicking Cancel takes you back to the Communication Settings 
dialog box without saving any settings). 

 

System menu 
- In the left corner of the WinComm window's title bar, click 

on the connector icon. The system menu appears from 
which you can define the options below. 
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 All Commands Uppercase : Unless you are satisfied with the 
current setting, select this command 
to toggle the setting. 

   Checked: lower-case characters in 
the command are changed to upper-
case characters before being sent to 
the receiver 

   Cleared: characters, whether lower-
case or upper-case, are sent 
unchanged. 

 

 No Internal Memory : Unless you are satisfied with the 
current setting, select this command 
to toggle the setting. 

   Checked: there is no internal 
memory in the attached receiver 
(Internal Memory Reader option 
disappears from the Win Comm 
window) 

   Cleared: there is an internal memory 
in the attached receiver (Internal 
Memory Reader option available in 
the Win Comm window). 
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 Display pane / window 
After communication is enabled between the computer and a GPS 
receiver the Display pane allows you to view the data stream on the 
receiver port, including data output in response to any command 
generated by Wincomm. 

If you wish to enlarge the Display pane, click  in this pane (top 
right). This causes the pane to be transformed into a separate 
window which you can move/re-size using the usual commands 
assigned to windows in the Windows95 environment. To restore the 
Display pane at the initial location, click  or  (top right). 

 

 
As the data may be refreshed every 0.1 seconds, it is not possible to 
log all that is relayed through the port so that it can be displayed at a 
later date, or this would require a huge memory size. For that 
reason, only the latest 100 data lines are stored and can be viewed 
using the vertical scroll bar available. 
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Each data line ends with a CR LF code and/or when it reaches the 
maximum length (80 characters). 

 
 Clear View : Clicking the Clear View push-button 

deletes any data displayed in the Display 
pane / window. 

 Print View : Clicking the Print View push-button opens 
a Print dialog box that allows you to print 
any data displayed in the Display pane / 
window. 

 Pause : Freezes the display pane and changes the 
label of the button to Resume. 

   Pressing the Pause button does not 
suspend the data flow on the receiver port 
or the recording in progress. 

   Pressing this button again (now changed 
to a Resume button) will re-activate the 
Display pane. 
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 Sending a Command to a GPS receiver 
After communication is enabled between the computer and a GPS 
receiver, the Command pane can be used to send commands to the 
receiver (label of selected command group recalled in the command 
pane, see below). 

 

 

To send a command, do the following: 

- Type the command in the Command combo box or select 
it from the Command or Label combo box. 

- Click the Send push-button. 

The list of commands prompted in the Label combo box can be 
changed using the Advanced push-button. 

 

 Commands editor dialog box 
This dialog box (appearing after you click the Advanced button) 
allows you to set up a group of commands interpretable by the 
connected receiver. The commands you select in this dialog box will 
be prompted in the main window. (As a result, you will only need to 
choose the desired command from the list in the main window and 
click to send the command to the connected receiver). 

After you install WinComm, a number of default command groups 
are available on your computer. Each command group is contained 
in a file whose name is the Group Label (see this parameter in the 
next page), with .cmd as extension. 

Command combo box 

Label combo box
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The buttons in the Commands Editor dialog box allow you to load 
any command-group file available, make any change to the group 
and save your own command groups. 

The selected command group will be available in the main window 
after you close the Commands Editor dialog box (by clicking in the 
upper-right corner). 

 
 

 Group Label : Text box used to enter and/or view the 
name given to a command group. For 
example, this name can suggest the type 
of receiver connected when this command 
group should be used. 

 Command : Text box used to enter and/or view each 
command script. Use the associated 
scrollbar to browse through the list of 
available commands. 

 Label : Text box used to enter and/or view a plain 
label for each command script. Use the 
associated scrollbar to browse through the 
list of available commands. 

Click here to close the 
Commands Editor 
dialog box. This loads 
the selected 
command group to the 
main window. 
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 Add command : Adds the command viewed in the text box 
to the list of available commands. 

 Delete command : Removes the command viewed in the text 
box from the list of available commands. 

 Load commands : Opens a dialog box that allows you to 
choose the appropriate command group 
file for the connected receiver so that the 
command group becomes available in the 
main window after you close the 
Commands Editor dialog box. 

 Save commands : Opens a dialog box that allows you to save 
your own command group (as viewed in 
the Commands Editor dialog box). 
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 Simple GPS recorder 
All data output from the receiver's port is viewed in the main 
window's Display pane / window. The data can be recorded to the 
file specified in the File Name and Directory text boxes. 

When the Simple GPS Recorder option is activated, you start and 
stop the recording manually, by simply clicking the Start/Stop 
Recording push-button. 

 
 File Name : The File Name text box is used to specify 

the name of the file to which you wish to 
record the data from the receiver. 

   Unless a maximum size is selected for the 
file, you are also allowed to enter an 
extension into the associated box. 

 File Max Size : The File Max Size option box is used to 
specify whether a single file should be 
created on the disk (No Limits option) or 
the file should be split into 0.7 MB or 1.4 
MB segments (with a view to storing it to 
floppy disks). 
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   If you elect to split the file into segments, 
then the system will automatically add 001 
as extension to the name of the first 
segment. This will automatically be 
incremented for each file segment 
generated, if the file exceeds the File Max 
Size selected. 

 Start Recording : Clicking the Start Recording button causes 
the data to be recorded to the specified file 
until you click the button again. (The label 
of the button changes from Start 
Recording to Stop Recording). 
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Programmable GPS recorder 
The Programmable GPS Recorder option allows you to prepare one 
or more requests for recording the data output on the connected 
receiver port, by specifying a start date, time and duration for each 
planned recording session, and also a disk file name, directory and 
maximum size. 

You can save the recording session requests you prepare (using the 
Save button) so that you can load them back at a later date (using 
the Load button). 

 

 
 
 Directory : The Directory text box is used to specify 

the directory to which you wish to record 
the data from the receiver. Clicking the 
button to the right opens a dialog box that 
allows you to navigate through the 
directory tree on your hard disk or a floppy 
disk, and select the desired destination 
directory. 
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 File Name : The File Name text box is used to specify 
the name of the file to which you wish to 
record the data from the receiver. 

   - If you choose the Automatic File Name 
option (i. e. if the option box is checked), 
then the File Name text box is dimmed and 
the name is automatically assigned by the 
system, based on the date (month, day 
number) and time (hour, minute) of the 
recording session. Example: 12240929 for 
a file recorded on December 24 at 9:29 a. 
m. 

   - If you do not select the Automatic File 
Name option, then you can enter a name 
of your own. Unless a maximum size is 
selected for the file, you are also allowed 
to enter an extension into the associated 
box. 

 File Max Size : The File Max Size option box is used to 
specify whether a single file should be 
created on the disk (No Limits option) or 
the file should be split into 0.7 MB or 1.4 
MB segments (with a view to storing it to 
floppy disks). 

   If you elect to split the file into segments, 
then the system will automatically add 001 
as extension to the name of the first 
segment. This will automatically be 
incremented for each file segment 
generated, if the file exceeds the File Max 
Size selected. 
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 Start Date : The Start Date text box is used to specify 
the day on which the recording session 
should begin. The current date is prompted 
by default. 

 Start Time : The Start Time text box is used to specify 
the time when the recording session 
should begin. The current time is prompted 
by default. 

 Duration : The Duration text box is used to specify 
the planned duration of the recording 
session. 

 Automatic File Name : If you choose the Automatic File Name 
option (i. e. if the option box is checked), 
then the File Name text box is dimmed and 
the name is automatically assigned by the 
system, based on the date (month, day 
number) and time (hour, minute) of the 
recording session. Example: 12240929 for 
a file recorded on December 24 at 9:29 a. 
m. 

   If you do not select the Automatic File 
Name option, then you can enter a name 
of your own. Unless a maximum size is 
selected for the file, you are also allowed 
to enter an extension. 
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 Add Request : The Add Request button saves the 
recording session description currently 
displayed and increments the number of 
programmed sessions that appears at the 
bottom of the scrollbar. (This automatically 
selects the Automatic File Name option 
and prompts the next possible session, 
considering the specified Duration). 

 Delete Request : The Delete Request button deletes the 
recording session description currently 
displayed and decrements the number of 
programmed sessions that appears at the 
bottom of the scrollbar. 

 Run Program : The Run Program button activates the 
Programmable GPS Recorder mode. This 
causes WinComm to wait for the next 
scheduled recording session and perform 
recording as planned. The label of the 
button changes from Run Program to Stop 
Program. Until the planned recording is 
complete or you click Stop Program, all 
other buttons in the Programmable GPS 
Recorder pane are inhibited and you 
cannot change to another Mode. 

 Load Program : The Load Program button opens a dialog 
box that allows you to select a file (typically 
a .pgm file) containing descriptions of 
planned recording sessions (saved earlier 
using the Save Program button). Select 
the desired file  name and click Open. 
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 Save Program : The Save Program button opens a dialog 
box that allows you to save descriptions of 
planned recording sessions so that they 
can be used at a later date (using the Load 
Program button). Enter a name into the 
File Name text box and click Save. 

 Print Program : The Print Program button opens a Print 
dialog box that allows you to print the 
descriptions of planned recording sessions 
currently loaded. 

 

Reading from a GPS receiver's memory 
After communication is enabled with a receiver, the Internal 
Memory Reader option allows you to view the contents of its data 
memory and choose one or all of its data files to copy them to a 
disk file. 

 

Click here to select the 
desired directory. 
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 Transfer : The Transfer text box displays the 
identification of the data record session 
that will be read from the receiver's 
memory when you click the Transfer 
Current button. If two or more sessions are 
available in the receiver, use the scrollbar 
to the right to select the desired session. 

   All data record sessions contained in the 
receiver's memory are listed in the Display 
pane to the left. 

 Directory : The Directory text box is used to specify 
the directory to which you wish to record 
the data read from the receiver's internal 
memory. Clicking the button to the right 
opens a dialog box that allows you to 
navigate through the directory tree on your 
hard disk or a floppy disk, and select the 
desired destination directory. 

 File Name : The File Name text box is used to specify 
the name of the file to which you wish to 
record the data read from the receiver's 
internal memory. 

   If you select No Limits as File Max Size 
option, then you are allowed to specify an 
extension to the file name in the 
associated text box. (You may choose an 
extension that reflects the type of data to 
be recorded to the file , e. g. RAW for raw 
data). 
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   If you select 0.7 MB or 1.4 MB as File Max 
Size option, then the system will 
automatically add 001 as extension. This 
will automatically be incremented for each 
file segment generated, if the file exceeds 
the Max File Size selected. 

 File Max Size : The File Max Size option box is used to 
specify whether a single file should be 
created on the disk (No Limits option) or 
the file should be split into 0.7 MB or 1.4 
MB segments (with a view to storing it to 
floppy disks). 

   If you elect to split the file into segments, 
then the system will automatically add 001 
as extension to the name of the first 
segment. This will automatically be 
incremented for each file segment 
generated, if the file exceeds the File Max 
Size selected. 

 Transfer Current : Clicking the Transfer Current button reads 
the record session selected in the Transfer 
text box from the receiver's memory and 
saves it to the file specified in the File 
Name and Directory text boxes. 

   If you fail to enter a file name, then the 
system will automatically create a disk file 
named Memory1 if you are reading the first 
session, or Memory2 for the second 
session, etc. 
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 Transfer All : Clicking the Transfer All button reads each 
record session from the receiver's memory 
and saves it to the associated file specified 
in the File Name and Directory text boxes. 

   If you fail to enter a file name the system 
will automatically save the first session to a 
disk file named Memory1, the second 
session to a disk file named Memory2, an 
so on... 

 

WinComm Shortcut 
You can save your customary communications settings to a 
configuration file and specify the configuration file name in the 
command line of any shortcut created to start WinComm. As a result 
the configuration file will automatically be loaded and enabled when 
you double-click the WinComm icon to start WinComm (in that case 
the Communication Settings dialog box will not be prompted). 

To create a WinComm shortcut icon that will automatically load one 
of your customary communications configuration files, do the 
following: 

- With the mouse right button, click outside any window in 
the workspace. From the menu that pops up, select New 
then Shortcut. This opens the Create Shortcut dialog box. 

- Click the Browse button. This opens a dialog box that 
prompts all the directories existing on your disk. Open (by 
double-clicking) the directory containing WinComm. 
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- Click WinComm.exe and click the Open button (or simply 
double-click WinComm.exe). This closes the Browse 
dialog box and automatically enters WinComm.exe (with 
its path) into the Command line text box in the Create 
Shortcut dialog box. 

- In the Command line text box, enter the name of your 
configuration file after WinComm.exe, with a space in 
between. 

- Click the Next button. Enter a name for your shortcut icon. 
Click the Finish button. This closes the Create Shortcut 
dialog box. 

As a result, a new WinComm icon appears in the workspace, with 
the name you specified. 

 
♣  
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  12. KISS Module 

Preamble 

Introduction 
- KISS comes as one of the optional modules of 3SPack. It 

is required in those land surveys where Scorpio 6x0x MK 
mobiles and 6x0x SK base stations are used. This series 
of equipment is specifically designed to operate in the 
DSNP LRK® real-time & long-range processing method. 

- KISS is used at the beginning of a survey to prepare field 
operations. First you will have to choose a coordinate 
system. 

- KISS will then provide a view of your work area. It is a good 
idea to have the map of this area scanned and the 
resulting bitmap file moved to the 3SPack Supervisor 
database (Maps object). This will give you the ability to 
show/hide the details of the area. 

- In the next stage, KISS will let you transfer jobs to PC 
cards (600x) or to rover palmtops (6x0x). 

- After field operations, KISS will be used to retrieve the 
results of the jobs performed in the field. At this stage, the 
Quick Info window will be very useful to read at a glance 
the interesting results of the survey. 

- If raw data was recorded during the survey at the station 
and the rover (this is an option in the 650x-to 630x series), 
KISS will allow you to transfer this data to 3SPack, or to 
any other Post-processing software, so that you can 
compare the real-time results against those obtained using 
a post-processing method. 

- A number of import/export functions are available in 
different formats (DXF, User). Points and results can easily 
be exchanged with the 3SPack database. 
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Terminology used 
In this section, the term �target� is used in two different contexts: 

1. To designate a point whose location is known in theory and 
which has to be materialized in the field. In this case the 
term �target� is always associated with the term �point� 

2. To designate the supposed (or planned) position of any 
point, whether a target point or a reference point. In this 
case, the term �target� is used alone. The main contexts in 
which �target� appears with this meaning are: 

- In the General tab of any dialog box describing a 
reference point 

- In the General tab of any dialog box describing a 
target point 

- In the Edit menu, Import Target and Export Target 
commands 

 
Key words 
 

 Reference points : Precisely known points previously materialized in 
the field. 

 Target points : Points whose locations are known in theory and 
which have to be materialized in the field (staking 
out) 

 Planned points : Points specified in a job file to be surveyed by a 
field operator. There are two types of planned 
points: reference points and target points. 

 Logged points : In contrast with planned points, logged points are 
unplanned points. Any time, field operators can 
log the position of a point, give a name to this 
point and save it in the results file. 



KISS Module 
Preamble 

DSNP 12-3 

 Offset procedure : Special procedure through which a planned or 
logged point can be surveyed whereas the GPS 
cannot be received properly at the desired 
location. In this case the location of the desired 
point will be deduced: 

- from two properly surveyed points P1 and 
P2 located nearby and forming either a 
triangle or a line with the desired point. 
Triangle � lateral offset; line � linear offset 

- or from two pairs of properly surveyed points 
P1-P2 and P3-P4 located nearby and 
forming two lines whose intersection 
provides the location of the desired point 
(�intersection� offset) 
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Graphic conventions used for points 
The color of any icon changes when you select it with the mouse 
pointer: 

 Selected : icon green, point name with dark-blue 
background 

 Deselected : icon dark-blue, point name with yellow 
background 

 

 

• Before surveying 
 Target points: Reference points: 

       
 
 
 

 
• After surveying 

 
- With known horizontal system: 

 Logged Target Reference 
 points: points: points: 

      
 Within Outside 
 acceptable  acceptable  
 deviation deviation  
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- With unknown horizontal system : 
 Logged Target Reference 
 points: points: points: 

     
 

 The horizontal system may still be unknown at the end of a 
survey either because the operator did not let the rover unit 
determine a suitable one from the specified reference 
points, or merely because the rover unit was unable to find 
one. In this case, note that all logged points will be grouped 
under the same icon in the top-right corner of the map as 
KISS will not be able to locate them on the map. On the 
other hand, reference and target points will be placed on 
the map at their planned locations. 

 

- Other cases where some reference points may be involved 
in the following computations. These points will be 
represented as follows after you validate the results of the 
computation: 

 After computing After computing After computing 
 datum shifts: local grid: vertical correction: 
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Project file structure 
If you create a project called �EDC�, then this project will be 
represented as shown below, beside the Project Wizard icon in the 
Projects window. The following folder and file are then present in the 
KIS directory. 

  

Later, the EDC folder will be completed with results files 
(<job>.RES), and possibly raw data files if during jobs, recording 
sessions were performed. 

While working on a project, you may need to create QRY files. This 
type of file, which contains a number of criteria used to select points, 
is invoked when using the �Select Where � function. By default, QRY 
files are saved in the KIS directory: 

 



KISS Module 
Using KISS before field surveying 

DSNP 12-7 

Using KISS before field surveying 

Creating a new project 

1. In the tool bar, click    or from the menu bar, select File 
and then New or double-click on the following icon in the 
Projects window: 

 
2. Start defining your project by completing the Project 

Wizard-Welcome Dialog Box which then appears:  
 Project Enter the project name 
 Region Enter the region name (optional) 
 Center Easting Enter the easting of the center point 
 Center Northing Enter the northing of the center point 
 Scale Choose a pre-defined value from the combo box or 

type another value in the text box 
 Distances in Choose the distance unit from this combo box (meters, 

US feet or imperial feet) 
 Angles In Choose the angle unit from this combo box (degrees or 

grades) 
 Notes text box Add comments or recommendations of any kind which 

you want to associate to this project (optional). 

3. Then, click the Next> button. 

4. Complete the Project Wizard-Horizontal System Dialog 
Box which then appears. This tab allows you to define the 
horizontal coordinate system which you would like to use 
for your survey. In usual cases, you just have to select a 
projection from the Projection combo box, which lists all 
the projections available from the 3SPack database. 
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 If you do not know which projection should be used, select 
<Unknown> in the PROJECTION combo box. As a result, 
KISS will also set the ON DATUM combo box to 
<Unknown>. You can however change this setting if you 
know the datum. The inverse statement is also possible: 
you can choose a projection and leave the datum 
�<Unknown>�. 

 As you can see, all the combinations are possible. 
However the most typical ones remain �projection and 
datum known� or �projection and datum unknown�. 

 When you select a projection or datum, in fact you load it 
from the 3SPack database. All the parameters of this 
projection or datum then appear in the dialog box. 

 If necessary, you can adjust the values of some of these 
parameters. If you do so, we recommend you to change 
the name of the projection or datum as well (the 
PROJECTION and ON DATUM combo boxes are also 
editable fields). In this way, you will never forget that you 
derived your horizontal coordinate system from a standard 
one. WARNING! This new system will be stored in your 
project only, not in the 3SPack database. 

 

 NOTE: The Project Properties dialog box includes a 
pop-up menu (right mouse button) accessible from the 
Horizontal System and Vertical System tabs. This menu 
contains the following commands:  

 Copy Copies the system parameters to the clipboard (binary 
& ASCII formats) 

 Paste Pastes the system parameters from the clipboard 
(binary format) 

 Save Saves the system parameters as a file (binary format) 
 Load Loads the system parameters from a file (binary 

format) 
 Update 3SPack Database Transfers the horizontal system to the 3SPack 

database 
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 The different parameters of projections and datums shown 
in this tab are described below. 

 PROJECTION Combo box listing the projections stored in the 3Spack 
database. Select the name of the projection used. As a 
result, the rest of the dialog box is updated to match 
your selection. This combo box is also an editable text 
box (see above) 

 Proj Kind From this combo box, select the kind of 
projection used. Generally this selection is 
correct after you choose the PROJECTION 
name (above) 

 False East. Easting of projection center 
 False North. Northing of projection center 
 Central Merid. Longitude of projection center 
 Central Lat. Latitude of projection center (except for 2P 

Lambert) 
 Scale Scale factor (except for 2P Lambert) 
 North Lat. Latitude of 1st parallel (for 2P Lambert only) 
 Ref. Lat. Latitude of projection center (for 2P Lambert 

only) 
 South Lat. Latitude of 2nd parallel (for 2P Lambert only) 
 Skew Azimuth of initial line (for Rect Skew Ortho and 

Skew Ortho only) 
 ON DATUM Combo box listing the datums stored in the 3Spack 

database. Select the name of the datum used. As a 
result, the rest of the dialog box is updated to match 
your selection. This combo box is also an editable text 
box (see above) 

 K Scale factor 
 Dx X deviation from ellipsoid (signed value in m) 
 Dy Y deviation from ellipsoid (signed value in m) 
 Dz Z deviation from ellipsoid (signed value in m) 
 A Semi-major axis of the ellipsoid, in m 
 1 / F Inverse flattening coefficient (ellipsoid) 
 Rx Angular deviation around X axis of ellipsoid (in 

seconds) 
 Ry Angular deviation around Y axis of ellipsoid (in 

seconds) 
 Rz Angular deviation around Z axis of ellipsoid (in 

seconds) 
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 The lower part of the Horizontal System Dialog Box 
allows you to specify the characteristics of the local grid, if 
you use one in your project (see instructions below). 

 WITH LOCAL GRID 
 check button Button cleared: no local grid 
   Button checked: enter the parameters of the local grid: 
 E0 Easting of origin 
 N0 Northing of origin 
 K Scale factor 
 DE Easting shift 
 DN Northing shift 
 Beta Rotation angle 

 

 See also Choosing the appropriate coordinate system, 
page 12-41. 

5. Then, click the Next> button. 

6. Complete the Project Wizard-Vertical System Dialog Box 
which then appears. In this box, tell KISS whether the 
altitude of the surveyed points should be expressed in 
relation to a geoid or a datum (WGS84, or the one 
selected for the project).See below: 

 HEIGHT EXPRESSED ON Choose the reference upon which the altitudes of the 
surveyed points will be determined. 

   If you click the GEOID radio button, then the reference 
can be the ICD200 model or any local model available 
on your system (RAF98, EGM96, etc.; this may be the 
complete model or just an excerpt corresponding to the 
area where you have to work). 

   If you click the DATUM radio button, then the reference 
can be either the datum used in the horizontal system, 
or the WGS84 (selection in same combo box nearby) 
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 WITH LOCAL 
 CORRECTION... check button Check this button if corrections have to be made to the 

selected reference (otherwise keep it cleared): 
 dH Vertical deviation between vertical system and 

WGS84 at the origin 
 Gl Latitude gain (a coefficient) 
 Gg Longitude gain (a coefficient) 
 L0 Latitude of the origin 
 G0 Longitude of the origin 

 

 See also Choosing the appropriate coordinate system, 
page 12-41. 

 Before you end the definition of the project, you can still go 
back to the previous tabs by clicking the <Back button if 
changes have to be made in these tabs. Then use the 
Next> button again until the Finish button appears. 

7. Once you agree with the definition of the project, click the 
Finish button. KISS then creates the new project. A map 
of the region of survey appears in the KISS window. In the 
same time, the project is saved in the KIS directory. 

 

 NOTE: The Project Properties dialog box includes a 
pop-up menu (right mouse button) accessible from the 
Horizontal System and Vertical System tabs. This menu 
contains the following commands:  

 Copy Copies the system parameters to the clipboard (binary 
& ASCII formats) 

 Paste Pastes the system parameters from the clipboard 
(binary format) 

 Save Saves the system parameters as a file (binary format) 
 Load Loads the system parameters from a file (binary 

format) 
 Update 3SPack Database Transfers the horizontal system to the 3SPack 

database 
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 Changing the properties of a project 
The properties of a project are the set of parameters that you 
defined when you created it. These parameters are arranged in 
three distinct tabs: 

- General tab  

- Horizontal System tab  

- Vertical System tab  

Once a project is created, you can still change some of its 
properties. 

To change the properties of a project, use one of the following 
procedures: 

- With the project open in the KISS window, with no point 
selected and whatever the pointer shape, position the 
pointer anywhere within the project window and click with 
the right-mouse button. In the shortcut menu which then 
appears, select Properties. 

- With the project open in the KISS window, with no point 
selected and whatever the pointer shape, from the menu 
bar, select Edit and then Properties 

- From the Projects window, position the pointer on the icon 
of the project and click with the right-mouse button. In the 
shortcut menu which then appears, select Properties. If 
the project is currently open, you can change any property 
(except the project name). If it is currently close, you can 
only change the properties on the General tab (except the 
project name). 

 
 WARNING! As long as there is no results available for a 

project, there is no harm in changing a project�s properties. 
This is no longer true when a project contains results. In 
this case, a warning message will appear informing you of 
the consequences whenever you try to validate a change 
made to any of the project�s properties. 
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Changing the project name  
- Position the mouse on the icon of the project you want to 

rename 

- Click the right mouse button and, from the shortcut menu 
which then appears, select Rename 

- Type the new name and press ENTER. 

 

Placing target points on the map 
After creating a project, target points can be placed directly on the 
map of the project. 

- In the toolbar, click  or from the Draw menu, select the 
Target Points command. 

- Position the mouse pointer (now a ) where you want to 
create a new target point. In the right-lower part of the 
KISS window, the status bar helps you locate the point 
accurately on the map by giving the current coordinates of 
the mouse pointer as you move it within the window: 

 

 
- When the mouse pointer is at the desired location, click 

with the left mouse button. This causes a new Target Point 
icon to appear on the map. 

 
- Position the mouse pointer where you want to create a 

second target point and click again, etc. To stop creating 
target points, click any other button in the toolbar. 
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Editing the properties of a target point before field 
operations  

- Click   

- Double-click on the icon corresponding to the target point 
you want to edit. A dialog box appears showing the 
properties of the target point. At this stage, the dialog box 
consists of a single tab (General). 

 Name Keep the default name of the target point or type 
another name 

 Code 1... code 4 Optional. Enter or select a geocode from each of these 
combo boxes. The list of available geocodes is the one 
you can define from the KISS Options dialog box, 
General tab  

   Note that if you place the pointer on the down-arrow of 
any of these combo boxes, the meaning of the 
selected geocode will appear in a tip box. 

 Target/Result/Error 
 radio buttons At this stage, only the Target radio button can be 

checked as the field survey is still to come  
 E N H check buttons They define the type of the target point. Two types are 

possible: 
 . 2D point: Simply obtained by clearing the H 

button. 
 . 3D point: Simply obtained by checking the H 

button. 
 E N H text boxes Planned coordinates of the target point resulting from 

where you clicked on the map. If you change E or N, 
the icon will appear at a location different from where 
you clicked. Any change in these boxes should be 
consistent with the type of point (2D, 3D) you choose 
(see E N H check buttons just above). 

 Notes pane:  Add comments or recommendations of any kind which 
you want to associate to this point (optional). 

 �Target� diagram 
 (on right) The �target� (planned location) is shown at the center 

of an oriented circle whose radius is the Acceptable 
deviation between target and surveyed coordinates 
defined in the General tab of the KISS options 
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Placing reference points on the map 
After creating a project, reference points can be placed directly on 
the map of the project. 

- In the toolbar, click  or from the Draw menu, select the 
Reference Points command. 

- Position the mouse pointer (now a ) where you want to 
create a new reference point. In the right-lower part of the 
KISS window, the status bar helps you locate the point 
accurately on the map by giving the current coordinates of 
the mouse pointer as you move it within the window: 

 

 
- When the mouse pointer is at the desired location, click 

with the left mouse button. This causes a dialog box to 
open in which you can complete the definition of the 
reference point. The following parameters can be specified 
or changed:  

 Name Keep the default name of the reference point or type 
another name 

 Code 1... code 4 Optional. Enter or select a geocode from each of these 
combo boxes. The list of available geocodes is the one 
you can define from the KISS Options dialog box, 
General tab  

   Note that if you place the pointer on the down-arrow of 
any of these combo boxes, the meaning of the 
selected geocode will appear in a tip box. 

 Target/Result/Error 
 radio buttons At this stage, only the Target radio button can be 

checked as the field survey is still to come  
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 E N H check buttons They define the type of the reference point. Three 
types are possible: 

 . 1D point: Obtained by checking the H button and 
clearing either of the other two buttons. 

 . 2D point: Obtained by clearing the H button and 
checking either of the other two buttons. The E 
and N buttons are then checked. 

 . 3D point: Obtained by checking the H button and 
either of the other two buttons. All three buttons 
are then checked. 

 E N H text boxes Planned coordinates of the reference point resulting 
from where you clicked on the map. If you change E or 
N, the icon will appear at a location different from 
where you clicked. Any change in these boxes should 
be consistent with the type of point (1D, 2D, 3D) you 
choose (see E N H check buttons just above). 

 Notes pane:  Add comments or recommendations of any kind which 
you want to associate to this point (optional). 

 

- After completing the definition of the reference point, click 
the OK button. The dialog box disappears and a new 
Reference Point icon appears on the map. 

 
- Position the mouse pointer where you want to create a 

second reference point and resume the same operations 
as above. To stop creating reference points, click any other 
button in the toolbar. 
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Changing a target point into a reference point or 
vice versa 

- In the KISS toolbar, click   

- On the map, select the point that you want to transform 
into a different type 

- From the contextual menu (right-mouse button) or from the 
Edit menu in the menu bar, select Change Into. The 
Change Into dialog box appears asking you to specify the 
new type to be assigned to this point 

- Choose the new type and click OK. The selected point is 
immediately changed into the desired type. 

 Note that if you use default names for target and reference 
points (i.e. target # and ref #), you will probably have to 
change the names of the points on which you run the 
Change Into command. Otherwise, this could introduce 
some confusion in your project. For example you should 
not keep naming a point "target 5" after changing it into a 
reference point. 

 Note also that you can select several points before running 
the Change Into command. In this case, all selected 
points will be changed into the selected type. 

 When results are available for reference and target points 
(after the field survey), these points can also be changed 
into "Logged points". If you select this option, a message 
box will appear asking you to confirm this choice. If you do 
so, you will lose the target coordinates associated with 
these points (only the coordinates measured in the field will 
be preserved). 
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Importing targets 
When preparing a project, you can add points on the map by 
importing them from a file or from 3SPack. 

- From the Edit menu or from the Map shortcut menu, select 
the Import Target... command. This opens the Import 
Target Positions dialog box 

- From the Mode combo box located at the foot of this 
dialog box, select Import From File or Import From 
3SPack depending on whether you want to import targets 
from a file (1st option) or from the 3Spack database (2nd 
option). Then do one of the following: 

 

• Import From File 
- Click the Add button to choose the file(s) from which to 

import points (default directory: ... /Points) 

- Select the desired file(s) and click the Open button. The 
selected files then appear in the Import list box. 

 When appropriate, use the other two buttons associated 
with the Import list box (Edit and Remove) after selecting 
a file name from this box. Use the Edit button to edit the 
selected file (default editor: Wordpad). Click the Remove 
button to remove the selected file name from the Import 
list box (no targets will then be imported from this file). 

- Tell KISS whether the imported targets should be defined 
as reference or target points in the active project. To make 
this choice, check the appropriate radio button in the 
Default Object pane (upper right) 
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- In the Format pane, specify the format of the file (ASCII 
DXF or User). To create new user formats, click the User 
formats button and then the New button. Then refer to 
page 3-64. 

- Click the Go button to start importing the points. The points 
will appear on the map after successful import operation 
(the map is adjusted through a zoom-to-fit-and-grab 
operation so that all the points can be viewed. 

 

• Import From 3SPack 
- Same as from a file, except that clicking the Add button 

will display directly all the sites available from the 3SPack 
Database. Another difference is that you should specify 
which solution of the site should be imported (the default 
or last one).To make this choice, from the Get 3SPack 
pane, click the appropriate radio button. 
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Importing results 
The Import Results command can be used in the following cases: 

1. You want to associate some points of your current project 
with results (solutions) that were obtained earlier for these 
points. For example these results were obtained using one 
of the 3SPack post-processing modules. In this case you 
will have to choose the Import from 3SPack mode when 
running the Import Results... command. 

 Note that importing a solution for a point which already has 
one will result in overwriting the existing solution with the 
imported one. 

2. You want to mark or illustrate the map of the active project 
with characteristic points surveyed previously. For example 
the results for these points were exported to files in the 
framework of earlier projects. In this case you will have to 
choose the Import from File mode when running the 
Import Results... command. 

Do the following to import results: 

- From the Edit menu or from the Map shortcut menu, select 
the Import Results... command. This opens the Import 
Result Positions dialog box 

- From the Mode combo box located at the foot of this 
dialog box, select Import From File or Import From 
3SPack depending on whether you want to import results 
from a file or files (1st option) or from the 3Spack database 
(2nd option). Then do one of the following: 

 

• Import From File 
- Click the Add button to choose the file(s) from which to 

import results (default directory: ... /Points) 



KISS Module 
Using KISS before field surveying 

DSNP 12-21 

- Select the desired file(s) and click the Open button. The 
selected files then appear in the Import list box. 

 When appropriate, use the other two buttons associated 
with the Import list box (Edit and Remove) after selecting 
a file name from this box. Use the Edit button to edit the 
selected file (default editor: Wordpad). Click the Remove 
button to remove the selected file name from the Import 
list box (no results will then be imported from this file). 

- Tell KISS whether the imported results should be defined 
as logged points or trajectories in the active project. To 
make this choice, check the appropriate radio button in the 
Default Object pane (upper right) 

- In the Format pane, specify the format of the file (ASCII 
DXF or User). To create new user formats, click the User 
formats button and then the New button (then refer to 
page 3-64). 

- Click the Go button to start importing the results. The 
points will appear on the map after successful import 
operation (the map is adjusted through a zoom-to-fit-and-
grab operation so that all the points can be viewed. 

 

• Import From 3SPack 
- Same as from a file, except that clicking the Add button 

will display directly all the sites available from the 3SPack 
Database. Another difference is that you should specify 
which solution of the site should be imported (the default 
or last one).To make this choice, from the Get 3SPack 
pane, click the appropriate radio button. 



KISS Module 
Using KISS before field surveying 

12-22 DSNP 

12 

Transferring jobs to a palmtop (6x0x series only) 
- Connect the palmtop to the computer through a serial line. 
- Select the Tools>Options>Transfer tab and check that 

the choices on this tab are appropriate (Scorpio 630x 
series selected, right choice for the port used on the PC to 
communicate with the Husky). Then click OK. 

- Open the project in the KISS window 
- If you want to focus on particular points, then select the 

corresponding icons. Otherwise, do not select anything. 

- In the toolbar, click    or, from the Transfer menu, 
select the Write Job command. 

- In the Write Job� dialog box which then appears, enter a 
name for the file which is going to be written to the palmtop 
(8 characters max.) or select an existing one from the list 
box which you will overwrite with the new job. 

- Specify the content of the job by checking one of the 
following buttons: 

 Selected Points This option should logically be checked if you have 
made a prior selection of points on the map (option 
dimmed otherwise) 

 Remaining Points Check this option if you want the field operator to deal 
only with the points not surveyed yet (which supposes 
that a part of the project has already been made). With 
this option you do not need to make a prior selection. 

 All Points Check this option if you want to make a job of the 
entire project. 

- Specify the order in which the points will be written by 
making a selection in the following combo box: 

 In Order of Choose one of the possible ways of arranging the 
points in the job 

- From the For Operator combo box, enter or select the 
name of the operator in charge of the job in the field. The 
list of known operators is defined in the Options dialog 
box, General tab. 

- Click the OK button to write the job to the palmtop. The file 
extension of a job file is �JOB�. 
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Transferring jobs to a PC card (600x series only) 
- Insert a card into the PC card reader of your PC. 
- Select the Tools>Options>Transfer tab, then, in the PC 

card drive: field, indicate the location of the PC card drive 
on your computer. Clear or check the Remind me of... 
check button relevant to the PC card. Click OK to enter 
your choices. This closes the dialog box. 

- Open the project in the KISS window 
- If you want to focus on particular points, then select the 

corresponding icons. Otherwise, do not select anything. 

- In the toolbar, click    or, from the Transfer menu, 
select the Write Job command. 

- In the Write Job� dialog box which then appears, enter a 
name for the file which is going to be written to the PC card 
(8 characters max.) or select an existing one from the list 
box which you will overwrite with the new job. 

- Specify the content of the job: 
 Selected Points This option should logically be checked if you have 

made a prior selection of points on the map (option 
dimmed otherwise) 

 Remaining Points Check this option if you want the field operator to deal 
only with the points not surveyed yet (which supposes 
that a part of the project has already been made). With 
this option you do not need to make a prior point 
selection. 

 All Points Check this option if you want to make a job of the 
entire project. 

- Specify the order in which the points will be written to the 
PC card by making a selection in the following combo box: 

 In Order of Choose one of the possible ways of arranging the 
points in the job 

- From the For Operator combo box, enter or select the 
name of the operator in charge of the job in the field. The 
list of known operators is defined in the Options dialog 
box, General tab. 
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- Click the OK button to write the job to the PC card. The file 
extension of a job file is �JOB�. 

 
 

Deleting a project 
Projects are deleted from the projects window. Only close projects 
can be deleted. 

- In the projects window, select the corresponding icon and 
then press the Del key (or choose the Delete command 
from the Edit menu. 

- Click Yes to confirm this choice. 

When you delete a project, in fact you delete all the files stored in the 
corresponding project folder, and this folder. A project folder 
generally contains a KIS file, one or more RES files and possibly raw 
data BIN files. 

It might be interesting to backup the project folder before deleting it 
from the KIS directory. 

 

How to quit KISS 
· From the menu bar, select File and then Exit. Unless an 

unsaved project is still open, this causes the KISS main 
window to be closed immediately. 

 If one or more unsaved projects are still open in the KISS 
window, warning messages will appear successively for 
each of these projects asking you to save the last changes 
made before quitting KISS. Click the Yes button to save 
them, or the No button to discard them. 
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Geoids module 
This module allows you to import geoids, extract data from a geoid 
to create a smaller file containing just the necessary data for your 
working area, and load geoid models (partial or complete) directly 
into a Scorpio receiver (only if it is from the 650x-to-630x series). 

Two geoid models are available in the Geoids module: RAF98 and 
EGM96 

Starting the Geoids module: 

- On the KISS Tools menu, select Geoids. This starts the 
Geoids module. 

Importing a new geoid model: 

- In the Geoids window, select File>Import and indicate the 
location of the corresponding file. 

Opening a geoid model: 

- In the Geoids window, select File>Open. This function 
indicates the following: geoid name, limits of geographical area, 
grid step, file size, number of points. 

Extracting data from a geoid model: 

- A geoid model must be open in the window 

- In the Geoids window, select File>Extract As�. Define the 
characteristics of the data extraction (name, format). To 
indicate the limits of your working area, you can advantageously 
use the World Map function, by clicking the World Map button, 
rather than type the coordinates of the N-W and S-E limits of 
the area. 

- Click the Extract button to create the new file. This file is 
automatically opened in the Geoids window after being created 
by the module. 
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Loading a geoid model into a receiver: 

- A geoid model must be open in the window (a complete or 
partial geoid). Establish a serial link between one of the ports on 
your PC and, for example, port A on the Scorpio (any RS232 
port can be used on the Scorpio), using the appropriate cable. 

- In the Geoids window, select Transfer>Write. A dialog box 
appears asking you to choose and set the serial port on your 
PC now connected to the Scorpio. 

 After setting the port, click OK to start and complete the file 
transfer. 
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Using KISS after field surveying 

Retrieving the results of a job (600x series) 
You do not need to work with the PC containing a project to read the 
results of a job prepared for this project. The only requirement is, of 
course, that 3SPack+KISS be installed and operating on this PC. If 
you work with the same PC, you can start the retrieve procedure by 
first opening the project from which the job was created. 

- Insert the PC card from the field into the drive of your 
computer 

· In the KISS toolbar, click  or from the Transfer menu, 
select the Read Results... command. This action is also 
possible if there is no project open in the KISS window, 
which will be the case if you work on a PC other than the 
one used to create the project 

- In the Read Results dialog box which then appears, select 
the job. 

- Click the OK button. Once KISS has successfully retrieved 
the results of the job, these results appear directly on the 
map. All the points for which solutions are now available 
are selected . See page 12-4 to understand the meaning of 
the icons used. 

If no project is open in the KISS window, or if the open project is 
incompatible with the results of the job, the PC card will restore the 
job as it was written earlier (this JOB file is still present on the PC 
card) and you will be asked to save this data as a new project. Then 
KISS will restore the solutions of the points surveyed during the job. 
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On transfer completion, a warning message will appear if particular 
events occurred during the transfer in relation with the transfer 
options chosen for KISS (see page 12-58): 

 

 
The message will prompt you to open the log file so that you can be 
informed of the nature of these events. If you click the Yes button, 
the log file will be opened using the WordPad text editor of 
Windows95. 

Outside this particular context, you cannot open the log file from 
KISS. If you need to open it at another moment, use Windows 
explorer (the log file is stored in ...\3SPack\bin under the name 
"KISS.log"). 

 

Retrieving the results of a job (650x-to-630x 
series) 

− Run KISS and open the project corresponding to the job 
completed in the field 

− In the toolbar, click  or from the Transfer menu, select 
the Read Results... command. The Read Results From... 
dialog box then appears listing a number of job names. 

 (This action is also possible if there is no project open in 
the KISS window, which will be the case if you work on a 
PC other than the one used to prepare the job.) 
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 (If a project is open, this dialog box will list all the job files 
present in the palmtop for which result files exist. If no 
project is open, ALL the job files will be listed, regardless of 
whether result files exist for these jobs or not.) 

− In the dialog box, select the job you have just completed in 
the field. 

− Click the OK button. 

 (If no project is open and you select a job, or if the open 
project is incompatible with the job, then KISS will ask you 
to create a new project on the basis of the selected job. If a 
result file exists for this job, then the results of this job will 
be retrieved.) 

 Note that during file transfer, format conversion is 
performed from binary to SVAR (ASCII). 

 Once KISS has successfully retrieved the results of the 
job, these results appear directly on the map. All the points 
for which solutions are now available are selected. 

− On transfer completion, a warning message will appear if 
particular events occurred during the transfer in relation 
with the transfer options chosen for KISS. 

 The message will prompt you to open the log file so that 
you can be informed of the nature of these events. If you 
click the Yes button, the log file will be opened using the 
WordPad text editor of Windows 95. 

 Outside this particular context, you cannot open the log file 
from KISS. If you need to open it at another moment, use 
Windows Explorer (the log file is stored in ...\3SPack\bin 
under the name "kiss.log") 
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Retrieving raw data recorded on PC card (650x-to-
630x series) 

- Insert the PC card containing the raw data files into the drive of your 
computer 

- Open the project relevant to the station or rover where raw 
data files were recorded 

- In the KISS toolbar, click  or , or from the Transfer 
menu, select Read Station or Read Mobile respectively. A 
dialog box appears listing all the raw data files present on PC 
card (*.Dxx). All files are selected by default for transfer. 

- Change the current selection if necessary 

- In the Recorded... text box, enter the identification of the 
station or rover where recording took place 

- Click OK to start transferring the files. Once transfer is 
complete the raw data files are visible in the project folder, 
and renamed as follows 

STATION_*.Dxx (raw data from stations) 

JOB_*.Dxx (raw data from rovers) 

where: 

xx: session number-1 (00 for 1st session, 01 for 2nd 
session, etc.). 

 
 Raw data can then be imported to 3SPack for post-

processing. Station raw data files should be associated with a 
site, and rover raw data files to a trajectory. 

 Warning! Raw data files recorded at a station or by a rover are 
exactly of the same type. It is therefore the user�s 
responsibility to establish the origin of the raw data files. 
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Editing a point surveyed at the planned location  
 

 
 

In the toolbar, select  and then double-click on the surveyed 
point (whether a reference point or a target point). The dialog box 
which then appears includes the following additional information, 
compared with the same dialog box before surveying the point: 

In the General tab 

- While only the Target radio button could be checked 
before the survey, you can now check the Result or Error 
radio button: 

. Checking the Result radio button will cause the 
coordinates of the position solution to appear just 
below as E, N and H. Note that these coordinates are 
dimmed (no changes allowed) 

. Checking the Error radio button will cause the 
components of the deviation between the planned and 
measured position to appear just below as DE, DN 
and DH. The Delta figure just below stands for the 
modulus of the deviation vector. This figure will be re-
computed if you change the type of the point (1D, 2D 
or 3D for a reference point, 2D or 3D for a target 
point), which you can easily do by simply 
checking/clearing the check buttons associated with 
DE, DN and DH. 
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. In this tab, opposite these results, a diagram 
illustrates the position solution. As shown in the 
examples below, the radius of the circle represents 
the 2D projection of the specified acceptable 
deviation: 

A. Target point whose solution is located within the acceptable 
deviation limit (vertical flag and segment in green): 

  
B. Target point whose solution is located outside the acceptable 

deviation limit (vertical flag and segment in red): 

  
C. 3D target point whose solution is located outside the 

acceptable deviation limit due to the vertical component of 
the deviation (vertical flag and segment in red although they 
remain within the circle): 
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A new (read-only) tab is added (Details) containing the complete 
description of the position solution: 

 Date Date & time of survey  
 Origin Name of the job during which the point was surveyed 
 Operator Name of the operator who made the job 
 Process Name of the processing method used (LRK A, LRK R, etc.) 
 
 GNSS 
 radio button Check this button to display the WGS84 coordinates of the 

position solution. This causes the lower part of the dialog box 
to show all the components of this solution. The definition of 
the vertical components (H84 and DH) are recalled 
graphically on the diagram in the right-hand part of the dialog 
box 

 L84, G84, H84 WGS84 coordinates of the antenna 
 DH GPS antenna height above the ground when surveying 

the point 
 Correlation Matrix Components of the correlation matrix 
 
 DGNSS 
 radio button Check this button to display the WGS84 coordinates of the 

reference station used in the surveying of the point. This 
causes the lower part of the dialog box to show the 
identification and coordinates of this station, as received by 
the roving unit through the data link. The distance and 
direction to the target point are illustrated on the diagram in 
the right-hand part of the dialog box. The illustration includes 
scale information. The station identification is also recalled in 
this diagram. 

 L84, G84, H84 WGS84 coordinates of the reference station, as 
received by the roving unit 

 Baseline Measured distance between target point and reference 
station 

 Correlation Matrix As the correlation matrix in fact qualifies the baseline 
measurement rather the position solution alone, it is 
maintained in the lower part of the dialog box, whether 
the GNSS or the DGNSS button is checked. 
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Editing a logged point 
Same as a planned point except that neither a target nor a deviation 
error is reported in the General tab 

 

Editing a planned point surveyed through offset 
procedure  

 
or 

 

In the toolbar, select  and then double-click on the surveyed 
point (whether a reference point or a target point). The dialog box 
which then appears includes the following additional information, 
compared with the same dialog box before surveying the point: 

In the General tab 

- While only the Target radio button could be checked 
before the survey, you can now check the Result or Error 
radio button: 

. Checking the Result radio button will cause the 
coordinates of the position solution to appear just 
below as E, N and H. Note that these coordinates 
are dimmed (no changes allowed) 

. Checking the Error radio button will cause the 
components of the deviation between the planned 
and measured position to appear just below as DE, 
DN and DH (necessarily all �0.000 m). The Delta 
figure just below stands for the modulus of the 
deviation vector (also �0.000 m). 
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- In this tab, opposite these results, a diagram illustrates the 
position solution (the target and the measured point 
necessarily coincide). 

Additional tabs are shown: Offsets , P1 , P2 and possibly P3 and P4 
in the case of �intersection� offset: 

- The Offsets tab identifies the type of offset procedure that 
was performed in the field, provides the coordinates of the 
points involved in that procedure and locates precisely the 
planned point with respect to these points: 

 Mode Lateral, linear or intersection 
 P1 P2 (P3 P4) 
 radio buttons Check the radio button corresponding to the point you 

want to display 
 E, N, H Coordinates of the selected point (Pn) 
 P1P (Lateral or linear offset only) Distance from P1 to the 

target (P) 
 P2P (Lateral offset only) Distance from P2 to the target (P) 
 P is (Lateral or linear offset only) Gives the location of the 

target with respect to the �oriented� segment [P2P1]. 
This means that if an observer is located at P2 and 
watches P1, then P will be seen either on the left or on 
the right side of this segment (as explained in the lower 
pane). 

 In this tab, opposite these results, a diagram illustrates the 
position solution: 

   
Lateral offset Linear offset Intersection offset 
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- Each of the P1, P2, P3 and P4 tabs is much similar to the 
Details tab obtained for a point surveyed at its planned 
location: 

 Date Date & time of survey  
 Origin Name of the job during which P1, P2, (P3 or P4) was 

surveyed 
 Operator Name of the operator who made the job 
 Process Name of the processing method used (LRK A, LRK R, etc.) 
 
 GNSS 
 radio button Check this button to display the WGS84 coordinates of P1, 

P2, P3 or P4. This causes the lower part of the dialog box 
to show all the components of this solution. The definition 
of the vertical components (H84 and DH) are recalled 
graphically on the diagram in the right-hand part of the 
dialog box 

 L84, G84, H84 WGS84 coordinates of antenna at P1, P2, P3 or 
P4 

 DH GPS antenna height above the ground when 
surveying the point 

 Correlation Matrix Components of the correlation matrix 
 
 DGNSS 
 radio button Check this button to display the WGS84 coordinates of the 

reference station used in the surveying of P1 or P2. This 
causes the lower part of the dialog box to show the 
identification and coordinates of this station, as received by 
the roving unit through the data link. The distance and 
direction to P1, P2, P3 or P4 are illustrated on the diagram 
in the right-hand part of the dialog box. The illustration 
includes scale information. The station identification is also 
recalled in this diagram. 

 L84, G84, H84 WGS84 coordinates of the reference station, as 
received by the roving unit 

 Baseline Measured distance between target point and 
reference station 

 Correlation Matrix As the correlation matrix in fact qualifies the 
baseline measurement rather the position 
solution alone, it is maintained in the lower part 
of the dialog box, whether the GNSS or the 
DGNSS button is checked. 
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Editing a logged point surveyed through offset 
procedure 
Same as a planned point surveyed in the same context, except that 
neither a target nor a deviation error is reported in the General tab 

 

Exporting targets 
This command allows you to generate a file containing the 
theoretical coordinates (targets) of points created in your project, or 
to create site records in the 3SPack database. This operation can be 
performed before or after field surveying. The format of the 
generated file (if this option is chosen) can be DXF or any user 
format. 

- From the Edit menu or from the Map shortcut menu, select 
Export Target... 

- In the Export Target Positions dialog box which then 
appears, click the Add button. A new box appears 
(Browse box) listing all the points present in the project. 

- Select the desired points (multiple selection is possible 
using the Ctrl and Shift keys if necessary) and then click 
OK. The list of selected points now appears in the Export 
zone of the Export Target Positions dialog box. 

 Note that this selection phase can be avoided if you select 
the desired points directly on the map before selecting the 
Export Target... command. 

- In the Mode combo box, specify whether you want to 
export the targets to a file or to 3SPack: 

 

• Exporting to 3SPack 
- Simply click the GO button to let KISS export the targets of 

the selected points to the 3SPack database 
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• Exporting to a file 
- In the In File edit box, specify the path and name of the 

export file to be generated. To specify a path and name 
different from the default ones, directly type in the edit box  

 or click  to quickly access the desired directory on the 
disk 

- In the Format combo box, select the desired file format. 
You can create or edit a user format through the User 
Formats... button. To create a new format, click the New... 
button. Then, for more information on how to create a user 
format, see 3-64.  

- Click the GO button to let KISS generate the file and save 
it at the specified location 

 

Exporting Results 
This command allows you to generate a file containing the surveyed 
coordinates of points present in your project, or to create site records 
in the 3SPack database. This operation can be performed only if 
results are available for points present in your project. The format of 
the generated file (if this option is chosen) can be DXF or any user 
format. 

- From the Edit menu or from the Map shortcut menu, select 
Export Results... 

- In the Export Result Positions dialog box which then 
appears, click the Add button. A new box appears 
(Browse box) listing all the points present in the project. 

- Select the desired points (multiple selection is possible 
using the Ctrl and Shift keys if necessary) and then click 
OK. The list of selected points now appears in the Export 
zone of the Export result Positions dialog box. 
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 Note that this selection phase can be avoided if you select 
the desired points directly on the map before selecting the 
Export Results... command. 

- In the Mode combo box, specify whether you want to 
export the results to a file or to 3SPack: 

 

• Exporting to 3SPack 
- Simply click the GO button to let KISS export the results of 

the selected points to the 3SPack database. 

 

• Exporting to a file 
- In the In File edit box, specify the path and name of the 

export file to be generated. To specify a path and name 
different from the default ones, directly type in the edit box  

 or click  to quickly access the desired directory on the 
disk 

- In the Format combo box, select the desired file format. 
You can create or edit a user format through the User 
Formats... button. To create a new format, click the New... 
button. Then, for more information on how to create a user 
format, see page 3-64.  

- Click the GO button to let KISS generate the file and save 
it at the specified location 
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Running computations relative to the coordinate 
system used 
The corresponding commands, which are grouped in the Tools 
menu, should be used after surveying reference points materialized 
in the field. 

The three main cases of use are described in page 12-41. 

 

Printing the report of a project 
Use the usual buttons to print the report of a project: 

- Select a printer and the few other print options through the 
Print Setup command from the File menu 

- Print preview : use    

- Print : use   

The content of the report depends on the setting of the include 
project points in to project report check button in the Report tab 
of the KISS options. 

If it was cleared, the report will print out in its shortest version: 

- The first page shows a map of the work area, as currently 
viewed in the KISS window (same grab setting and scale) 

- The second page lists the project details and indicates the 
counts of points according to type 

- The third page provides a complete description of the 
coordinate system used 

 If the include project points in to project report button 
was checked, the report will also include the user-set 
results table, as defined in the Report tab of the KISS 
options. 



KISS Module 
Choosing the appropriate coordinate system 

DSNP 12-41 

Saving a project 

- In the toolbar, click  or from the File menu, select the 
Save command. 

 

 

Choosing the appropriate coordinate 
system 
When creating a new project, you may be confronted with the 
problem of not knowing how to define the coordinate system to be 
used. The three cases described below are typical examples of 
applications where this choice may not be easy. The accompanying 
explanations will tell you what to do. 

• Guidelines: 
- If the local system cannot be linked with the WGS84 

system and you are mainly interested in the vertical 
coordinate of your points, then you should use the 
commands Compute Local Grid and Compute Vertical 
Correction  

- If you want to compute the datum shifts, use the 
corresponding command Compute Datum Shifts, and 
possibly the Compute Vertical Correction command if 
you want to change the altitude reference (for example you 
want to apply a correction on the STANAG geoid rather 
than on the WGS84 ellipsoid). 

- If you use a local grid, the Compute Datum Shifts 
command is made unavailable to you as it is irrelevant in 
this case. 



KISS Module 
Choosing the appropriate coordinate system 

12-42 DSNP 

12 

1st case: You cannot link your local horizontal 
system with the WGS84  

• Problem: 
You want to work on a local horizontal system (a plane) but you do 
not know how to link this system with the WGS84. 

You know the exact coordinates, expressed in this local system, of a 
few reference points located within the work area. These points are 
materialized in the field. 

• What you should do: 
- When creating your project, in the second tab (Project 

Wizard - Horizontal System), select <Unknown> for both 
the datum and the projection, or select a datum and a 
projection which might work in the area 

- On the view of the work region, place the known reference 
points with their local coordinates and create a job 
containing these points 

- Survey these 2D or 3D points in the field 

- Then, either from the field palmtop or using KISS 
(Compute Horizontal Grid command from the Tools 
menu), allow the system to determine a local grid after you 
select a number of these points to be involved in the 
processing. 

- If you chose an <Unknown> datum, then the WGS84 will 
be used in that processing 

- If you chose an <Unknown> projection, then a 
stereographic projection will be used in that processing, 
centered on the barycentre of the selected points. 

- After determining a local grid, KISS will provide the 
deviations between the local coordinates you defined (El, 
Nl) and the corresponding surveyed coordinates (after 
successively converting them into the intermediate 
projection and the local grid) 
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- If you think the results are satisfactory, you can validate the 
local grid. The icons of the reference points involved in the 
grid processing will then appear on the map, each of them 
marked with a "G" (see graphic conventions) 

• The theory behind this procedure...  
- The user provides an intermediate transformation (or KISS 

finds an appropriate one if none is specified) making it 
possible to transform WGS84 coordinates (L84, G84, H84) 
into projected coordinates (Ei, Ni) 

- As some 2D or 3D reference points are known both in local 
coordinates (El, Nl, provided by user) and in WGS84 
coordinates (after surveying), the intermediate 
transformation is used to convert the WGS84 coordinates 
of these points into projected coordinates (Ei, Ni), then 
through least-square processing, a transformation is found 
(linear shifts+angular shifts+scale change) allowing the (Ei, 
Ni) coordinates to be converted into (El, Nl) coordinates 
(on the local grid). 

- The following equations provide a mathematical model for 
the local grid: 

 E1 = 1 /k [ (Ei+DE) cos β − (Ni+DN) sin β ] 

 N1 = 1 /k [ (Ei+DE) sin β + (Ni+DN)c os β ] 
 However, the values of Ei and Ni are generally large and k 

is of the order of 1. This means that Ei+DE and Ni+DN wil 
also be large. As a consequence, any error on β, however 
small it can be, will induce a significantly more important 
error on the local coordinates. 

- That is why a different mathematical model is now used, in 
this version of KISS, for local grids: 

 E1 = E0 + 1 /k [ (Ei+DE) cos β − (Ni+DN) sin β ] 

 N1 =N0 + 1 /k [ (Ei+DE) sin β + (Ni+DN)c os β ] 
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 As this model minimizes the values of Ei+DE and Ni+DN, 
the impact, on the local coordinates, of the possible error 
on β, is also minimized. 

- Note that the following parameters can be user-set: 

 (E0, N0): for example (0, 0) complies with a grid in the 
former KISS version 

 and/or (DE, DN): for example (0, 0) for no linear shifts 

 and/or k: for example "1" for no scale change 

 and/or β: for example "0" for no angular shift 

 The algorithm used will depend on the number of 
parameters fixed by the user 

- Note also that a minimum of two reference points is 
required to determine a local grid (unless most of the 
parameters have been fixed) 

 

2nd case: You cannot link your local vertical 
system with the WGS84  

• Problem: 
- You want to work on a local vertical system (altimetric 

system) but you do not know how to link this system with 
the WGS84, or you want to use a global vertical system 
which you want to refine locally through a survey 

- You know the exact heights, expressed in this local 
system, of a few reference points located within the work 
area. These points are materialized in the field. 

- You would like the receiver to provide altitudes expressed 
on your local system 
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• What you should do: 
- When creating your project, in the third tab (Project 

Wizard - Vertical System), select any system 

- On the view of the work region, place the known reference 
points with their local coordinates and create a job 
containing these points 

- Survey these 1D or 3D points in the field 

- Then, either from the field palmtop or using KISS 
(Compute Vertical Correction command from the Tools 
menu), allow the system to determine a vertical correction 
after you select a number of these points to be involved in 
the processing 

- After determining a vertical correction, KISS will provide 
the deviations between the local heights you defined (Hl) 
and the corresponding surveyed heights (after 
successively converting them into the intermediate system 
and the local correction) 

- If you think the results are satisfactory, you can validate the 
local correction. The icons of the reference points involved 
in the vertical correction processing will then appear on the 
map, each of them marked with an "H". 

- Note that 3 reference points minimum have to be surveyed 
to determine a plane correction. KISS will however be able 
to determine an average vertical correction from one or two 
of these points. 

• The theory behind the procedure...  
- The user chooses a vertical system (datum or geoid 

model) that is suitable for the work area, allowing the 
system to compute an intermediate altitude Hi, not very 
different from the local altitude Hl 
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- As some 1D or 3D reference points are known both in local 
coordinates (Hl, and possibly El and Nl, provided by user) 
and in WGS84 coordinates (after surveying), the 
intermediate transformation is used to compute Hi from the 
WGS84 coordinates of these points, then through least-
square processing, a plane correction (DH) is found �a 
function of both L84 and G84� which will be used to 
determine Hl from Hi. 

 The local correction is a plane correction. We have: 

 H1 = Hi + Delta 

 The expression of Delta is: 

 Delta = dH + Gl (L84 − L0) + Gg (G84 − G0) 
 Where: 

 (L0, G0) are the WGS84 coordinates of the central 
point (the barycentre of the selected reference 
points) 

 dH is the correction at the central point 

 Gl and Gg are the gains defining the amount of 
correction to be applied along the latitude and 
longitude axes (plane slopes) 

 NOTICE: Applying a plane correction does not necessarily 
mean that the resulting vertical system is also a plane. 
Remember that the correction operates on an intermediate 
system which is not a plane. 
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3rd case: You are working with a standard 
coordinate system but the datum shifts are not 
accurately known  

• Problem: 
- You want to work on a standard coordinate system 

(ellipsoid and projection are known) but you do not know 
how to link the ellipsoid of this system with that of the 
WGS84 (i.e. datum shifts unknown) 

- You know the exact coordinates, expressed in this local 
system, of a few reference points located within the work 
area. These points are materialized in the field. 

- You would like to determine the datum shifts in order to 
complete the definition of your coordinate system. A 
transformation system would then be available allowing the 
points surveyed in WGS84 coordinates to be converted 
into local coordinates. 

• What you should do: 
- When creating your project, in the second tab (Project 

Wizard - Horizontal System), specify the projection used 
in the local system, then edit the datum. In the present 
case, only the two parameters 1/F and A are known. 

- On the view of the work region, place the known reference 
points with their local coordinates and and create a job 
containing these points 

- Survey these 1D, 2D or/and 3D points in the field 

- Then, from KISS, using the Compute Datum Shifts 
command from the Tools menu, allow the system to 
determine the datum shifts after you select a number of 
these points to be involved in the processing. Note that this 
computation cannot be performed from the field palmtop. 
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 2D and 3D reference points are used to determine the 
datum shifts 

 1D and 3D reference points are used to determine the 
vertical correction to be applied to any altitude expressed 
on the WGS84 ellipsoid. 

- At the end of the processing, KISS will provide: 1) the 
horizontal deviations between the local coordinates you 
defined (El, Nl) and the corresponding coordinates 
surveyed in WGS84 after converting them using the newly 
determined transformation including the new datum shifts; 
2) the vertical deviations between the local altitudes you 
defined (Hl) and the altitudes surveyed in WGS84 after 
correcting them for the local correction 

- If you think the results are satisfactory, you can validate the 
datum shifts. The icons of the reference points involved in 
the processing will then appear on the map, each of them 
marked with a "D" and an "H". (see page 12-4). 

• The theory behind this procedure...  
- The user chooses a projection and a datum for which only 

A and 1/F are known 

- As some 1D, 2D and/or 3D reference points are known 
both in local coordinates (provided by user) and in WGS84 
coordinates (after surveying), the projection and datum are 
used to determine the geocentric coordinates of these 
points on the user datum. Then, through least-square 
processing, the datum shifts are computed by comparing 
the obtained coordinates with the WGS84 geocentric 
coordinates surveyed in the field. 

 NOTE: Experimentation has proven that planimetric results 
are much better if the angular shifts RX, RY and RZ are 
forced to zero thus limiting the processing to determining 
only the linear shifts DX, DY, DZ, and the scale factor k. 
However, altimetric results obtained through this 
processing are not as good as in planimetry 
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 For this reason, our ultimate choice in terms of processing 
now consists of a datum shifts computation based on the 
determination of 4 parameters (DX, DY, DZ, k), followed by 
the computation of a vertical correction to be applied to 
altitudes measured above the WGS84 ellipsoid. 

 

Computing datum shifts 
One of the following two methods can be used when asking for the 
computation of the datum shifts:  

1st choice: (check the upper-right button) 

A new horizontal system (DX, DY, DZ and K) will be determined 
from the specified 2D and 3D reference points. A new vertical 
system (a linear correction model to be applied to WGS84 
altitude) will be determined as well from the specified 3D and 1D 
reference points. 

The reference points used will be annotated �D� for those 
involved in the determination of the datum shifts and / or �H� for 
those involved in the altimetry computation. 

2nd choice: (check the lower-right button) 

The following parameters will be determined from the specified 
3D reference points: DX, DY, DZ, K, RX, RY, RZ. Then, the new 
datum will be validated in both the horizontal and vertical systems 
(altitudes will be expressed on the new datum, without any 
corrections). The reference points used will then be annotated 
�D�. 

Warning! Although this 2nd method is very attractive �the 
resulting system is a standard one� it is however more sensitive 
than the 1st one to errors introduced when logging the reference 
points in the field (the resulting errors on the computed rotation 
parameters, however small they may be, will produce significantly 
larger errors on coordinates when converting them into the new 
system). 
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Quick Info window 
The Quick Info window is as a very useful complement to the map 
view. Basically, the Quick Info window displays a row of interesting 
variables, such as planned, surveyed coordinates, etc., for any point 
you select on the map. 

The Quick Info window is entirely user-configurable, which means 
that you can choose which variables you would like to display for the 
selected point(s). Moreover, the Quick Info window is fully 
independent of the map view: you use it only when needed. 

 

Opening the Quick Info window 
- From the menu bar, select View and then Quick Info 

 or, from anywhere within the window of an open project, 
click with the right-mouse button and select Quick Info 
from the shortcut menu which then appears. 

 The Quick Info window then appears with the current 
settings. If points are currently selected, the Quick Info 
window will display rows of data relative to these points. 

- You can sort the data rows (in order of name for example) 
by clicking the title bar of the corresponding column (i.e. 
the Name column in our example). 
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Setting the Quick Info window 
1. Open the Quick Info window 

2. Position the pointer anywhere in the Quick Info window 

3. Click with the right-mouse button and select Settings... 
from the menu which then appears. 

 A dialog box appears in which you can configure 
everything you would like the Quick Info window to show 
when you select a point on the map. Configuring this 
window is much similar to configuring the information 
supplement to be added to the project report. The content 
of the dialog box is described below: 

 
 Categories 
 combo box Allows you to select one of the 3 main categories of 

variables which are: General, Offsets, Details 
 Variables list box Lists the available variables for the selected category 

(see combo box above) 
 Columns list box Each variable contained in this list defines a column in 

the results table (top of the list: leftmost column) 
 List  
 trajectory points 
 check button If checked, all the points in existing trajectories will 

appear in the Quick Info window, as are all the isolated 
points. If cleared, each trajectory will occupy a single 
row in the window (only the trajectory name will be 
reported). 
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• Adding a parameter column to the Quick Info window  
Unless already done: 

1. Open the Quick Info window 

- From the menu bar, select View and then Quick Info 

 or, from anywhere within the window of an open 
project, click with the right-mouse button and select 
Quick Info from the shortcut menu which then 
appears. 

2. Position the pointer in the title bar of the Quick Info 
window 

3. Click with the right-mouse button and select Settings... 
from the menu which then appears. 

Then: 

4. In the Variables list box, select the variable for which you 
want to create a new column in the Quick Info window. Use 
the vertical scroll bar, or after clicking any visible variable 
press the vertical direction keys, to access the desired 
variable 

5. Click  located between the Variables list box and the 
Columns list box. This causes the selected variable to 
appear at the end of the Columns list box (hence as the 
rightmost column of the Quick Info window). 
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• Changing the order of columns within the Quick Info 
window  
The Variables-to-Columns assignment is as follows 

 First variable in the Columns list box → printed in leftmost 
column of Quick Info window 

 ... 

 Last variable in the Columns list box → printed in 
rightmost column of Quick Info window 

Changing the order of columns in the Quick Info window is obtained 
by changing the order of variables in the Columns list box: 

 
Unless already done: 

1. Open the Quick Info window 

- From the menu bar, select View and then Quick Info 

 or, from anywhere within the window of an open 
project, click with the right-mouse button and select 
Quick Info from the shortcut menu which then 
appears. 

2. Position the pointer in the title bar of the Quick Info 
window 

3. Click with the right-mouse button and select Settings... 
from the menu which then appears. 

Then: 

4. In the Columns list box, select the variable you want to 
move to another location within the list 

5. Click the Move Up or Move Down button to move the 
variable to the desired place. 

 Note that the "Name" variable is necessarily the first 
variable in the list (hence appearing in the leftmost column 
of the Quick Info window). 
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• Removing a column from the Quick Info window 
Unless already done: 

1. Open the Quick Info window 

- From the menu bar, select View and then Quick Info 

 or, from anywhere within the window of an open 
project, click with the right-mouse button and select 
Quick Info from the shortcut menu which then 
appears. 

2. Position the pointer in the title bar of the Quick Info 
window 

3. Click with the right-mouse button and select Settings... 
from the menu which then appears. 

Then: 

4. In the Columns list box, select the variable you want to 
remove from the Quick Info window 

5. Click the Remove button. The column corresponding to 
that variable immediately disappears from the Quick Info 
window 

 Note that you cannot remove the "Name" variable. 

 

• Adjusting column width 
Unless already done: 

1. Open the Quick Info window 

- From the menu bar, select View and then Quick Info 

 or, from anywhere within the window of an open project, 
click with the right-mouse button and select Quick Info 
from the shortcut menu which then appears. 
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Then: 

2. Position the pointer on the right of the desired column 
(pointer shape: ): 

- Drag to the right to increase the column width, or to 
the left to decrease it 

 or double-click to adjust the column width to the 
longest word in the column 

 

• Sorting the data rows into alphabetical or numerical order 
(according to the content of a column) 

Unless already done: 

1. Open the Quick Info window 

- From the menu bar, select View and then Quick Info 

 or, from anywhere within the window of an open project, 
click with the right-mouse button and select Quick Info 
from the shortcut menu which then appears. 

Then: 

2. Click in any of the column headings (gray areas) to sort the 
data rows according to the data in the corresponding 
column 

 If you click on the "Name" heading for example, data rows 
will be listed in alphabetical order (ascending or 
descending) according to "Name". If you click on "Name" 
again, data rows will be listed in reverse order. 
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Changing the options of KISS 

- In the toolbar, click   or from the menu bar, select 
Tools and then Options. A dialog box appears in which 
you can set the options of the KISS module. The dialog 
box contains the following three tabs. 

General Tab 
Acceptable deviation between target and surveyed coordinates 
text box 

 Enter the maximum distance allowed between the planned 
(target) and the measured position. The Delta figure, 
obtained after retrieving the results of the survey, will be 
compared to this maximum distance. If it is less, then the 
point will be shown in green on the map, otherwise it will be 
shown in red (thus signaling that the measured position is 
different from the planned position by more than the 
acceptable deviation). 

 The acceptable deviation is shown graphically in the 
properties of any target point as a circle centered at the 
planned location. It should be noted that this circle only 
represents the acceptable deviation in the horizontal 
plane. This means for example that if the solution of a 3D 
point is represented by a red icon although it is located 
within the circle, you should infer that the cause of this can 
only be a too high vertical deviation in the solution of this 
point. 

 
Maximum count of points allowed in a job file text box 

 Limiting the number of points in a job is recommended as 
the memory space in the palmtop is not unlimited, and 
besides preserves the processing speed of the palmtop 
(default value: 1000). 
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Operators pane 

 Allows you to create the list of operators usually in charge 
of performing your field surveys. KISS will ask you to 
choose an operator from this list when writing a job to 
PCMCIA. 

 
Geocodes pane 

 Allows you to create a list of geocodes. The pane contains 
two columns: the first one lists the geocodes you define, 
the second one the meaning of each of these geocodes. 

 
 Contextual menu: 

 From anywhere within the above two panes, a contextual 
menu exists allowing you to work on the Operators and 
Geocodes lists. To display this menu, click with the right-
mouse button after positioning the mouse pointer 
anywhere within any of the two panes: 

  
 (See page 12-63 for more information on how to work on 

the Operators and Geocodes lists). 

 

Transfer tab 
Scorpio receiver series used : Tick the button corresponding to 
the series of Scorpio receiver used (6500-to-6300 series, or 
former 6000 series) 

Then depending on the above selection: 

PC Card Drive : Type the path of the PC card (default: E:\) 
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PC port to Husky : Select the port on your PC that you want to use 
to communicate with the Husky (via its serial port) 

Transfer procedure reminder: Check or clear the Remind me of... 
check button, depending on whether you wish to be guided during 
the job transfer procedures or not. 

 

When reading results... pane 

 This pane deals with all the anomalous events detected by 
KISS when reading results files after the field operator has 
completed a job. The pane gives access to four different 
options. A single option is displayed at a time. To proceed 
with the next choice, use the vertical scroll bar. For each 
option, check the button corresponding to your choice. You 
must choose an option in each of the four cases: 

 
1 : If the coordinates of a reference point read from the results 

file are different from those of the same point in the active 
project: 

 Discard point read from the results file 
 Create a new point in the active project 
 Replace the initial coordinates with those read from the results 
file 

 
2 : If the results file contains a reference position not defined in 

the active project: 

 Discard point read from the results file 
 Create a new point in the active project 
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3 : If the coordinates of a planned target point read from the 
results file are different from those of the same point in the 
active project: 

 Discard point read from the results file 
 Create a new point in the active project 
 Replace the initial coordinates with those read from the results 
file 

 
4 : If the results file contains a planned target point not defined 

in the active project: 

 Discard point read from the results file 
 Create a new point in the active project 

 

Report tab 
This tab allows you to define the content of the document you can 
print from the active project. 

 
Include Project Points into project Report check button 

If you clear this button, the printout will only contain: 

· A map of the region of survey, as currently shown in the 
KISS window 

· A summary of the project (area, points, trajectories, etc.) 

· the definition of the horizontal and vertical systems used 
 
If you check this button, the With Next Settings pane will appear in 
the lower part of the tab allowing you to complete the printout as 
defined above with a results table containing the information present 
in the Print list box below. 
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If the width of the results table you define cannot fit in a page, then 
the table will be split into several pages, each page containing the 
maximum number of columns, starting from the leftmost column, 
which can fit in the page. 
 

 Print Combo box allowing you to tell KISS whether the 
results table in the report should contain all the points 
in the project (choose All points) or only the selected 
points (choose Selected points). 

 In Order of Combo box allowing you classify the points in the 
results table according to a criterion that you specify 
here (up to 50 different criteria available). 

 With Next  
 Settings pane Allows you to define the content of the results table: 

see below. 
 

Managing the table of variables appended to the 
project report 
 

 Categories 
 combo box Allows you to select one of the 3 main categories 

of variables which are: General, Offsets, Details 
 Variables list box Lists the available variables for the selected 

category (see combo box above) 
 Columns list box Each variable contained in this list defines a 

column in the results table (top of the list: 
leftmost column) 

List trajectory points 
 check button If checked, all the points in existing trajectories 

are described in the results table, as are all the 
isolated points. If cleared, the trajectory will 
occupy a single row in the results table (only its 
name will be reported). 
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• Adding a parameter column to the results table 
- In the Variables list box, select the variable for which you 

want to create a new column in the results table. Use the 
vertical scroll bar, or after clicking any visible variable press 
the vertical direction keys, to access the desired variable 

- Click  located between the Variables list box and the 
Columns list box. This causes the selected variable to 
appear at the end of the Columns list box (hence as the 
rightmost column of the results table when next printing it). 

 

• Changing the order of columns within the results table 
The Variables-to-Columns assignment is as follows: 

 First variable in the Columns list box → printed in leftmost 
column of results table 

 ... 

 Last variable in the Columns list box → printed in 
rightmost column of results table 

Changing the order of columns in the results table is obtained by 
changing the order of variables in the Columns list box: 

- In the Columns list box, select the variable you want to 
move to another location within the list 

- Click the Move Up or Move Down button to move the 
variable to the desired place. 

 Note that the "Name" variable is necessarily the first 
variable in the list (hence printed in the leftmost column of 
the results table). 
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• Removing a column from the results table 
 - In the Columns list box, select the variable you want to 

remove from the results table 

- Click the Remove button. When next printing the results 
table, the column corresponding to that variable will no 
longer print 

 Note that you cannot remove the "Name" variable. 
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Managing Operators & Geocodes list 

Unless already done, in the toolbar click  and select the General 
tab to access these two lists. 

Use the procedures below to update your Geocodes list. The same 
procedures can be used when working on the Operators list. 

• Creating a new geocode 
- Click the New Geocode... button or from the shortcut 

menu, select New Geocode... 
- Type the code and meaning of the new geocode in the 

dialog box which then appears 

- Click the OK button. The new geocode appears in the 
geocode list. Its position in the list results from the last 
sorting criterion (see below). 

 

• Correcting the definition of a geocode 
- Select the geocode you want to correct 

- From the contextual menu , select Properties 
- In the dialog box which appears, correct the definition of 

the geocode (code and/or meaning) and then click OK. 
 

• Sorting geocodes into alphabetical order 
- Click in any of the two column headings (gray areas 

containing the words "Code" and "Meaning"). 

 If you click on the "Code" heading for example, geocodes 
will be listed in alphabetical order (ascending or 
descending) according to "Code". If you click on "Code" 
again, geocodes will be listed in reverse order (same 
behavior if you click on "Meaning"). 
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• Adjusting column width 
- Position the pointer on the right of the desired column 

(pointer shape: ): 
. Drag to the right to increase the column width, or to 

the left to decrease it 

. Or double-click to adjust the column width to the 
longest word in the column. 

 

• Removing a geocode from the list 
- Select the geocode you want to remove 

- From the contextual menu , select Delete. 
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Map commands 
You will probably need to use the following commands when you 
work on a project. 

 

Map window status bar 
For the active project, the status bar of the KISS window 
permanently indicates the total number of points in the project, the 
number of currently selected points and the number of hidden points. 

 

Showing/hiding the Map grid  

Click  in the toolbar to show/hide the map grid. This button 
operates as a toggle. You can also select the Grid command from 
the View menu. This command also operates as a toggle. 

 

Showing/hiding the ruler 

Click  in the toolbar to show/hide the ruler. This button operates 
as a toggle. You can also select the Ruler command from the View 
menu. This command also operates as a toggle. 

 

Showing/hiding map details 

Click  in the toolbar to show/hide the map details. You can also 
select the Map command from the View menu. This command also 
operates as a toggle. 

Maps are bitmap files obtained with scanners. They must be stored 
in the Maps object of the 3SPack database to be used by KISS. 
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Hiding/Focusing on/Showing... Points 
To make it even easier for you to handle your surveys, KISS offers 
three different viewing commands relative to the points shown on the 
map. The three commands are accessible either from the Map 
shortcut menu or from the View menu. These three commands are: 

 
 Hide Hides the selected point (or points) 
 Focus Performs Zoom To Fit action based on the current 

selection of points. In the same time, hides all other 
points. 

 Show... Gives access to a points list in which you can check 
the points you want to hide or clear the points you 
want to show. The number of currently hidden points 
is indicated in the status bar of the KISS window. 
Asking for a point to be hidden means that both the 
icon and the name, if shown, will be hidden. 

Use Notes: 

While both Hide and Focus directly act upon the current selection of 
points, Show... on the contrary makes an inventory of the hidden 
and non-hidden points. From this list you can decide on what 
changes should be made concerning the presence or not of points 
on the map. Changes can be made either individually, by 
checking/clearing the corresponding check buttons, or globally using 
the Hide All or Show All button. 

Note that the Show... command is not contextual (no selection of 
points required to access this command). 

 

Selecting all points  

After clicking  to view all the points, drag to create a rectangle 
that encloses all the points, or from the Edit menu, select the Select 
All command. 
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Selecting a point on the map 

In the toolbar, click    and then click on the point you want to 
select. If shown, the point name turns white with dark-blue 
background 

To add another point to the selection, hold down the Shift or Ctrl key 
while clicking on the second point. If necessary, add other points to 
the selection by repeating this action. 

To select several points at the same time, drag to create a rectangle 
that encloses all of the points you want to select. Selection is 
effective after you release the mouse button. 

To remove a point from the selection, hold down the Ctrl key while 
clicking this point. 

To cancel a selection, click in the map where there is no point. 

 
Moving the map within the KISS window 

- In the toolbar, click  or from the View menu, select the 
Grabber command 

- Move the mouse pointer onto the map. This causes the 
pointer shape to change to a  

- Depress the left mouse button and drag the pointer in the 
direction where you want the map to be moved. Note that 
the move will take place only when you release the mouse 
button and it will be proportional to the distance covered by 
the pointer when you drag it. 

 
Deleting points 
Select these points (using the Select or �Select Where� function) 
and then press the Del key. A message will then ask you to confirm 
the Delete operation. The points will definitively disappear from the 
map if you click the Yes button. 
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Selecting points according to a number of preset 
criteria: �Select where� 
The �Select Where� function is very useful when you need to select a 
large number of points meeting one or more criteria. After you 
specify this criterion (or these criteria), KISS will be capable of 
selecting these points for you in no time. 

In addition, you can restrict the selection of points meeting the 
criteria by drawing a rectangle on the map (after specifying your 
criteria). By doing this, only the points meeting the criteria and 
located inside this rectangle will be effectively selected. 

- In the toolbar, click  or, from the menu bar, select 
Draw and then Select Where. A new dialog box appears 
in which you can do the following: 

 Criteria pane  
 Add button Click this button to add a new criterion. A new dialog 

box appears (�Add criterion� dialog box) in which you 
can build the expression of the new criterion 

   Click OK when the expression of the criterion is 
complete. The criterion then appears in the list box of 
the �Select Where� dialog box. 

   Resume this operation until all the required criteria are 
shown in the list box. 

 Edit button Click this button after selecting a criterion which you 
want to modify. A new dialog box appears (�Add 
criterion� dialog box) in which you can change the 
expression of this criterion. Click OK when you agree 
with the new expression of the criterion. The list box in 
the �Select Where� dialog box is then updated 
accordingly 

 Delete button Click this button after selecting a criterion which you 
want to delete. The criterion will then disappear from 
the list box 



KISS Module 
Map commands 

DSNP 12-69 

 Query pane  

 You can save the set of criteria created in the list box as a 
file (a QRY file) so that it will be easy for you to use it again 
at a later date. You can also load a QRY file created earlier 
for this project (or for another project) in order to use the 
criteria contained in this file. 

 By default, QRY files are saved in the KIS directory, at the 
same level as the project folders. 

 Load button Click this button to load a QRY file created earlier 
(default directory: KIS). After selecting a file, click the 
Open button. As a result, all the criteria held by this file 
appear in the list box of the �Select Where� dialog box 

 Save button Click this button to save the displayed criteria as a 
QRY file (default directory: KIS). After naming the file, 
click the Save button. As a result, all the displayed 
criteria are saved into this file. 

 

 Select points 
 that match� Check one of the following options: 
   �At least one of the following criteria� : any 

tested point meeting any of these criteria will be 
selected 

   or �All the following criteria� : only the tested 
points meeting all the criteria will be selected 

 - At the foot of the dialog box, check one of the 
following options 

   �and match cursor selection as well� : only the 
points in the area that you will drag with the 
mouse pointer will be tested to see if they match 
the criteria. 

   or �without cursor selection� : all points in the 
project will be tested to see if they match the 
criteria. 
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Zoom In/Out/to Fit 
• Zoom in 

- In the toolbar, click    or from the View menu, select 
the Zoom In command 

- Move the mouse pointer onto the map. This causes the 
pointer shape to change to a  

- Position the pointer in the area from which to zoom in and 
click with the left mouse button. As a result the window 
displays a magnified view of the area, centered around the 
clicked point 

- You can zoom in repeatedly (i.e. so long as the mouse 
pointer looks like a   ). 

• Zoom out 

- In the toolbar, click    or from the View menu, select 
the Zoom Out command 

- Move the mouse pointer onto the map. 

 This causes the pointer shape to change to a  

- Position the pointer in the area from which you want to 
zoom out and click with the left mouse button. As a result 
the window displays a larger-scale view centered around 
the area 

- You can zoom out repeatedly (i.e. so long as the mouse 
pointer looks like   ). 

• Zoom To Fit 

- In the toolbar, click   or from the View menu, select the 
Zoom To Fit command. 

 This causes the map to be re-adjusted (through a zoom-
and-grab operation) so that it can view all the objects you 
have defined for the project. 
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Measuring a segment on the map 

- Move the pointer to the toolbar and click  or from the 
View menu, select the Distance command. 

 This causes the pointer to change to  

- Move the pointer to an end of the segment and start 
dragging the pointer toward the other end. From that 
moment, KISS will provide the value of distance (with red 
background) between the initial point and the one currently 
pointed by the mouse until you release the mouse button: 

 

 
 

- Once the pointer accurately coincides with the second 
point, read the distance measured and then release the 
mouse. 

 After releasing the mouse, the pointer shape is still  
meaning that KISS is ready to measure a new segment. 
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A review of the KISS commands 

File menu commands 
 New Creates a new project 
 Open... Opens an existing project 
 Close Closes the active project (or the Projects window 

if it�s the only open window) 
 Save Saves the active project 
 Save As... Saves the active project under a new name thus 

creating a new project  
 Print... Prints the active project 
 Print Preview Displays the active project as it would appear 

printed 
 Print Setup... Selects a printer and printer connection 
 Report Setup... Shows the Report tab from the KISS options 

dialog box. Allows you to define the content of 
the printout for the active document 

 {Recent files} Names of the projects last opened using KISS 
 Exit Exits KISS 
 

Edit menu commands 
 Copy Copies the map to the clipboard 
 Delete Deletes the current selection 
 Select All Selects all the objects placed on the map 
 Change Into Allows a target point to be changed into a 

reference point (or logged point) or vice versa 
 Reset Results Deletes the available results of survey for the 

current selection of points 
 Import Target... Imports targets from one or more files, or from 

3Spack data base 
 Export Target... Exports the target of each selected point to 

3Spack or to a file 
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 Import Results... Imports position solutions either from a file or 
from 3SPack 

 Export Results... Exports the position solutions of the selected 
points to 3Spack or to a file 

 Properties� Shows the Project properties dialog box as was 
defined for the active project, or shows the 
properties of the selected point (only if there is a 
single point selected). 

 
View menu commands 

 Zoom In Magnifies the map, by one zoom-in step, around 
the clicked point 

 Zoom Out Shrinks the map, by one zoom-out step, around 
the clicked point 

 Zoom To Fit Adjusts the zoom so that all the points defined on 
the map can be viewed 

 Grabber Moves the map in the direction in which you drag 
the mouse pointer. The move is effective only 
after releasing the mouse button. 

 Distance Activates a meter tool allowing you to know the 
distance between any two points: click the first 
point and drag the mouse pointer to the second 
one. Read the distance before releasing the 
mouse button. 

 Hide Hides the selected point (or points) 
 Focus Performs Zoom To Fit action based on the 

current selection of points. In the same time, 
hides all other points. 

 Show... Gives access to a points list in which you can 
check the points you want to hide or clear the 
points you want to show. The number of currently 
hidden points is indicated in the status bar of the 
KISS window. Asking for a point to be hidden 
means that both the icon and the name, if shown, 
will be hidden. 
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 Map Shows/Hides all the geographical details other 
than the objects you have placed on the map 
using KISS 

 Ruler Shows/hides the grid coordinates 
 Grid Shows/hides the map grid lines 
 Names Shows/hides the names of the points on the map 
 Toolbar Shows/hides the toolbar 
 Status Bar Shows/hides the status bar 
 Projects Opens/closes the Projects window 
 Quick Info Opens/closes the Quick Info window  
 84 Logged... Active if results of a job include points logged on 

WGS84 because the horizontal system could not 
be determined. In this case, selecting this 
command opens a dialog box containing the 
names of all these points. 

 Results... Edits the RES file that you select in a separate 
window, using a text editor much similar to 
WordPad. Each new record session is identified 
in the left-hand pane and the corresponding 
records are viewed in the right-hand pane. 

 
Draw menu 

 Select Allows you to select any point on the map 
 Select Where Allows you to select the points meeting the active 

criteria. The criteria may be applied to all the 
points on the map, or only to the selection you 
make after selecting this function 

 Reference Points Lets you create a reference point at the location 
that you click with the left-mouse button. 

 Target Points Lets you create a target point at the location that 
you click with the left-mouse button. 
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Transfer menu commands 
 Write Job... Writes all or part of the active open project, to PC 

card or palmtop as a job, under a name that you 
specify 

 Read Results... Reads the results of a job directly from palmtop 
(6x0x) or from PC card (600x) 

 Read Station Reads raw data files from PC card (recorded at a 
station) 

 Read Mobile Reads raw data files from PC card (recorded by 
a rover) 

 Read Notes Reads notes from palmtop (6x0x only) 
 

Tools menu 
 Geoids... Runs the Geoids module 
 Compute Datum Shifts... Computes or refines the datum 

shifts of a standard coordinate 
system after surveying a few known 
reference points in this system 

 Compute Horizontal Grid... Computes or refines a local grid 
after surveying a few known 
reference points on this grid 

 Compute Vertical Correction... Computes or refines a local vertical 
system after surveying a few known 
reference points in this system 

   For the above three commands, see 
page 12-41.  

 
 Test Transfo... Opens a dialog box allowing you to 

test the coordinate system used 
 Options Opens the Kiss Options dialog box. 
 



KISS Module 
A review of the KISS commands 

12-76 DSNP 

12 

Window menu 
 Cascade Arranges all the open files in cascade 

configuration 
 Tile Places all the open files side by side according to 

a vertical arrangement 
 Arrange Icons Auto-arranges all iconized files (icons are moved 

to the lower part of the KISS window and 
arranged horizontally starting from the left) 

 Close All Closes all the open project files 
 {File list} The names of the currently open project files are 

listed here to let the user choose a new active file 
directly from this menu. 

 
Help menu 
The Help menu offers the following commands, which provide you 
assistance with this application:  

 Index Displays the opening screen of Help 
 Using Help Displays instructions for using Help 
 About KISS Displays the version number of KISS 

♣  
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  13. SISS Module 

Preamble 

Introduction 
- SISS (Seismic Information Support Software) comes as one of 

the optional modules of 3SPack. It is specifically intended for 
seismic land surveys performed with DSNP DGNSS equipment 
using the DSNP LRK® real-time & long-range processing 
method. 

- SISS is used at the beginning of field operations to create a project. 
There are three different ways of creating a project: from a points 
file with or without auto link statement , from the Grid Generator, or 
creating an empty project for logging-only operations. 

- SISS then provides a view of your work area. It is a good idea to 
have the map of this area scanned and the resulting bitmap file 
moved to the 3SPack Supervisor database (Maps object). This 
will give you the ability to show/hide the details of the area as you 
create your target points. 

- In the next stage, SISS will let you write jobs directly on palm 
computers (6x0x) or on PC cards (former 600x). Field operators 
will just have to follow the instructions provided on their screens. 

- After field operations, SISS will be used to retrieve the results of 
the jobs performed in the field. 

- If raw data was recorded during the survey at the station and the 
rover (this is an option in the 650x-to 630x series), SISS will allow 
you to transfer this data to 3SPack, or to any other Post-
processing software, so that you can compare the real-time 
results against those obtained using a post-processing method. 

- SISS allows you to work on the results of your projects . For 
example you can validate the real-time or post-processed solution 
of a target point using various selection criteria. A number of 
import/export functions are available in different formats (SPS, 
DXF, Seismic, User). Points and results can easily be exchanged 
with the 3SPack database. 
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Staking-out Modes 
Select one of the following modes, depending on the type of survey you have 
to perform: 
 
• 2D Mode: Staking out a line    

The field operator will be allowed to mark a target point only after 
entering the acceptance strip (see diagram below). The direction of 
the acceptance strip is perpendicular to the line and centered around 
the theoretical location of the target. The half-width of the 
acceptance strip is defined when preparing the survey. It represents 
the distance of the perpendicular from the theoretical point to either 
edge of the strip. Typically the 2D mode is used to survey a single 
series of points (along a straight line or a polyline). 

 

• 3D Mode: Staking out a grid    
The field operator will be allowed to mark a target point only after 
entering the acceptance circle (see diagram below). The acceptance 
circle is centered at the theoretical location of the target. Its radius is 
defined when preparing the survey. Typically the 3D mode is used to 
survey a grid, i.e. several parallel lines (or a single line). 

 

 

            



SISS Module 
Preamble 

DSNP 13-3 

Graphic conventions used for target points 
• Before surveying  

1. Each receiver point is represented by an empty square:   
2. Each source point is represented by an empty circle:   
3. The thickness of the icon tells you whether the point is still 

waiting to be transferred as part of a job, or this operation 
has already been made: 

 Bold: still waiting to be transferred 
 Thin: transfer has already been made 

4. The color of the icon changes when you select it with the 
mouse pointer: 

 Selected: icon green, point name with dark-blue background 
 Deselected: icon dark-blue, point name with yellow background 

5. A red line connected to this icon means that the point is 
�linked�, i.e. it is part of a line. If it is not, it is said to be 
isolated, or �unlinked�. 

 
• After surveying 

6. A surveyed receiver point is represented by a full 
square: , which means that a solution is now available for 
this point. 

7. A surveyed source point is represented by a full circle: , 
which means that a solution is now available for this point. 

8. A logged point is represented by a flag:   
9. The color of any icon changes when you select it with the 

mouse pointer (same as 4. above) 
10. Validating a solution for a point results in the following icon:  

  or  

11.  or  denotes a point staked out at some distance 
from its theoretical location. The direction of the line in the 
icon is indicative of the deviation vector. 
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• Examples of icons for receiver points 

  
 

Target 1: Isolated or unlinked point (no red line connected to 
this point) 

 Currently non-selected (square is dark-blue in 
color) 

 Not transferred yet as part of a job (square sides 
are bold) 

 
R4001 0500: Linked point (a red line starts from this point) 
 Currently non-selected (square is dark-blue in 

color) 
 Was earlier transferred as part of a job (square 

sides are thin) 
 
R4001 0502: Linked point (a red line passes through this point) 
 Currently selected (square is green in color, name 

with dark-blue background) 
 Not transferred yet as part of a job (square sides 

are bold) 
 
R4001 0504: Linked point (a red line ends at this point) 
 Currently non-selected (square is dark-blue in 

color) 
 Not transferred yet as part of a job (square sides 

are bold). 
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Project file structure 
If you create a project called �PatBrixen�, then this project will be 
represented as shown below, beside the Project Wizard icon in the 
Projects window. The following folder and file are then present in the 
SIS directory. 

  
Later, the PatBrixen folder will be completed with results files 
(<job>.JRS), and possibly raw data files if during jobs, recording 
sessions were performed. 

While working on a project, you may need to create QRY files. This 
type of file, which contains a number of criteria used to select points, 
is invoked when using the �Select Where � function. By default, QRY 
files are saved in the SIS directory: 
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Using SISS before field surveying 

Project creation algorithm 
As shown in the diagram below, there are three possible ways of 
creating a project: 

 

 

Horizontal & vertical systems 
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Creating a project from a points file 
1. Choose this option if you want the new project to originate 

from a file containing a number of useful points. If you 
check this option, the following appears in the lower part of 
the tab: 

 Source file Specify the name of the file from which to create the 
project. Click the � button to navigate to the directory 
containing the desired file (by default to Points 
directory). Once a selection is made, you can edit the 
file by clicking the View File� button. 

 Format Select the option corresponding to the format in which 
the source file was saved (ASCII SPS, ASCII DXF or 
ASCII User) 

 Auto link points 
  where names 
 contain Check this button if you want to link some of the points 

read from the source file in order to build a line (or a 
grid). In this case, it is assumed that each point name 
in the source file includes line and point number 
information. Only those points meeting the auto link 
statement will be linked (continued in page 13-16).  

 

2. Enter a name for the project, click the Next> button and 
then enter the project details in the Project Wizard-Details 
tab: 

 Supervisor Enter the supervisor name (optional) 
 Region Enter a label for the region of survey (a town, a village, 

a particular site, etc.) (8 characters max.; optional) 
 Horz. System Specify a horizontal system from the drop-down menu 

(all the systems stored in the 3SPack database are 
prompted in this menu) 

   If you are creating a project from an SPS file, then the 
coordinate system present in this file is automatically 
entered in this field. 

 Vert. System Choose one of the vertical systems available. The 
vertical system is used to determine the Z coordinate 
of every point surveyed. 
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 Distances In Specify the Distance unit chosen for the project 
(meters, US Feet or Imperial Feet) 

 Angles In Specify the Angle unit chosen for the project (degrees 
or grades) 

 Notes text box Add comments or recommendations of any kind which 
you want to associate to this project (optional). Press 
Ctrl+Enter to start a new line in this text box. 

 Mode Specify the staking-out mode to be used in your project 
(2D or 3D) 

 Radius/Half Width Enter the value of distance defining the radius of the 
acceptance circle (in 3D) or the half-width of the 
acceptance strip (in 2D) 

 Classification Specify the point type (�Source� or �Receiver�) (Preset 
if project created from a points file) 

 
3. When you agree with the content of this tab, click the 

Finish button. Unless the corresponding button has been 
cleared in the SISS Options dialog box (see page 13-43), 
the Coordinate System dialog box will now appear. This 
box lets you read the characteristics of the chosen 
coordinate system before definitively validating it for the 
project (you can still modify some of these characteristics if 
necessary). 

4. Click OK. SISS now creates the new project. A map of the 
region of survey appears in the SISS window. In the same 
time, the project is saved in the SIS directory  (Refer to 
page 13-5, Project file structure). 

 If you now select the Properties command from the Edit 
menu, note that some of the fields are dimmed (no 
changes allowed). 
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Creating a new project from the Grid Generator 
1. Choose this option if you want the new project to be 

created from the Grid Generator. After checking this 
option, do the following: 

2. Enter a name for the project 

3. Click the Next> button in the lower part of the tab and 
enter the details of the new project  in the Project Wizard-
Details tab: 

 Supervisor Enter the supervisor name (optional) 
 Region Enter a label for the region of survey (a town, a village, 

a particular site, etc.) (8 characters max.; optional) 
 Horz. System Specify a horizontal system from the drop-down menu 

(all the systems stored in the 3SPack database are 
prompted in this menu) 

 Vert. System Choose one of the vertical systems available. The 
vertical system is used to determine the Z coordinate 
of every point surveyed. 

 Distances In Specify the Distance unit chosen for the project 
(meters, US Feet or Imperial Feet) 

 Angles In Specify the Angle unit chosen for the project (degrees 
or grades) 

 Notes text box Add comments or recommendations of any kind which 
you want to associate to this project (optional). Press 
Ctrl+Enter to start a new line in this text box. 

 Mode Specify the staking-out mode to be used in your project 
(2D or 3D) 

 Radius/Half Width Enter the value of distance defining the radius of the 
acceptance circle (in 3D) or the half-width of the 
acceptance strip (in 2D) 

 Classification Specify the point type (�Source� or �Receiver�) (Preset 
if project created from a points file) 

 

4. Click the Next> button in the lower part of this tab when 
you agree with its content. 
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5. In the Project Wizard-Grid Generator tab which then 
appears, enter the following: 

 Pattern pane: defines the length and orientation of the 
pattern line: 

 
 Origin Easting Enter the easting of the point where the line starts 
 Origin Northing Enter the northing of the point where the line starts 

 
 End point defined by Check one of the following options: 
   (1) Azimuth and number of points (origin excluded) 
   (2) Azimuth and line length 
   (3) Coordinates of end point 
 End Easting If (3) checked, enter the easting of the point where the 

line ends 
 or 
 Azimuth If (1) or (2) checked, enter the azimuth angle of the line 
 
 End Northing If (3) checked, enter the northing of the point where the 

line ends 
 or  
 Line length If (2) checked, enter the total length of the line 

(expressed in the chosen distance unit) 
 or 
 Number of points If (1) checked, enter the number of planned points 

along the line (start point excluded) 
 
 Inter-point Spacing Interval of distance between any two consecutive 

points along the line. 
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 Replica pane: defines other lines, based on the pattern 
line, to form a grid. If �2D� was selected in the previous tab, 
then this pane is irrelevant and is replaced by the message 
�single line!�. If �3D� was selected, enter the following: 

 
 Inter-line spacing Interval of distance, expressed in the chosen distance 

unit, between any two adjacent lines 
 Number of lines Number of lines forming the grid (1 to 100) 

 
 Origin of line defines Check �Right side of grid� if you want the grid to be 

generated to the left of the pattern line (thereby making 
this line the right side of the grid). Check the �Left side 
of grid� option to obtain the inverse result. 

 

 Naming pane: Defines rules allowing SISS to assign a name to 
each of the generated points: 

 Line Start: In 2D, number of the line being created. In 3D, 
number of the pattern line. Only the last 4 characters 
entered in this field are validated. 

   Step: In 3D only. Increment (100 max) allowing SISS 
to assign a number to each line other than the pattern 
line 

   Example: Line Start =0300 and Line Step=5; then 1st 
line: 0300, 2nd line: 0305, 3rd line= 0310, etc. 

 Point Start: In 2D and 3D, number of the first point in each 
line. Only the last 4 characters entered in this field are 
validated. 

   Step: In 2D and 3D, increment (100 max) allowing 
SISS to assign a number to each point in each line 

   Example: Point Start =1800 and Point Step=1; then 1st 
point: 1800, 2nd point: 1801, 3rd point= 1802, etc. 

 Prefix Forced to �R� for receiver points 
   Forced to �S� for source points. 
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 Preview button: 

 Before creating the project by clicking the Finish button, 
which is an irreversible operation, you can preview the grid 
that would be created from the current settings of the Grid 
Generator. 

 Example: 

 Grid preview (click Show Grid button): 

  
 �and resulting names table (click Show Names button): 

  



SISS Module 
Using SISS before field surveying 

DSNP 13-13 

6. When you agree with the content of this tab, click the 
Finish button. Unless the corresponding button has been 
cleared in the SISS Options dialog box (see page 13-43), 
the Coordinate System dialog box will now appear. This 
box lets you read the characteristics of the chosen 
coordinate system before definitively validating it for the 
project (you can still modify some of these characteristics if 
necessary). 

7. Click OK. SISS now creates the new project. A map of the 
region of survey appears in the SISS window. In the same 
time, the project is saved in the SIS directory  see page 13-
5, Project file structure. 

 If you now select the Properties command from the Edit 
menu, note that some of the fields are dimmed (no 
changes allowed). 
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Creating an empty project 
Use this option if you want to create a project for the sole purpose of 
allowing field operators to log points in the field. With this option 
selected, the project details you then need to specify are mainly the 
horizontal & vertical systems used and the work area (coordinates of 
center point and scale) (staking-out mode and point classification 
are irrelevant). 

1. Check �Created empty for logging only� 

2. Enter a name for your project 

3. Click the Next> button and then enter the project details.  
in the Project Wizard-Details tab: 

 Supervisor Enter the supervisor name (optional) 
 Region Enter a label for the region of survey (a town, a village, 

a particular site, etc.) (8 characters max.; optional) 
 Horz. System Specify a horizontal system from the drop-down menu 

(all the systems stored in the 3SPack database are 
prompted in this menu) 

 Vert. System Choose one of the vertical systems available. The 
vertical system is used to determine the Z coordinate 
of every point surveyed. 

 Distances In Specify the Distance unit chosen for the project 
(meters, US Feet or Imperial Feet) 

 Angles In Specify the Angle unit chosen for the project (degrees 
or grades) 

 Notes text box Add comments or recommendations of any kind which 
you want to associate to this project (optional). Press 
Ctrl+Enter to start a new line in this text box. 

 Center Easting Enter the easting of the center point 
 Center northing Enter the northing of the center point 
 Scale Enter the scale of the map 
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4. When you agree with the content of this tab, click the 
Finish button. Unless the corresponding button has been 
cleared in the SISS Options dialog box (see page 13-43), 
the Coordinate System dialog box will now appear. This 
box lets you read the characteristics of the chosen 
coordinate system before definitively validating it for the 
project (you can still modify some of these characteristics if 
necessary). 

5. Click OK. SISS now creates the new project. A map of the 
region of survey appears in the SISS window. In the same 
time, the project is saved in the SIS directory  refer to page 
13-5, Project file structure). 

 If you now select the Properties command from the Edit 
menu, note that some of the fields are dimmed (no 
changes allowed). 
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Auto-link statement 
(Continued from page 13-7) 

When creating a project from a points file, you can ask SISS to auto-
link points on the basis of criteria that you specify after checking the 
Auto link points where names contain check button. The criteria 
are defined as follows:   

 A line number from� Specify the location of the line number within 
each of the point names. 

   To do this, tell SISS what are, in every point 
name, the first and last characters delimiting the 
line number. For example, if you select �0� and 
�2�, SISS will regard the first three characters as 
the line number. 

   SISS will then create a link between all the points 
having the same line number. 

 
 A point number from� Specify the location of the point number within 

each of the point names. 
   To do this, tell SISS what are, in every point 

name, the first and last characters delimiting the 
point number. For example, if you select �3� and 
�7�, SISS will regard the 4th character up to the 
8th character as the character string holding the 
point number. 

   SISS will then create a line in which all the points 
having the same line number will be arranged in 
the order of their point numbers. 

 
To help you complete the above 4 fields, use the text box located at 
the bottom of this tab and the three buttons (Paste, L and P). Follow 
the procedure below: 

- After choosing a file, click on the View File button. This 
causes WordPad to be run to view this file 
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- In the window showing this file, extract a sample of this file 
by copying any line in which you can identify the location of 
the line number and the point number 

- Come back to SISS and click the Paste button to paste the 
sample in the box beside this button 

- In this sample, select the line number and click on the L 
button to complete the first two fields 

- Still from this sample, select the point number and click on 
the P button to complete the last two fields. 

 

Placing additional target points on the map 
After creating a project from a file or the Grid Generator, additional 
target points can be placed directly on the map of the project to 
complete the list of target points to be surveyed. 

The points that you add in this way are necessarily isolated 
�unlinked� points and of the same classification as those already 
present in the project (for example only �receiver� points can be 
added if the project already contains such points). 

- In the toolbar, click  or from the Draw menu, select the 
Target command. 

- Position the mouse pointer (now a ) where you want to 
create a new target point. In the right-lower part of the 
SISS window, the status bar helps you locate the point 
accurately on the map by giving the current coordinates of 
the mouse pointer as you move it within the window: 
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- When the mouse pointer is at the desired location, click 
with the left mouse button. This causes to Point 
Properties dialog box to open. This dialog box contains 
two tabs: 

 General tab 
 Name A default name, of the type "Target n", is assigned to 

the point. "n" is the order number (n=1 if first point 
created, =2 if second point created, etc.). Change this 
name if required. 

 Notes text box  Add comments or recommendations of any kind which 
you want to associate to this point (optional). Press 
Ctrl+Enter to start a new line in this text box (5 lines 
max.). 

   (All the other fields are dimmed). 
 

 Target tab 

 
 Target 
 position 
 pane Adjust the E and N coordinates of this point if required. 

By default, all target points are 2D. On this tab 
however, you can change the target point into a 3D 
point by checking the �H:� button and then by entering 
the value of its height component. 

 

- Click the OK button when the definition is complete. This 
causes a new Target Point icon to appear on the map.  

 
- Position the mouse pointer where you want to create a 

second target point and resume the same operations as 
above. To stop creating target points, click any other 
button in the toolbar. 
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Forcing the azimuth angle 
This command can be used in two different cases: 

- You want the azimuth angle to be a round figure (45° is 
easier to use than 45.01248°!) 

- You do not want the line to be used as the reference 
direction on which the roving unit will express the 
components of the offset, should the operator be unable to 
reach the target point.  

 These 2 examples illustrate the role of the azimuth in the 
expression of an offset point: 

 

  
 

 Changing this angle has no effect on the graphic 
representation of both the point and the link passing 
through this point. 
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• Procedure: 
- Select the linked point or points for which you want the 

azimuth to be changed 

- From the Edit menu, select the Azimuth command. In the 
dialog box which then appears, do the following: 

 Az Change or correct the azimuth angle 
 
 With across line 
 offsets positive Check one of the following options to orient the axis 

system on which the offset components will be 
expressed: 

   To the right: the cross-component of the offset is 
positive if it is to the right of the theoretical point, seen 
from that point, and compared to the direction given by 
the azimuth 

   To the left: the inverse statement. 
 

- Click OK to validate the changes. Note that these changes 
have no effect on the map. Edit the Target tab for one of 
the points to check that these changes are effective. 
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Linking/unlinking target points 
When creating a project from a file, you may want to create links 
manually rather than let SISS create them for you. In this case, you 
will have to ensure that the Auto Link button is cleared before 
validating the new project. Here are the few rules which you should 
know before using the Link and Unlink commands from the Draw 
menu. 

Whatever the staking-out mode used in the project (2D or 3D): 

- Links (red lines) are systematically drawn for the current 
selection of points, in the order of creation of the points, 
starting from the oldest. 

- Links can only be created on a selection of isolated target 
points. If a linked point is part of the selection, then SISS 
will make the Link command unavailable to you. In this 
case, only the Unlink command is valid, suggesting that 
the linked point in the selection should be unlinked. 

- The azimuth of each linked point can be forced to any 
value (0.. 360°) using the Azimuth command  

In 3D staking-out mode: 

- SISS will stop a link at any point from which the next point 
could only be joined by changing the azimuth angle by 
more than ± 90°. In this case, the current line is stopped at 
this point and a new line is started from the next point 
(unless it is the last point of the selection in which case this 
point will remain an isolated point). 

- By default, the same azimuth angle is assigned to all the 
points forming a line. This angle represents the direction of 
the straight line connecting the two ends of the link. This 
assignment will be done even if the link is not a straight 
line, but rather looks like a �polyline�, due to the fact that all 
the points are not accurately aligned. 
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In 2D staking-out mode: 

- Unlike the 3D mode, the change in azimuth angle can take 
any value (0.. 360°). By default, the azimuth angle 
assigned to each point represents the direction of the line 
to the next point. 

 

Editing the properties of a target point before field 
operations  
Double-click on this point. A dialog box appears showing the 
properties of the target point. The dialog box consists of two tabs 
(General, Target). The amount of information shown on these tabs 
depends on whether the point is isolated or linked (i.e. it is part of a 
line). 

General tab  
 Name Target point name (read-only). This field is preceded 

by the classification icon (a square or a circle) 
 

Check pane (read-only information): 
 Planned Checked only after you write this point on PCMCIA as 

part of a job 
 Offset, Surveyed 
 Post processed 
 Validated All these buttons necessarily cleared before field 

operations 
 

Notes pane (read-write text box): 
   Add comments or recommendations of any kind which 

you want to associate to this point (optional). Press 
Ctrl+Enter to start a new line in this text box. 
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Target tab 
Target position pane: 

 E, N, H Theoretical coordinates of the point (Easting, Northing, 
Height) 

   By default a 2-dimensional point (E and N checked and 
dimmed) 

   If the point is linked , you cannot change E and N. If 
the point is isolated, you can still do it. 

   To define a 3-dimensional point, whether the point is 
linked or isolated, check the H button and enter the H 
coordinate. 

 
Target Lines pane (read-only information): shown only if a linked point 

 Az Azimuth angle associated with the point. This 
information will be required when field operators have 
to offset the staking-out of a target point. In this 
particular case, the roving unit will express the 
components of the offset using an axis system whose 
origin is the theoretical location of the point and its 
orientation based on the direction given by this angle 
(see Expressing the components of an offset point ). 

   By default, this angle is the azimuth of the line 
connecting this point to the next point. 

 Across line 
 offsets are 
 positive Check one of the following options to orient the axis 

system on which the offset components will be 
expressed: 

   To the right: the cross-component of the offset is 
positive if it is to the right of the theoretical point, seen 
from that point, and compared to the direction given by 
the azimuth 

   To the left: the inverse statement. 
 Mode Staking-out mode (2D or 3D) 

    
 Radius/ 
 Half-width Defines the size of the acceptance area, (radius of 

acceptance circle in 3D, half-width of acceptance strip 
in 2D)  

 Classification Receiver or source 
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Acceptance area: 

The upper-right corner of the dialog box shows the nature of the 
acceptance area: 

 Linked point in 3D: 

 A circle centered at the theoretical target point. The 
orientation of the horizontal axis is in compliance with the 
�Across line offsets are positive� selection at the foot of the 
Target tab. The line is always oriented upward. 

 Linked point in 2D: 

 A strip, perpendicular to the line, centered vertically around 
the theoretical target point. The orientation of the horizontal 
axis is in compliance with the �Across line offsets are 
positive� selection at the foot of the Target tab. The line is 
always oriented upward. 

 Isolated point: 

 No acceptance area (just a point) 

 

Importing target points 
When preparing a project, you can add points on the map by 
importing them from a file or from 3SPack. 

As these points have no classification before being imported, SISS 
will give these points the same classification (source or receiver) as 
the one chosen for the project. 

- From the Edit menu, select the Import Target Points 
command 

- In the Import Positions dialog box which then appears, 
select the import mode (Import From File or Import From 
3SPack). Then do one of the following: 
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• Import From File 
- Click the Add button to choose the file(s) from which to 

import points (default directory: ... /Points) 

- Select the desired file(s) and click the Open button. The 
selected files then appear in the Import list box. 

 When appropriate, use the other two buttons associated 
with the Import list box (Edit and Remove) after selecting 
a file name from this box. Use the Edit button to edit the 
selected file (default editor: Wordpad). Click the Remove 
button to remove the selected file name from the Import 
list box (no targets will then be imported from this file). 

- In the Format pane, specify the format of the file (ASCII 
DXF or User). To create new user formats, click the User 
formats button and then the New button. Then refer to 
page 3-64. 

- Click the Go button to start importing the points. The points 
will appear on the map after successful import operation 
(the map is adjusted through a zoom-to-fit-and-grab 
operation so that all the points can be viewed). 

 

• Import From 3SPack 
- Same as from a file, except that clicking the Add button 

will display directly all the sites available from the 3SPack 
Database. Another difference is that you should specify 
which solution of the site should be imported (the default 
or last one).To make this choice, from the Get 3SPack 
pane, click the appropriate radio button. 
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Exporting target points 
- From the Edit menu, select the Export Target Points 

command. 

- In the dialog box which then appears, select the export 
mode (Export to File or Export to 3SPack). Then do one 
of the following: 

 
• Exporting to a File 

- Click the Add button to choose the target points to export 
from the active project (if you selected the points before 
selecting the Export Target Points command, then the 
points are automatically selected and you do not need to 
click Add) 

- Select the target points from the list and click the OK 
button 

- Define the export ASCII file by specifying its path, name 
and format (SPS, DXF or User) 

- Click the Go button to start exporting the target points. All 
the target positions of these points will be exported. 

 
• Exporting to 3SPack database 

Same as to a File, except that you just need to specify (or pre-
select) the points. 

- Click the GO button 

 All selected points will be stored as Sites in the 3SPack 
database. 

 
• Creating new user formats for exporting results to a file 

- Click the User formats button and then the New button. 
Then see page 3-64. 
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Transferring jobs to a palmtop (6x0x series only) 
- Connect the palmtop to the computer through a serial line. 
- Select the Tools>Options>Transfer tab and check that 

the choices on this tab are appropriate (Scorpio 630x 
series selected, right choice for the port used on the PC to 
communicate with the Husky). Then click OK. 

- Open the project in the SISS window 
- If you want to focus on particular points, then select the 

corresponding icons. Otherwise, do not make any selection. 

- In the toolbar, click    or, from the Transfer menu, 
select the Write Job command. 

- In the Write Job� dialog box which then appears, enter a 
name for the file which is going to be written to the palmtop 
(8 characters max.) or select an existing one from the list 
box which you will overwrite with the new job. 

- Specify the content of the job: 
 Selected Points This option should logically be checked if you have 

made a prior selection of points on the map (option 
dimmed otherwise) 

 Remaining Points Check this option if you want the field operator to deal 
only with the points not surveyed yet (which supposes 
that a part of the project has already been made). With 
this option you do not need to make a prior selection. 

 All Points Check this option if you want to make a job of the 
entire project. 

- Click the OK button to write the job to the palmtop. The 
extension of a job file is J2D (2D staking-out), J3D (3D 
staking-out) or J0D (logging) 
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Transferring jobs to a PC card (600x series only) 
- Insert a card into the PC card reader of your PC. 
- Select the Tools>Options>Transfer tab, then, in the PC 

card drive: field, indicate the location of the PC card drive 
on your computer. Clear or check the Remind me of... 
check button relevant to the PC card. Click OK to enter 
your choices. This closes the dialog box. 

- Open the project in the SISS window 
- If you want to focus on particular points, then select the 

corresponding icons. Otherwise, do not make any selection. 

- In the toolbar, click    or, from the Transfer menu, 
select the Write Job command. 

- In the Write Job� dialog box which then appears, enter a 
name for the file which is going to be written to the PC card 
(8 characters max.) or select the existing one which you 
will overwrite with the new job. 

- Specify the content of the job: 
 Selected Points This option should logically be checked if you have 

made a prior selection of points on the map (option 
dimmed otherwise) 

 Remaining Points Check this option if you want the field operator to deal 
only with the points not surveyed yet (which supposes 
that a part of the project has already been made). With 
this option you do not need to make a prior selection. 

 All Points Check this option if you want to write the entire project. 

 
- Click the OK button to write the job to the PC card. As 

there can only be a single file on the PC card, SISS will ask 
you to confirm the deletion of the file present on the card (if 
any) before writing the new job. Click Yes to confirm this 
choice. 

 The file extension used when writing a job is in the form 
�J<x>� where x: staking-out mode. Two file extensions are 
therefore possible for staking-out operations: J2D and J3D. 
For logging operations, the file extension is J0D. 
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Deleting a project 
Projects are deleted from the projects window. Only close projects 
can be deleted. 

- In the projects window, select the corresponding icon and 
then press the Del key (or choose the Delete command 
from the Edit menu). 

- Click Yes to confirm this choice. 

When you delete a project, in fact you delete all the files stored in the 
corresponding project folder, and this folder. A project folder 
generally contains a SIS file, one or more JRS files and possibly raw 
data BIN files. 

It may be useful to backup the project folder before deleting it from 
the SIS directory. 
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How to quit SISS 
· From the menu bar, select File and then Exit. Unless an 

unsaved project is still open, this causes the SISS main 
window to be closed immediately. 

 If one or more unsaved projects are still open in the SISS 
window, warning messages will appear successively for 
each of these projects asking you to save the last changes 
made before quitting SISS. Click the Yes button to save 
them, or the No button to discard them. 

 
 

Geoids module 
This module allows you to import geoids, extract data from a geoid 
to create a smaller file containing just the necessary data for your 
working area, and load geoid models (partial or complete) directly 
into a Scorpio receiver (only if it is from the 650x-to-630x series). 

Two geoid models are available in the Geoids module: RAF98 and 
EGM96 

Starting the Geoids module: 

- On the SISS Tools menu, select Geoids. This starts the 
Geoids module. 

Importing a new geoid model: 

- In the Geoids window, select File>Import and indicate the 
location of the corresponding file. 

Opening a geoid model: 

- In the Geoids window, select File>Open. This function 
indicates the following: geoid name, limits of geographical area, 
grid step, file size, number of points. 
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Extracting data from a geoid model: 

- A geoid model must be open in the window 

- In the Geoids window, select File>Extract As�. Define the 
characteristics of the data extraction (name, format). To 
indicate the limits of your working area, you can advantageously 
use the World Map function, by clicking the World Map button, 
rather than type the coordinates of the N-W and S-E limits of 
the area. 

- Click the Extract button to create the new file. This file is 
automatically opened in the Geoids window after being created 
by the module. 

Loading a geoid model into a receiver: 

- A geoid model must be open in the window (a complete or 
partial geoid). Establish a serial link between one of the ports on 
your PC and, for example, port A on the Scorpio (any RS232 
port can be used on the Scorpio), using the appropriate cable. 

- In the Geoids window, select Transfer>Write. A dialog box 
appears asking you to choose and set the serial port on your 
PC now connected to the Scorpio. 

 After setting the port, click OK to start and complete the file 
transfer. 
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Using SISS after field surveying 

Retrieving the results of a job (600x series) 
You do not need to work with the PC containing a project to read the 
results of a job prepared for this project. The only requirement is, of 
course, that 3SPack+SISS be installed and operating on this PC. If 
you work with the same PC, you can start the retrieve procedure by 
first opening the project from which the job was created. 

- Insert the PC card from the field into the drive of your 
computer 

· In the SISS toolbar, click  or from the Transfer menu, 
select the Read Results... command. This action is also 
possible if there is no project open in the SISS window, 
which will be the case if you work on a PC other than the 
one used to create the project 

- In the Read Results dialog box which then appears, select 
the job. 

- Click the OK button. Once SISS has successfully retrieved 
the results of the job (a JRS file), these results appear 
directly on the map. All the points for which solutions are 
now available are selected . See page 13-3 to understand 
the meaning of the icons used. 

If no project is open in the SISS window, or if the open project is 
incompatible with the results of the job, the PC card will restore the 
job as it was written earlier (this JxD file is still present on the PC 
card) and you will be asked to save this data as a new project. Then 
SISS will restore the solutions of the points surveyed during the job. 
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On transfer completion, a warning message will appear if particular 
events occurred during the transfer in relation with the transfer 
options chosen for SISS (see page 13-43): 

 
The message will prompt you to open the log file so that you can be 
informed of the nature of these events. If you click the Yes button, 
the log file will be opened using the WordPad text editor of Windows 
95. 

Outside this particular context, you cannot open the log file from 
SISS. If you need to open it at another moment, use Windows 
explorer (the log file is stored in ...\3SPack\bin under the name 
"SISS.log"). 

If raw data files are present on the card (raw data was recorded 
during the job by the rover), then these files will be copied to the 
corresponding project folder and renamed JOB_*.Dxx, where * : time 
(hhmmss) and xx : recording session number. 

 

Retrieving the results of a job (650x-to-630x series) 
− Run SISS and open the project corresponding to the job 

completed in the field 

− In the toolbar, click  or from the Transfer menu, select 
the Read Results... command. The Read Results From... 
dialog box then appears listing a number of job names. 

 (This action is also possible if there is no project open in 
the SISS window, which will be the case if you work on a 
PC other than the one used to prepare the job.) 
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 (If a project is open, this dialog box will list all the job files 
present in the palmtop for which result files exist. If no 
project is open, ALL the job files will be listed, regardless of 
whether result files exist for these jobs or not.) 

− In the dialog box, select the job you have just completed in 
the field. 

− Click the OK button. 

 (If no project is open and you select a job, or if the open 
project is incompatible with the job, then SISS will ask you 
to create a new project on the basis of the selected job. If a 
result file exists for this job, then the results of this job will 
be retrieved.) 

 Note that during file transfer, format conversion is 
performed from binary to SVAR (ASCII). 

 Once SISS has successfully retrieved the results of the job 
(a JRS file), these results appear directly on the map. All 
the points for which solutions are now available are 
selected. 

− On transfer completion, a warning message will appear if 
particular events occurred during the transfer in relation 
with the transfer options chosen for SISS. 

 The message will prompt you to open the log file so that 
you can be informed of the nature of these events. If you 
click the Yes button, the log file will be opened using the 
WordPad text editor of Windows 95. 

 Outside this particular context, you cannot open the log file 
from SISS. If you need to open it at another moment, use 
Windows Explorer (the log file is stored in ...\3SPack\bin 
under the name "siss.log") 
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Retrieving raw data recorded on PC card (650x-to-
630x series) 

- Insert the PC card containing the raw data files into the drive 
of your computer 

- Open the project relevant to the station or rover where raw 
data files were recorded 

- In the SISS toolbar, click  or , or from the Transfer 
menu, select Read Station or Read Mobile respectively. A 
dialog box appears listing all the raw data files present on PC 
card (*.Dxx). All files are selected by default for transfer. 

- Change the current selection if necessary 

- In the Recorded... text box, enter the identification of the 
station or rover where recording took place 

- Click OK to start transferring the files. Once transfer is 
complete the raw data files are visible in the project folder, 
and renamed as follows 

STATION_*.Dxx (raw data from stations) 

JOB_*.Dxx (raw data from rovers) 

where: 

xx: session number-1 (00 for 1st session, 01 for 2nd 
session, etc.). 

 
 Raw data can then be imported to 3SPack for post-

processing. Station raw data files should be associated with a 
site, and rover raw data files to a trajectory. 

 Warning! Raw data files recorded at a station or by a rover are 
exactly of the same type. It is therefore the user�s 
responsibility to establish the origin of the raw data files. 
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Editing a target point after a solution is available 
for this point 
Double-click on a surveyed point. The dialog box which then appears 
includes the following additional information, compared with the 
same dialog box before surveying the point (see page 13-22): 

In the General tab 

- The name of the job through which the point was surveyed 
is mentioned in the check pane 

- The �Surveyed� button is checked 

- The �Offset� button will also be checked if the point had to 
be offset 

- On the upper-right diagram, the real time solution (RT) is 
shown. A segment connects this point to the theoretical 
point. For an offset point, the acceptance area is centered 
around the offset point and so the diagram is not indicative 
of the deviation between the two points. 

The Target tab is unchanged except if the point was offset. In 
this case: 

- The coordinates of the offset point are provided 

- The offset components with respect to the target are 
provided, expressed on an axis system based on the 
azimuth associated to the target 

- The upper-right diagram shows the location of the offset 
point with respect to the target. 
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A new (read-only) tab is added (RT Solution) containing the 
complete description of the real time solution  

Solution pane 
 Time Date & time of survey  
 E, N, H Coordinates of the solution 
 Ant. Height GPS antenna height above the ground when surveying 

the point 

 
 DGNSS button Displays the current WGS84 coordinates of both the 

roving unit and the station when the point was 
surveyed. The baseline is indicated at the foot of the 
window. 

 

Errors pane 
 Along line/On North Northing deviation (isolated point) or longitudinal 

deviation (linked point) with respect to the theoretical 
location of the target 

 Across line/On East Easting deviation (isolated point) or transverse 
deviation (linked point) with respect to the theoretical 
location of the target. 

 

Quality Control pane 
 Processor Real-time processing method used 
 SV count Current count of visible satellites when the point was 

surveyed 
 Meas. Count of GPS solutions involved in this real time 

solution (through averaging) 
 PDOP Current value of PDOP 
 Correlation Matrix The components of the Correlation matrix. 
 
 

Selecting points according to a number of preset 
criteria: �Select where� 
 See page 13-37. 
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Validating/invalidating one of the available 
solutions for a target point 
This function allows you to declare one of the solutions available for 
a target point (real time or post-processing) as the valid solution for 
this point. Following this operation, you will be able to export this 
solution (and not the other one) to 3SPack or to a file. The function 
can be applied to a multiple selection. 

 

• Validating the solution of a target point 
- Select a surveyed target point (full icon) 

- In the SISS toolbar, click  or, from the Edit menu, 
select Validate Results. A dialog box appears asking you 
to specify which solution to validate for this point (Real time 
or Post processing) 

- Check one of the two options and click OK. As a result, a 
check symbol is now superimposed on each of the point 
icon selected on the map. Example of icon for a source 
point with validated solution: 

 

 If you now edit this point, note that on the General tab, the 
�Validated� button is now checked and on the tab of the 
chosen solution, the following symbol is displayed in the 
upper-right corner: 
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• Invalidating the solution of a target point 
This is the reverse operation. 

- Select a validated target point (full icon with superimposed 
check symbol) 

- In the SISS toolbar, click  or, from the Edit menu, 
select Invalidate Results. As a result, the check symbol is 
removed from the point icon. 

- If you now edit this point, note that on the General tab, the 
�Validated� button is now cleared and on the tab of the 
invalidated solution, the following symbol is displayed in the 
upper-right corner: 

 
 
 

Importing post-processed results 
When preparing a project or when collecting the results of a project, 
you can add post-processed solutions to existing target points by 
importing these solutions from a file or from 3SPack. 

- From the Edit menu, select the Import Post-processed 
Results command. 

- In the Import Positions dialog box which then appears, 
select the import mode (Import From File or Import From 
3SPack). Then do one of the following: 

 

• Import From File 
- Click the Add button to choose the file(s) from which to 

import post-processed solutions (default directory: ... 
/Points) 

- Select the desired file(s) and click the Open button 
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- Specify the format of the file (DXF or User) 

- Click the Go button to start importing the points and their 
solutions. After transfer, edit one of the points concerned 
by this transfer to check that a new tab is now present. 
This tab contains the Post-Processed solution of this point. 

 

• Import From 3SPack 
- Same as from a file, except that clicking the Add button 

will display directly all the sites available from the 3SPack 
Database. 

- If there are too many sites in the database, it is a good idea 
to make a selection of the concerned points on the project 
map before selecting the Import Post-processed Results 
command. Then, after selecting this command, checking 
the �focus on selection� button in the Add Sites dialog box 
will allow SISS to make a pre-selection of the 
corresponding sites from the 3SPack database. 

- Another difference is that you should specify which solution 
of the site should be imported (the default or the last one). 

 

• Creating new user formats 
- Click the User formats button and then the New button. 

Then see page 3-64. 

 
Exporting validated results 

- From the Edit menu, select the Export Validated Results 
command. 
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- In the dialog box which then appears, select the export 
mode (Export to File or Export to 3SPack). Then do one 
of the following: 

 

• Exporting to a File 
- Click the Add button to choose the validated points to 

export from the active project (if you selected the points 
before selecting the Export Validated Results command, 
then the points are automatically selected and you do not 
need to click Add) 

- Select the target points from the list and click the OK 
button 

- Define the export ASCII file by specifying its path, name 
and format (SPS, DXF or User) 

- Click the Go button to start exporting the validated points. 
Only the validated solution of each of these target points 
will be exported. 

 

• Exporting to 3SPack database 
Same as to a File, except that you just need to specify (or pre-
select) the points. 

- Click the GO button 
 All selected points will be stored as Sites in the 3SPack 

database. Each of these sites will hold a single solution: 
the one you validated (�Written by SISS� will be the text 
appearing in the Notes text box of this solution). 

 

• Creating new user formats for exporting results to a file 
- Click the User formats button and then the New button. 

Then see page 3-64. 
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Printing a project 
Use the usual buttons to print a project: 

- Select a printer and the few other print options through the 
Print Setup command from the File menu 

- Print preview : use    

- Print : use   

The complete printout of a project consists of three pages: 

- The first page shows a map of the work area, as currently 
viewed in the SISS window (same grab setting and scale) 

- The second page lists the project details and indicates the 
count of target points and the count of surveyed points 

- The third page provides a complete description of the 
coordinate system used (projection and datum). 

 

 

Saving a project 

- In the toolbar, click  or from the File menu, select the 
Save command. 
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Changing the options of SISS 

- In the toolbar, click   or from the menu bar, select 
Tools and then Options. A dialog box appears in which 
you can set the options of the SISS module. The dialog 
box contains the following three tabs. 

 

 

General Tab 
Always check coord. system 
when creating a new project check button 

- If you check this button, the Coordinate System dialog 
box will automatically appear right before validating the 
definition of a new project. Displaying this dialog box, 
which shows the characteristics of the chosen coordinate 
system, allows you to check/modify this system before 
definitively validating it. 

- If you clear that button, the Coordinate System dialog box 
will not appear in that particular context. 

 

 

Transfer tab 
Scorpio receiver series used : Tick the button corresponding to 
the series of Scorpio receiver used (6500-to-6300 series, or 
former 6000 series) 

Then depending on the selection you have just made: 

PC Card Drive : Type the path of the PC card (default: E:\) 
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PC port to Husky : Select the port on your PC that you want to 
use to communicate with the Husky (via its serial port) 

Transfer procedure reminder: Check or clear the Remind me 
of... check button, depending on whether you wish to be guided 
during the job transfer procedures or not. 

 

When reading results... pane 

 This pane deals with all the anomalous events detected by 
SISS when reading results files after the field operator has 
completed a job. The pane gives access to two different 
options. A single option is displayed at a time. To proceed 
with the next choice, use the vertical scroll bar. 

 For each option, tell SISS what to do in the following two 
cases, by checking the corresponding button. You must 
choose an option in each of the two cases. 

1 : If the coords of a planned target point read from the results 
file are different from those of the same point in the active 
project: 

 Discard point read from the results file 
 Create a new point in the active project 
 Replace the initial coordinates with those read from the the 
results file 

 
2 : If the results file contains a planned target point not defined 

in the active project: 

 Discard point read from the results file 
 Create a new point in the active project 
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Map commands 
You will probably need to use the following commands when you 
work on a project. 

 

Map window status bar 
For the active project, the status bar of the SISS window 
permanently indicates the total number of points in the project, the 
number of currently selected points and the number of hidden points. 

 

Showing/hiding the Map grid  

Click  in the toolbar to show/hide the map grid. This button 
operates as a toggle. You can also select the Grid command from 
the View menu. This command also operates as a toggle. 

 

Showing/hiding the ruler 

Click  in the toolbar to show/hide the ruler. This button operates 
as a toggle. You can also select the Ruler command from the View 
menu. This command also operates as a toggle. 

 

Showing/hiding map details 

Click  in the toolbar to show/hide the map details. You can also 
select the Map command from the View menu. This command also 
operates as a toggle. 

Maps are bitmap files obtained with scanners. They must be stored 
in the Maps object of the 3SPack database to be used by SISS. 
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 Selecting a point on the map 

In the toolbar, click    and then click on the point you want to 
select. If shown, the point name turns white with dark-blue 
background 

To add another point to the selection, hold down the Shift or Ctrl key 
while clicking on the second point. If necessary, add other points to 
the selection by repeating this action. 

To select several points at the same time, drag to create a rectangle 
that encloses all of the points you want to select. Selection is 
effective after you release the mouse button. 

To remove a point from the selection, hold down the Ctrl key while 
clicking this point. 

To cancel a selection, click in the map where there is no point. 

 

Selecting all points  

After clicking  to view all the points, drag to create a rectangle 
that encloses all the points, or from the Edit menu, select the Select 
All command. 

 

Moving the map within the SISS window 

- In the toolbar, click  or from the View menu, select the 
Grabber command 

- Move the mouse pointer onto the map. This causes the 
pointer shape to change to a  

- Depress the left mouse button and drag the pointer in the 
direction where you want the map to be moved. Note that 
the move will take place only when you release the mouse 
button and it will be proportional to the distance covered by 
the pointer when you drag it. 
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Deleting points 
Select these points (using the Select or �Select Where� function) 
and then press the Del key. A message will then ask you to confirm 
the Delete operation. The points will definitively disappear from the 
map if you click the Yes button. 

The fact that a point is linked to one or two other points does not 
constitute a restriction in the use of the Delete command. Deleting 
linked points will cause SISS to re-draw the target lines, taking into 
account the fact that some of the points which initially were part of 
these lines do not exist any more. 

 

Editing a point 
- Select this point and then from the Edit menu, select the 

Properties command (alternate action: double-click on the 
point). This will display the Properties dialog box for the 
selected point. 

 Note that if no point, or two or more points, are selected on 
the map, then the Properties command will display the 
properties of the project. 
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Selecting points according to a number of preset 
criteria: �Select where� 
The �Select Where� function is very useful when you need to select a 
large number of points meeting one or more criteria. After you 
specify this criterion (or these criteria), SISS will be capable of 
selecting these points for you in no time. 

In addition, you can restrict the selection of points meeting the 
criteria by drawing a rectangle on the map (after specifying your 
criteria). By doing this, only the points meeting the criteria and 
located inside this rectangle will be effectively selected. 

- In the toolbar, click  or, from the menu bar, select 
Draw and then Select Where. A new dialog box appears 
in which you can do the following: 

 

 Criteria pane  
 Add button Click this button to add a new criterion. A new dialog 

box appears (�Add criterion� dialog box) in which you 
can build the expression of the new criterion 

   Click OK when the expression of the criterion is 
complete. The criterion then appears in the list box of 
the �Select Where� dialog box. 

   Resume this operation until all the required criteria are 
shown in the list box. 

 Edit button Click this button after selecting a criterion which you 
want to modify. A new dialog box appears (�Add 
criterion� dialog box) in which you can change the 
expression of this criterion. Click OK when you agree 
with the new expression of the criterion. The list box in 
the �Select Where� dialog box is then updated 
accordingly 

 Delete button Click this button after selecting a criterion which you 
want to delete. The criterion will then disappear from 
the list box. 
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 Query pane  

 You can save the set of criteria created in the list box as a 
file (a QRY file) so that it will be easy for you to use it again 
at a later date. You can also load a QRY file created earlier 
for this project (or for another project) in order to use the 
criteria contained in this file. 

 By default, QRY files are saved in the SIS directory, at the 
same level as the project folders. 

 Load button Click this button to load a QRY file created earlier 
(default directory: SIS). After selecting a file, click the 
Open button. As a result, all the criteria held by this file 
appear in the list box of the �Select Where� dialog box 

 Save button Click this button to save the displayed criteria as a 
QRY file (default directory: SIS). After naming the file, 
click the Save button. As a result, all the displayed 
criteria are saved into this file. 

 
 

 Select points 
 that match� Check one of the following options: 
   �At least one of the following criteria� : any 

tested point meeting any of these criteria will be 
selected 

   or �All the following criteria� : only the tested 
points meeting all the criteria will be selected 

 - At the foot of the dialog box, check one of the 
following options 

   �and match cursor selection as well� : only the 
points in the area that you will drag with the 
mouse pointer will be tested to see if they match 
the criteria. 

   or �without cursor selection� : all points in the 
project will be tested to see if they match the 
criteria. 
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Zoom In/Out/to Fit 
• Zoom in 

- In the toolbar, click    or from the View menu, select 
the Zoom In command 

- Move the mouse pointer onto the map. This causes the 
pointer shape to change to a  

- Position the pointer in the area from which to zoom in and 
click with the left mouse button. As a result the window 
displays a magnified view of the area, centered around the 
clicked point 

- You can zoom in repeatedly (i.e. so long as the mouse 
pointer looks like a   ). 

• Zoom out 

- In the toolbar, click    or from the View menu, select 
the Zoom Out command 

- Move the mouse pointer onto the map. 

 This causes the pointer shape to change to a  

- Position the pointer in the area from which you want to 
zoom out and click with the left mouse button. As a result 
the window displays a larger-scale view centered around 
the area 

- You can zoom out repeatedly (i.e. so long as the mouse 
pointer looks like   ). 

• Zoom To Fit 

- In the toolbar, click   or from the View menu, select the 
Zoom To Fit command. 

 This causes the map to be re-adjusted (through a zoom-
and-grab operation) so that it can view all the objects you 
have defined for the project. 
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Measuring a segment on the map 

- Move the pointer to the toolbar and click  or from the 
View menu, select the Distance command. 

 This causes the pointer to change to  

- Move the pointer to an end of the segment and start 
dragging the pointer toward the other end. From that 
moment, SISS will provide the value of distance (with red 
background) between the initial point and the one currently 
pointed by the mouse until you release the mouse button: 

 

 
 

- Once the pointer accurately coincides with the second 
point, read the distance measured and then release the 
mouse. 

 After releasing the mouse, the pointer shape is still  
meaning that SISS is ready to measure a new segment. 
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A review of the SISS commands 

File menu commands 
 New Creates a new project 
 Open... Opens an existing project 
 Close Closes the active project (or the Projects window 

if it�s the only open window) 
 Save Saves the active project 
 Save As... Saves the active project under a new name thus 

creating a new project  
 Print... Prints the active project 
 Print Preview Displays the active project as it would appear 

printed 
 Print Setup... Selects a printer and printer connection 
 {Recent files} Names of the projects last opened using SISS 
 Exit Exits SISS 
 

Edit menu commands 
 Copy Copies the map to the clipboard 
 Delete Deletes the current selection 
 Select All Selects all the objects placed on the map 
 Azimuth Forces the azimuth associated to a linked point 

(or to linked points) to the desired value 
 Validate Results� Allows you to choose one of the solutions 

computed for the selected target points as their 
true positions (check symbols then appear on 
icons) 

 Invalidate Results Allows you to stop using the solutions chosen 
with the Validate Results command to be the 
true positions of the selected points (check 
symbols then disappear from icons) 
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Reset Target Points Deletes the solutions computed for the selected 
points (icons are then turned into empty squares 
or circles, as if the points had just been created) 

 Import 
 Target Points� Imports points from one or more files, or from 

3Spack data base 
Export Target Points Exports the selected target points to 3Spack or to 

a file 
 Import 
 Post-processed 
 Results� Imports the post-processed solutions of points 

either from a file or 3SPack 
 Export 
 Validated 
 Results� Exports the validated solution of each of the 

selected points to 3Spack or to a file 
 Properties� Shows the Project properties dialog box as was 

defined for the active project, or shows the 
properties of the selected point (only if there is a 
single point selected). 

 
 

View menu commands 
 Zoom In Magnifies the map, by one zoom-in step, around 

the clicked point 
 Zoom Out Shrinks the map, by one zoom-out step, around 

the clicked point 
 Zoom To Fit Adjusts the zoom so that all the points defined on 

the map can be viewed 
 Grabber Moves the map in the direction in which you drag 

the mouse pointer. The move is effective only 
after releasing the mouse button. 
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 Distance Activates a meter tool allowing you to know the 
distance between any two points: click the first 
point and drag the mouse pointer to the second 
one. Read the distance before releasing the 
mouse button. 

 Hide Hides the selected point (or points) 
 Show... Gives access to a points list in which you can 

check the points you want to hide or clear the 
points you want to show. The number of currently 
hidden points is indicated in the status bar of the 
SISS window. Asking for a point to be hidden 
means that both the icon and the name, if shown, 
will be hidden. 

 Map Shows/Hides all the geographical details other 
than the objects you have placed on the map 
using SISS 

 Ruler Shows/hides the grid coordinates 
 Grid Shows/hides the map grid lines 
 Names Shows/hides the names of the points on the map 
 Toolbar Shows/hides the toolbar 
 Status Bar Shows/hides the status bar 
 Projects Opens/closes the Projects window 
 Results... Edits a JRS results file using a text editor much 

similar to WordPad. Both the data and the record 
sessions are shown. 
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Draw menu 
 Select Allows you to select any point on the map 
 Select Where Allows you to select the points meeting the active 

criteria. The criteria may be applied to all the 
points on the map, or only to the selection you 
make after selecting this function 

 Target Lets you create a target point at the location that 
you click with the left-mouse button. 

 Link Points Creates a red line connecting the selected target 
points 

 Unlink Points Deletes the line connecting the selected points. 
 
 

Transfer menu commands 
 Write Job... Writes all or part of the active open project, to PC 

card or palmtop as a job, under a name that you 
specify 

 Read Results... Reads the results of a job directly from palmtop 
(6x0x) or from PC card (600x) 

 Read Station Reads raw data files from PC card (recorded at a 
station) 

 Read Mobile Reads raw data files from PC card (recorded by 
a rover). With the former 600x series, this 
command is implicitly run when using the Read 
Results... command 

 
 

Tools menu 
 
 Geoids... Runs the Geoids module 
 Options Allows you to display/change the options of SISS. 
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Window menu 
 Cascade Arranges all the open files in cascade 

configuration 
 Tile Places all the open files side by side according to 

a vertical arrangement 
 Arrange Icons Auto-arranges all iconized files (icons are moved 

to the lower part of the SISS window and 
arranged horizontally starting from the left) 

 Close All Closes all the open project files 
 {File list} The names of the currently open project files are 

listed here to let the user choose a new active file 
directly from this menu. 

 
 
 

Help menu 
 Index Displays the opening screen of Help 
 Using Help Displays instructions for using Help 
 About SISS Displays the version number of SISS. 
  ♣  
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  14. Appendices 

Project Document Abstract 
 

The information contained in the abstract is listed below: 

 

 (From Project General tab)  Project name 
    Project supervisor 
    Project start date & time 

    Planned project end date & time 

 
 (From Project Region tab)  Time zone 

    N/W & S/E coordinates 

 
 (From Project General tab)  Coordinate system name 

 
 (From Coord.sys record)  Complete description of coordinate 

system 

 
 (From Project General tab)  Notes about the project, if any 
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ASCII SVAR Format 

File Header 
< stx ><eoln> 
!L,<GPS week><GPS time><eoln> 
*1,<label11>,<label12>,<label13><eoln> 
*2,<label21>,<label22><eoln> 

 

!L line 
<GPS week> GPS week number 
<GPS time> GPS time in week, in seconds (Reference time is 
Jan 6 1980 at 0hr00) 

 

*1 : Header line ####1 
< label11 > Time when file first opened (mm/mm/yyyy hh :mm :ss) 
< label12 > Operator name (20 characters max.) 
< label13 > Work area label (8 characters max.), or job name 

for seismic surveys 
*2 : Header line ####2 

< label21 > File or Job name  
< label22 > Comment (48 characters max.) 
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Points list 
<stx><eoln> 
!I,<GPS week>,<GPS  time><eoln> 
*1,<point type>,<point number>,<label11>,<label12>, 
<label13>,<label14>,<label15>,<label16>,<label17> <eoln> 
*2,<X >,<Y>,<Z>,<distance unit code>,<angle unit code><eoln> 
*3,<X ECEF>,<YECEF>,<ZECEF>,<unit code><eoln> 
*4,<value41>,<value42>,<value43>,<value44>, 
<value45>,<value46>,<distance code><eoln> 
∗ 6,<EL0>,<NL0>,<DE>,<DN>,<BETA>,<K>,<distance unit 
code>,<angle unit code><eoln> 
∗ 9,<SDE>,<CEN>,<SDN>,<CEH>,<CNH>,<SDH>, 
<MU>,<N>,<Q>,<unit code><eoln> 
∗ A,<Dif station number>,<XECEF>,<YECEF>, <ZECEF><eoln> 
∗ B,<Dif station number>,<XECEF>,<YECEF>, <ZECEF>< eoln > 
∗ C,<Dif station number>,<XECEF >,<YECEF>, <ZECEF>< eoln > 
∗ T, <XT>,<YT>,<ZT>,<point type>,<unit code><eoln> 
<etx> 
 
 
!I Time tagging line 

<GPS week> GPS week number 
<GPS time> GPS time in week, in seconds (Reference time is 
Jan 6 1980 at 0hr00) 

!I: point identifier, character 49Hex (GPS week and time are 
optional) 
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*1 : Point description line  
<Point type>: 

10: reference point or staked-out reference point 
11: staked-out reference point, modified by operator 
12: staked-out reference point, through linear offset 
13: staked-out reference point, through lateral offset 
20: staked-out target point 
21: staked-out target point, modified by operator 
22: staked-out target point, through linear offset 
23: staked-out target point, through lateral offset 
30: logged point 
31: logged point, modified by operator 
32: logged point, through linear offset 
33: logged point, through lateral offset 
34: logged point, through intersection of lines 
50: logged point during trajectory work 
51: logged point during trajectory work, modified by operator 

60 to 69: Intermediate points involved in point offset procedure 
70 to 79: Points involved in the computation of grid parameters 
80 to 89: Points involved in the computation of altitude correction 

parameters 
<point number>: recording number (software-set)  

<label11>: point name  (12 characters max.) 
<label12>: geocode 1 (12 characters max.) 
<label13>: geocode 2 (12 characters max.) 
<label14>: geocode 3 (12 characters max.) 
<label15>: geocode 4 (12 characters max.) 
<label16>: comment (48 characters max.) 
<label17>: recording local time ("26/11/97 18:51:59") 
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For seismic surveys: 
<label11>: point name  (characters 0 to 11) 
<label12>: point name  (characters 12 to 23) 
<label13>: point name  (characters 24 to 35) 
<label14>: geocode of a logged point (12 characters 

max.) 
<label15>: Count of SVs used and PDOP 
 format: "%2d %9.1f" (12 characters max.) 
 
 

*2 : Line containing ground position in local 
coordinates 

 
 
*3 : line containing ECEF position of antenna phase 

centre 
This line contains the ECEF position of the antenna phase center 
when logging the point or the ECEF position of the antenna phase 
center in the case of an offset logged point. 

 

*4 : Offset line 
<value41>: P1-to-P distance if point type is 12, 13, 22, 

23, 32 or33 
<value42>: P2to-P distance if point type is 12, 13, 22, 

23, 32 or33 
<value43>: Offset direction (1: to the right, −1: to the 

left) if point type is 13, 23 or 33 
<value44>: Not used 
<value45>: Not used 
<value46>: Antenna height 
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For seismic surveys: 
<value41> 
<value42> 
<value43>:  Theoretical ground position of offset point 
<value44>: Longitudinal offset 
<value45>: Transverse offset 
 

 
*6 : Deviations from user local grid 

<EL0>: Origin local easting 
<NL0>: Origin local Northing 
<DE>: Easting deviation 
<DN>: Northing deviation 
<BETA>: User local grid rotation angle 
<K>: Scale factor 
 
 

*9 : Qualification line 
<SDE>: Easting standard deviation 
<CEN>: Easting/Northing correlation 
<SDN>: Northing standard deviation 
<CEH>: Easting/Height correlation 
<CNH>: Northing/Height correlation 
<SDH>: Height standard deviation 
<MU>: Weighting factor standard deviation 
 <N>: Count of measurements involved in 

qualification processing 
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 <Q>: Kind of position solution: 
1: Natural 
11: DGPS 
21: EDGPS L1 
31: KART R 
41: KART A 
51: EDGPS L1/L2 
61: LRK R 
71: LRK A 
81: OFFSET 
 
 

*A or B or C : line describing Differential station used 
<Dif station No.>: identification number of a differential 

station involved in the position 
solution processing 

<X ECEF><Y ECEF><Z ECEF>: 
 Coordinates of a differential station 

involved in the position solution 
processing 

 
*T : line containing the planned position of a point to be 
staked out 

<XT><YT><YT>: planned ground position, in local 
coordinates, of a reference or target 
point. 

 
<point type>: 

1 for 1D 
2 for 2D 
3 for 3D 
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Kinematic re-initialization 
(Output every time the receiver is re-initialized in real-time kinematic) 

<stx ><eoln> 
!K, <GPS week>,<GPS time><eoln> 
∗ 1, <label11>,<value12>,<label13><eoln> 
<etx> 
 

!K Time tagging line 
<GPS week> GPS week number 
<GPS time> GPS time in week, in seconds (Reference time is 
Jan 6 1980 at 0hr00) 
 
 
 
 

Header line ####1 
<label11> local date & time of initialization (dd/mm/yyyy hh:mm:ss) 
<value12> Number of initialization cause 
<label13> Labelof initialization cause 
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Datum 
<stx ><eoln> 
!G, <GPS week>,<GPS time><eoln> 
∗ 1, <datum No. "datum name">< eoln > 
∗ 2, <"A" value>,<"1/F" value>,< "S" value>, 

<unit code><eoln> 
∗ 3, <"Dx" value>,<"Dy" value>,<"Dz" value> , 

<unit code><eoln> 
∗ 4, <"Ax" value>,<"Ay" value>,< "Az" value> , 

<unit code><eoln> 
  
1st line : 

Identification of the datum used. The reference is the WGS84. If it is 
unknown, the datum number is 0, and lines *2 to *4 are not provided. 

Projection parameters 
"n" lines are required to describe the projection parameters whose 
identifier is <#n>. Projection parameters are always preceded by the 
characteristics of the datum used. 

The first line contains the number of the projection type. This 
number indicates the algorithm used. Is may be followed by a label 
containing the instance name for the projection type. The labels 
listed below are just examples. 
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If the projection is unknown, line #1 reads #1,0,0 and the next lines 
(2 and 3) are not provided. 

<value1> in line #1 qualifies the coordinate system used: 

0: not used 
1: standard coordinate system (known datum & 
projection) 
2: not used 
3: standard coordinate system with local grid 
4: coordinate system with unknown datum & projection 
5: coordinate system with known datum & unknown 
projection 
6: coordinate system with unknown datum & known 
projection 
7: coordinate system with local grid and unknown datum 
& projection 
8: coordinate system with local grid, with known datum & 
unknown projection 
9: coordinate system with local grid, with unknown datum 
& known projection 
 
 

Tangent conical projection (Lambert): 

#1,<02 "Lambert 1">,<value1><eoln> 
#2,<"Lori" valeur>,<"Gori"value>, 

<"Eori" value>,<"Nori" value>,<unit code><eoln> 
#3,<"Ko" value><eoln> 
 
1st line: Number of projection type used, possibly 

followed by the name of the projection 
2nd line: Lori, Gori: latitude and longitude of origin (angles) 
 Eori, Nori: projected (XY) coordinates of origin 

(distances) 
 angle unit code and distance unit code (no 

separator in between) 
3rd line: Ko: Scale factor (a coefficient) 
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Secant conical projection (Lambert) 

#1,<03 "Maryland">,<value1><eoln> 
#2,<"Lref" value>,<"Gori" value>, 

<"Eori" value>,<"Nori" value>, 
<unit code><eoln> 

#4,<"LatN value>,<"LatS" value>,<unit code><eoln> 
 

1st line: Number of projection type used, possibly 
followed by the name of the projection 

2nd line: Lref, Gori: latitude and longitude of origin (angles) 
 Eori, Nori: projected (XY) coordinates of origin 

(distances) 
 angle unit code and distance unit code (no 

separator in between) 
3rd line: LatN, LatS: latitudes of 1st and 2nd parallels 

(scale: 1) (angles) 
 angle unit code 
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UTM projection (Universal Transverse Mercator) 

#1,<01 "UTM xx">,<valeur1><eoln> 
#2,<"Lori" value>,<"Gori" value>, 

<"Eori" value>,<"Nori" value>, 
<unit code><eoln> 

#3,<"Ko" value><eoln> 
 
1st line: Number of projection type used, possibly 

followed by the name of the projection 
2nd line: Lori, Gori: latitude and longitude of origin (angles) 
 Eori, Nori: projected (XY) coordinates of origin 

(distances) 
 angle unit code and distance unit code (no 

separator in between) 
3rd line: Ko: Scale factor (a coefficient) 
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Oblique cylindrical projection (Skew Orthomorphic) 

#1,<04 "Switzerland">,<valeur1><eoln> 
#2,<"Lori" value> , <"Gori" value>,<"Eori" value>, 

<"Nori" value>,<unit code><eoln> 
#3,<"Ko" value>,<"Skew" value>,<unit code><eoln> 
 
1st line: Number of projection type used, possibly 

followed by the name of the projection 
2nd line: Lori, Gori: latitude and longitude of origin (angles) 
 Eori, Nori: projected (XY) coordinates of origin 

(distances) 
 angle unit code and distance unit code (no 

separator in between) 
3rd line: Ko: Scale factor (a coefficient) 
 Skew: rotation (an angle) 
 angle unit code 
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Oblique cylindrical projection (Rectified Skew 
Orthomorphic) 

#1,<05 "Borneo">,<valeur1><eoln> 
#2,<"Lori" value>,<"Gori" value>, 

<"Eori" value>,<"Nori" value>, 
<unit code><eoln> 

#3,<"Ko" value>,<"Skew" value>,<unit code><eoln> 
 
1st line: Number of projection type used, possibly 

followed by the name of the projection 
2nd line: Lori, Gori: latitude and longitude of origin (angles) 
 Eori, Nori: projected (XY) coordinates of origin 

(distances) 
 angle unit code and distance unit code (no 

separator in between) 
3rd line: Ko: Scale factor (a coefficient) 
 Skew: rotation (an angle) 
 angle unit code 
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Oblique stereographic projection (Skew Stereographic) 

#1,<06 "Holland">,<value1><eoln> 
#2,<"Lori" value> , <"Gori" value>,<"Eori" value>, 

<"Nori" value>,<unit code><eoln> 
#3,<"Ko" value><eoln> 
 
1st line: Number of projection type used, possibly 

followed by the name of the projection 
2nd line: Lori, Gori: latitude and longitude of origin (angles) 
 Eori, Nori: projected (XY) coordinates of origin 

(distances) 
 angle unit code and distance unit code (no 

separator in between) 
3rd line: Ko: Scale factor (a coefficient) 
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Altimetric parameters 
"n" successive lines are required to describe the altimetric 
parameters whose identifier is <%n>. 

 
 %%%%1,<value1>,<value2>,<value3>,<altitude file name><eoln> 
 %%%%2,<value1>,<value2>,<value3>,<value4>,<value5><eoln> 
 

%%%%1 : <value1>, <value2> and <value3> stand for the data held by 
the command $PDAS,ALTI interpretable by GNSS receivers. 

<value1> : altitude processing mode 
0 H = H84 - MSLSTANAG - ∆h - offset 
1 H = H84 - ∆h - offset 
2 H = HELLIPSOID - ∆h - offset 
3 H = H84 - MSLLOCAL - ∆h - offset 
<value2> : Altitude offset with respect to ground (antenna 

height) 
<value3> :User correction: 

 0: ∆h = 0 
 1 : ∆h = h0 + a (LWGS84-L0) + b (GWGS84-G0) 

(linear local altimetry) 
<altitude file name>: file name (8 characters - a DOS-

compliant name) 
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%%%%2 : <value1> to <value5> correspond to the data used for the 
altitude processing, in the order given by the BIN file. 

<value1>: h0  
<value2>: a 
<value3>: L0 
<value4>: b 
<value5>: G0 

 
<etx> 

 

Unit code 
 ASCII character identifying the different units used in a 

data line, in the same order as the data, and without 
separator (example: 2b). The unit codes are described in 
the two tables below. 
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Adding a Coordinate System 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Coord. Systems object in the left-hand pane of 
the window 

- Click  or from the menu bar, select the Record 
command and then the Add command 

- In the dialog box that appears, enter the following 
parameters: 

 System : Enter a name for the new coordinate 
system 

 Kind : From this list box, specify the kind of 
projection used in the new coordinate 
system: 

1P-Lambert: A simple conic projection (i.e. using a single tangent 
cone). 
2P-Lambert: A secant conic projection (a secant cone is defined 
intersecting the earth at two standard parallels). 
Geocentric: Not a projection. Coordinates are expressed in a XYZ 
coordinate system whose origin is the centre of the earth. 
LatLong: Provides angular coordinates in relation to the chosen 
datum. 
RectSkewOrtho: A particular case of SkewOrtho projection 
consisting of a transverse Mercator projection in which an initial 
line is defined as the central meridian. 
SkewOrtho: An oblique conformal cylindrical projection. 
Stereographic: A projection in which points on the surface of the 
earth are projected geometrically onto a tangent plane, from a 
point on the surface of the earth opposite the point of tangency 
(also called azimuthal orthomorphic projection). 
UTM: Universal Transverse Mercator, an orthomorphic projection 
based upon a cylinder tangent along a meridian. 
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 Datum : From this list box, specify the name of the 
datum used in the new coordinate system. 

 Unit : From this list box, specify the name of the 
unit used in the new coordinate system. 

 Labels : From this list box, specify the name of the 
labels used in the new coordinate system. 

- If you choose the kind of projection Geocentric or 
LatLong, you don't need to specify any other parameters. 
Click the OK button when the definition is complete. 

- For the other kinds of projection, before you click the OK 
button, you need to specify the following: 

 
Extra parameters for 1P-Lambert, Stereographic & 
UTM 

 Extent button  : Is used to access the System Extent 
dialog box through which you can define 
the limits of the area in which the 
projection is assumed to be valid. 

  
 

 False Eastings : User-chosen eastings for projection centre 

 False Northings : User-chosen northings for projection 
centre 

 Central Meridian : Longitude of projection centre 

 Central Latitude : Latitude of projection centre 

 Scale : Scale factor 
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• NOTE: 
Defining the validity area is essential when you define this 
kind of projection. That is why 3SPack will force the display 
of the System Extent dialog box if you try to validate a 
new coordinate system without defining this area. 
 
 
 

Extra parameters for 2P-Lambert 
 Extent button  : Is used to access the System Extent 

dialog box through which you can define 
the limits of the area in which the 
projection is assumed to be valid (see in 
the previous page) 

 False Eastings : User-chosen eastings for projection centre 

 False Northings : User-chosen northings for projection 
centre 

 Central Meridian : Longitude of projection centre 

 North Latitude : Latitude of 1st parallel 

 Ref.Latitude : Latitude of projection centre 

 South Latitude : Latitude of 2nd parallel 

 

• NOTE: 
Defining the validity area is essential when you define this 
kind of projection. That is why 3SPack will force the display 
of the System Extent dialog box if you try to validate a 
new coordinate system without defining this area. 
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Extra parameters for RectSkewOrtho & SkewOrtho 
 Extent button  : Is used to access the System Extent 

dialog box through which you can define 
the limits of the area in which the 
projection is assumed to be valid (see in 
the previous page) 

 False Eastings : User-chosen eastings for projection center 

 False Northings : User-chosen northings for projection 
center 

 Central Meridian : Longitude of projection center 

 Central Latitude : Latitude of projection center 

 Scale : Scale factor 

 Skew : Azimuth of initial line 

• NOTE: 
See Note above concerning the definition of the validity 
area. 
 
 
 

Adding a Datum Record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Datums object in the left-hand pane of the 
window 
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- Click  or from the menu bar, select the Record 
command and then the Add command 

- In the dialog box that appears, enter the following 
parameters: 

 Datum : Enter the Datum name 
 Ellipsoid : Enter the name of the reference ellipsoid 
 Dx : Enter the X deviation of the datum 

compared with the reference ellipsoid 
(signed value in metres) 

 Dy : Enter the Y deviation of the datum 
compared with the reference ellipsoid 
(signed value in metres) 

 Dz : Enter the Z deviation of the datum 
compared with the reference ellipsoid 
(signed value in metres) 

 K : Enter the scale factor 
 Rx : Enter the angular deviation of the datum 

around the X axis compared with the 
reference ellipsoid (angle in seconds) 

 Ry : Enter the angular deviation of the datum 
around the Y axis compared with the 
reference ellipsoid (angle in seconds) 

 Rz : Enter the angular deviation of the datum 
around the Z axis compared with the 
reference ellipsoid (angle in seconds) 

 
- Click the OK button when the definition is complete. 
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Adding an Ellipsoid Record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Ellipsoids object in the left-hand pane of the 
window 

- From the menu bar, select the Record command and then 
the Add command 

 or 

 In the tool bar, click  

- In the dialog box that appears, enter the following 
parameters: 

 

 Ellipsoid : Enter the name of the new ellipsoid 

 Semi-Major Axis : Enter its Semi-Major Axis, in metres 

 Inverse Flattening : Enter its inverse flattening coefficient (1/f) 

 

-  Click the OK button when the definition is complete. 
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Adding a Label Record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Labels object in the left-hand pane of the window 

- From the menu bar, select the Record command and then 
the Add command 

 or 

 In the tool bar, click  

- In the dialog box that appears, enter the following 
parameters: 

 Label : Enter a name for the new Label 

 Field 1 : Enter the term introducing the first 
coordinate 

 Field 2 : Enter the term introducing the second 
coordinate 

 Field 3 : Enter the term introducing the third 
coordinate 

 

-  Click the OK button when the definition is complete. 
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Adding a Unit Record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Units object in the left-hand pane of the window 

- From the menu bar, select the Record command and then 
the Add command 

 or 
 In the tool bar, click  

- In the dialog box that appears, enter the following 
parameters: 

 Units : Enter the name of the new unit (for 
example "meter") 

 Ratio : Enter the value of the unit expressed in 
meters (for example as the US foot equals 
0.304799999 m, then we have 
Ratio=0.304799999 for the US foot Unit) 

 Digits : Enter the number of digits reserved for the 
fractional part of coordinates (for example 
coordinates of the type "xx...xx.xxx" will be 
obtained if Digits=3) 

 Label : Enter the term placed after coordinates to 
indicate the unit used (for example "m" for 
"meter") 

-  Click the OK button when the definition is complete. 
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Importing GPS data from within the 
database 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the corresponding database object (ephemerides, 
iono-UTC or almanacs) in the left-hand pane of the 
window. 

- In the toolbar, click  or, from the menu bar, select the 
Record command and then the Import command 

- In the Import GPS Data Dialog box that appears, click the 
Add button 

- The Browse dialog box which then appears shows the 
content of the Raw directory where all types of GPS raw 
data are expected to be located. 

- Double-click the file icon containing the data you would like 
to import, or click this icon and then the Open button. To 
make a multiple selection, first click the first file in your list 
and then, while holding down the Shift key, click the last 
file in your list. 

- Now that the name of the file you have just selected 
appears in the Import GPS Data Dialog box and is 
highlighted, click the Go button to start importing the data. 
A message appears providing information on the data 
import step in progress. 

- At the end of this step, the database is updated with a new 
record (or new records). 

- GPS data can also be imported by clicking   
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Editing an ephemeris record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Ephemeris database object in the left-hand pane 
of the window. In the list of ephemerides now shown in the 
right-hand pane: 

- Double-click the Ephemeris record you wish to edit  
 

 Ephemeris Data: 

 Sv SV PRN Number 

 URA (m) User Range Accuracy 

 SvHealth Health Status 

 Toe (s) Reference Time Ephemeris 

 Weeks Week Number 

 IODC Issue Of Data Clock 

 IODE Issue Of Data Ephemeris 

 Fit Inter (h) Fit Time 

 Mo Mean Anomaly at Reference Time 

 DeltaN (deg/s) Mean Motion Difference From Computed 
Value 

 E Eccentricity 

 Ao (m) Semi-Major Axis 

 Omega Right Ascension at Reference Time 

 IO Inclination Angle at Reference Time 

 W Argument of Perigee 

 OmegaDot (deg/s) Rate of Right Ascension 
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 IDOT (deg/s) Rate of Inclination Angle 

 Cuc (deg) Amplitude of the Cosine Harmonic 
Correction Term to the Argument of 
Latitude 

 Cus (deg) Amplitude of the Sine Harmonic 
Correction Term to the Argument of 
Latitude 

 Crc (m) Amplitude of the Cosine Harmonic 
Correction Term to the Orbit Radius 

 Crs (m) Amplitude of the Sine Harmonic 
Correction Term to the Orbit Radius 

 Cic (deg) Amplitude of the Cosine Harmonic 
Correction Term to the Angle of 
Inclination 

 

 Cis (deg) Amplitude of the Sine Harmonic 
Correction Term to the Angle of 
Inclination 

 Toc Reference Time of SV Clock Data (max: 
604784) 

 Af0 (µs) Polynomial Coefficient required to 
compute SV Clock Correction Data 

 Af1 (ns/s) Polynomial Coefficient required to 
compute SV Clock Correction Data 

 Af2 (ns/s2) Polynomial Coefficient required to 
compute SV Clock Correction Data 

 TGD (ns) L1-L2 correction term for single-frequency 
users 

 CodesOnL2 Indicates whether L2 is modulated by P or 
C/A 

 L2Dataflag Indicates whether code P is modulated by 
Navigation Data on L2 Channel 

 Transmit time Time when SV transmits ephemeris 
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Editing an almanac record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Almanacs database object in the left-hand pane 
of the window. In the list of almanacs now shown in the 
right-hand pane: 

- Double-click the Almanac record you wish to edit  

 
 Almanac Data: 

 Time GPS time 

 Sv  Satellite PRN number 

 A (m) Semi-major axis 

 w Argument of Perigee 

 Mo Mean Anomaly at Reference Time 

 e Eccentricity 

 Io Inclination Angle at Reference Time 

 Omg Right Ascension at Reference Time 

 OmegaDot (deg/s) Rate of Right Ascension 

 af0 (µs) Polynomial Coefficient required for SV 
clock correction data computation 

 af1 (ns/s) Polynomial Coefficient required for SV 
clock correction data computation 

 Toa (s) Almanac Reference Time 

 Week Week number 

 Health Health Status 
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Editing a Iono-UTC record 

- In the toolbar, click  

 or 

- From the menu bar, select the Window command and 
then the Database Manager command. 

- Click the Iono-UTC database object in the left-hand pane 
of the window. In the list of iono-UTC records now shown 
in the right-hand pane: 

- Double-click the Iono-UTC record you wish to edit 

 
 Iono-UTC Data: 

 Alpha0 (ns) Coefficient to be used in the single 
frequency user correction model 

 Alpha1 (ns/s) Coefficient to be used in the single 
frequency user correction model 

 Alpha2 (ns/s2) Coefficient to be used in the single 
frequency user correction model 

 Alpha3 (ns/s3) Coefficient to be used in the single 
frequency user correction model 

 Beta0 (s) Coefficient to be used in the single 
frequency user correction model 

 Beta1 (s/s) Coefficient to be used in the single 
frequency user correction model 

 Beta2 (s/s2) Coefficient to be used in the single 
frequency user correction model 

 Beta3 (s/s3) Coefficient to be used in the single 
frequency user correction model 

 A0 (µs) Polynomial Coefficient 

 A1 (ns/s) Polynomial Coefficient 
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 Tot (s) Reference Time of UTC Data (Max: 
602112) 

 WNT (weeks) UTC Reference Week Number 

 DeltaTLS (s) Delta Time due to Leap Seconds 

 WNLSF (weeks) Week Number of future Leap Second 
Effectivity 

 DN (days) Day Number of future Leap Second 
Effectivity 

 DeltaTLSF (s) Delta Time due to future Leap Seconds 

  ♣  
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Auto Configure, 2-9, 11-3, 11-
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Auto link, 13-7 
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Automatic File Name option, 

11-17 
Azimuth, 13-52 
Azimuth (forcing the), 13-19 

B 
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Bin, directory, 1-5 
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C 
CD-ROM, 1-1 
Central Latitude, 14-19, 14-21 
Central Meridian, 14-19, 14-

20 
Change 

(LR) Rapid Static, options, 9-3 
Curtain view, 3-77 
DGNSS, options, 7-3 

Kinematic or LR Kinematic, 
options, 8-4 

KISS options, 12-56 
Natural, options, 6-3 
Prediction, input parameters, 5-

2 
Prediction, options, 5-3 
Properties of KISS project, 12-

12 
SISS options, 13-43 
Target point into reference point 

(KISS), 12-17 
Viewing options (Map Server), 

4-26 
World Map viewing options, 3-

74 
Change Into, 12-17, 12-72 
Choose 

Appropriate coordinate system 
(KISS), 12-41 

Classification, 13-8 
Clipboard, 3-98, 3-99, 4-28, 5-

15, 5-17, 6-16, 6-19, 7-16, 7-
19, 8-17, 8-20, 9-15, 9-18, 
10-3, 10-7, 10-8, 10-18 

Close 
Project document, 3-66 

Cmd, directory, 1-5 
Colour options, 4-10 
Communications with a GPS 

receiver, 11-2 
Compute, 3-15, 3-51, 3-57, 4-

16 
Compute Datum Shifts..., 12-

75, 13-55 
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Compute Horizontal Grid..., 
12-75 

Compute Vertical 
Correction..., 12-75 

Computer requirements, 1-1 
Control key, 2-12 
Coord. Systems object, 3-5, 14-

18 
Correlation Matrix, 3-37, 3-44 
Create 

Empty SISS project, 13-14 
New geocode, 12-63 
New KISS project, 12-7 
New SISS project, 13-6 
New SISS project from a file, 

13-7 
New SISS project from grid 

generator, 13-9 
Project document, 3-10 
Site, 3-34 
Trajectory, 3-41 
Tutorial project, 2-2 
User format, 3-64 

Curtain 
Accessing the curtain chart, 3-

77 
Enable/disable, 3-82 
Move, re-shape, delete, 3-81 
purpose, definition, 3-75 

Customize, map server, 4-7 

D 
Data, directory, 1-5 
Database 

Architecture, 3-4 

Shortcut menu, 3-10 
Database Manager, 3-1, 3-3, 

3-29, 3-40, 3-43, 3-45, 3-61, 
3-71, 3-100, 14-18, 14-21, 
14-23, 14-24, 14-25, 14-26, 
14-27, 14-29, 14-30 

Datum, 10-13 
Datums object, 3-5, 14-21 
Default is Site radio button, 3-

48 
Default is Trajectory radio 

button, 3-48 
Default solution, 2-6, 3-6, 3-7, 

3-35, 3-36, 3-38, 3-45, 4-8 
Define 

Curtain, 3-39 
Kinematic process, 2-17 
Natural process, 2-14 
prediction, 2-7 
Prediction, 3-27 
Rapid Static process, 2-16 
Site process, 3-49 
Trajectory process, 3-56 
User format, 4-24 

Delete 
Almanacs, 2-28 
Ephemerides, 2-27 
Iono-UTC data, 2-27 
KISS project, 12-24 
Objects or operations, 4-21 
Observations, 2-27 
Project, 2-27 
Record, 3-8 
SISS project, 13-29 
Site solutions, 2-28 
Trajectory solutions, 2-28 
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Delete Request button, 11-18 
Destination directory, 1-2 
DGNSS 

Gps view, 7-8 
Target view, 7-5 
Time tag, 7-6, 7-15 

DGNSS processor 
Use, 7-1 

Directories 
Bin, 1-5 
Cmd, 1-5 
Data, 1-5 
Kis, 1-6 
Maps, 1-6 
Pgm, 1-6 
Points, 1-6 
Raw, 1-6 
Rtf, 1-6 

Diskette 
Icons, 2-13 
Installation, 1-4 

dongle, 1-7 
Dongle, 1-1, 1-7 
Drag and Drop, 10-4 
Draw 

Curtain, 3-77 
Draw (define) 

Additional target points (SISS), 
13-17 

Prediction, 3-27 
Process, 4-16 
Reference points (KISS), 12-15 
Site, 4-12 
Site process, 3-50 
Target points (KISS), 12-13 
Trajectory, 3-41, 4-13 
Trajectory process, 3-56 

Draw (define) prediction, 4-14 
DSNP to RINEX, 3-104 
DXF, 2-23, 2-24, 3-46, 3-61 

E 
Edit 

Almanac record, 14-29 
Curtain, 3-78 
Ephemeris record, 14-27 
Iono-UTC record, 14-30 
Logged point (KISS), 12-34 
Logged point surveyed through 

offset procedure, 12-37 
Planned point surveyed through 

offset procedure, 12-34 
Point surveyed at planned 

location, 12-31 
Prediction options, 2-7 
Process definition, 2-18 
Project document, 3-21 
Properties of target point 

(KISS), 12-14 
Properties of target point 

(SISS), 13-22 
Record, 3-8 
Site definition, 2-6 
Target point solution (SISS), 

13-36 
Trajectory definition, 2-6 

Elements of the Supervisor 
Database ("records", 
"objects"), 2-25 

Elev. min, 9-3 
Elev. Min, 3-17, 3-19, 5-4 
Ellipsoid, 10-13 
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Ellipsoids object, 3-5, 14-23 
Ephemerides object, 2-27, 3-7 
Epoch is significant, 3-85 
Event editor 

Mark, 3-84 
Moving the view, 3-87 
purpose, definition, 3-83 
Scroll, 3-87 
zooming in, 3-86 
zooming out, 3-86 

Export 
Project results, 3-61 
Results, 12-38 
Sites and trajectories, 4-22 
Solutions, 2-23 
Target points, 13-26 
Targets, 12-37 
transformed position to another 

window, 10-5 
Validated results, 13-40 

Extent button, 14-19, 14-20, 
14-21 

F 
False Eastings, 14-19, 14-20, 

14-21 
False Northings, 14-19, 14-20, 

14-21 
Field record file, 2-10 
File Max Size option, 11-13, 

11-16, 11-21 
File Max Size parameter, 2-10 
Filter code with phase, 3-17 
Focusing on points, 12-66 

G 
GDOP, 3-19, 3-20, 5-1, 5-2, 5-

4, 5-5, 5-13, 5-18, 5-19 
Geocenter, 10-14 
Geocentric, 14-18 
Geocodes pane, 12-57 
Geoid, 10-14 
GIS, 2-24 
Giving geographical 

dimensions to a raster map, 
3-94 

Graduations, 3-96, 3-97 
Graphic conventions used 

(KISS), 12-4 
Graphic conventions used 

(SISS), 13-3 
Grid, 3-4, 3-95, 3-96, 4-1, 4-4, 

4-8, 4-26, 4-29, 4-30 
Grid origin, 3-95, 4-4 
Grid step, 3-96, 4-4 
Group Label parameter, 11-10 

H 
HDOP, 3-19, 5-4, 5-5, 5-13, 5-

19 

I 
Import 

Field data records, 2-11 
GPS data, 3-30 
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GPS Data from within the 
database, 14-26 

Post-processed results, 13-39 
Results, 12-20 
Sites and trajectories, 3-46 
Target points, 13-24 
Targets, 12-18 

Include Project Points into 
project Report check button, 
12-59 

Initialisation Mode, 3-17 
in-place activated, 9-2 
In-place activated, 2-4, 4-2, 5-

1, 6-2, 7-2, 8-3 
Insert 

Map, 2-19, 3-26 
Map (automatic), 2-3 
Objects, 3-24 
Prediction, 3-29 
Process, 3-53 
Trajectory process, 3-59 

Install 
from CD-ROM, 1-2 
from diskettes, 1-1, 1-4 

Inter-line spacing, 13-11 
Inter-point Spacing, 13-10 
Intersection offset, 12-35 
Inverse flattening, 3-5, 10-17, 

14-23 
Inverse Flattening, 14-23 
Iono-UTC object, 2-27, 3-7 

K 
Keep, 3-32, 3-48 

Key words (KISS), 12-2 
Kinematic (or LR Kinematic) 

processor, use, 8-1 
Kinematic or LR Kinematic 

Gps view, 8-9 
Target view, 8-6 
Time tag, 8-6, 8-16 

Kis, directory, 1-6 
KISS 

Purpose, definition, 12-1 
Known point, 8-1, 8-5 

L 
Labels object, 3-5, 14-24 
Lateral offset, 12-35 
LatLong, 14-18 
Left from previous point, 3-80 
Linear offset, 12-35 
Link, 3-24 
Linking/unlinking target points, 

13-21 
local grid, 14-6 
LR Kinematic (or Kinematic) 

processor, use, 8-1 

M 
Map Server 

Conventions, 4-3 
Grab tool, 4-27 
Segment measurement, 4-19 
Viewing options, 4-7, 4-26 
Zooming in/out, 4-19 
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Map Zoom-In Limit, 4-9 
Map Zoom-Out Limit, 4-10 
Maps object, 3-4 
Maps, directory, 1-6 
Margins, 3-68 
Marker, 3-85 
Mask editor 

Purpose, definitions, 3-88 
Unmask, 3-91 
Zooming in, 3-92 

Mask Editor 
Move, 3-93 
Zooming out, 3-92 

Mask editor, (LR) Rapid Static 
Mask, 9-12 
Move view, 9-14 
Unmask, 9-13 
Use, 9-10 
Zooming in/out, 9-13 

Mask editor, DGNSS 
Mask, 7-12 
Move view, 7-14 
Unmask, 7-13 
Use, 7-11 
Zooming in/out, 7-13 

Mask editor, kinematic or LR 
Kinematic 
Mask, 8-13 
Move view, 8-15 
Unmask, 8-14 
use, 8-12 
Zoom in/out, 8-14 

Mask editor, Natural 
Mask, 6-12 
Move view, 6-14 
Unmask, 6-13 
Use, 6-11 

Zooming in/out, 6-13 
Mask tab, 3-88, 3-89, 3-90 
Maximum count of points 

allowed in a job file, 12-56 
Measuring a segment on the 

map, 4-19, 12-71, 13-51 
Multiple selection, 2-12 

N 
names, show/hide on map 

server, 4-29 
Naming pane, 13-11 
Naming rules, 2-12, 3-33 
Natural 

Gps view, 6-8 
Target view, 6-5 
Time tag, 6-5, 6-15 

Natural processor 
Use, 6-1 

No Limits parameter, 2-10 
North Latitude, 14-20 
NW & SE coordinates, 3-12 

O 
Object 

Insert, 3-24 
Observations, 3-7, 3-88 
Prediction, 2-8, 3-18 
Prediction, options, 3-19 
Process, 3-14 
Process, options, 3-16 

Observations object, 2-26, 2-27 
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Observations, show/hide on 
map server, 4-29 

Offsets, 12-35 
Open 

Database window, 3-3 
Project document, 3-21 

Operating system, 1-1 
Operators pane, 12-57 
Options of a prediction, 5-3 
Orientation, 3-68 
OTF, 8-2, 8-5 

P 
Page layout, 2-24 
Paper, 3-67 
Pattern pane, 13-10 
PCMCIA, 2-9, 2-11, 3-31 
PDOP, 3-19, 5-4, 5-5, 5-13, 5-

19 
Pgm, directory, 1-6 
Placing a new prediction on 

the map, 4-14 
Placing a new process on the 

map, 4-16 
Placing a new site on the map, 

4-12 
Placing a new trajectory on the 

map, 4-13 
Points, directory, 1-6 
Port settings, 2-9 
Prediction 

Azimuth view, 5-10 
Elevation view, 5-9 

GDOP view, 5-13 
Polar view, 5-11 
Schedule view, 5-7 
Time tag, 5-14 

Preview button, 13-12 
Previewing the project 

document, 2-24 
Print 

KISS project, 12-40 
Project document, 3-67 
SISS project, 13-42 

Printer, 3-68, 3-70 
Printing the project document, 

2-24 
Processor, 1-1, 3-16, 3-52, 3-

58, 5-1, 6-1, 6-11, 7-1, 7-11, 
8-1, 8-2, 8-11, 9-10 

program folder, 1-6 
Program folder, 1-3, 2-1 
Programmable GPS Recorder 

option, 11-15 
Project 

General tab, 2-2, 3-10 
Operations tab, 3-12 
Region tab, 3-11 

Project abstract, 2-3, 3-14, 14-
1 

Project Editor, 3-1, 3-2 
Project file structure (KISS), 

12-6 
Project file structure (SISS), 

13-5 
Projection, 10-14 
Projects object, 2-25, 2-27, 3-4 
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Properties, 3-70, 3-99, 4-20, 4-
28 

Q 
QRY files, 12-69, 13-49 
Quality Control, 13-37 
Quick Info window, 12-50 
Quit 

(LR) Kinematic environment, 8-
18 

(LR) Rapid Static environment, 
9-16 

DGNSS environment, 7-17 
KISS, 12-24 
Natural environment, 6-17 
Prediction environment, 5-16 
SISS, 13-30 

R 
Rapid Static, 8-1 
Rapid Static or LR Rapid Static 

Gps view, 9-7 
Target view, 9-5 
Time tag, 9-14 

Rapid Static or LR Rapid Static 
processor, recommendations, 
9-9 

Rapid Static or LR Rapid Static 
processor, use, 9-1 

Raw, directory, 1-6 
Reading from a GPS receiver's 

memory, 11-19 

Receiver Type, 11-4 
Receiver-to-PC data transfer, 

2-9 
RectSkewOrtho, 14-18 
Ref.Latitude, 14-20 
Reference, 3-15, 3-51, 3-57, 4-

17, 14-27, 14-28, 14-29, 14-
31 

Refresh 
Map, 2-13 

Region tab, 2-3, 3-11, 3-71, 3-
73, 3-103, 14-1 

Regions object, 2-26, 3-4 
Registration, 1-2 
Remove 

Map details, 2-5 
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